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Preface

Autodesk Fusion is a product of Autodesk Inc.  Fusion is the first of its kind software which combine 3D CAD, CAM, and CAE tool in single package. It connects your entire product development process in a single cloud-based platform that works on both Mac and PC. In CAD environment, you can create the model with parametric designing and dimensioning. The CAD environment is equally applicable for assembly design. The CAE environment facilitates to analysis the model under real-world load conditions. Once the model is as per your requirement then generate the NC program using the CAM environment.

The Autodesk Fusion 360 Black Book (V 2.0.18477) is 7th edition of our series on Autodesk Fusion. The book is updated on Autodesk Fusion Student V 2.0.18477. With lots of features and thorough review, we present a book to help professionals as well as beginners in creating some of the most complex solid models. The book follows a step by step methodology. In this book, we have tried to give real-world examples with real challenges in designing. We have tried to reduce the gap between educational use of Autodesk Fusion and industrial use of Autodesk Fusion. This edition of book, includes latest topics on Sketching, 3D Part Designing, Assembly Design, Sculpting, Mesh Design, CAM, Simulation, Sheetmetal, 3D printing, Manufacturing, and many other topics. Latest enhancements of the software have been added in this edition. The book covers almost all the information required by a learner to master the Autodesk Fusion. The book starts with sketching and ends at advanced topics like Manufacturing, Simulation, and Generative Design. Some of the salient features of this book are :

In-Depth explanation of concepts

Every new topic of this book starts with the explanation of the basic concepts. In this way, the user becomes capable of relating the things with real world.

Topics Covered

Every chapter starts with a list of topics being covered in that chapter. In this way, the user can easily find the topic of his/her interest easily.

Instruction through illustration

The instructions to perform any action are provided by maximum number of illustrations so that the user can perform the actions discussed in the book easily and effectively. There are about 2410 small and large illustrations that make the learning process effective.

Tutorial point of view

At the end of concept’s explanation, the tutorial makes the understanding of users firm and long lasting. Almost each chapter of the book has tutorials that are real world projects. Moreover, most of the tools in this book are discussed in the form of tutorials.

Project

Free projects and exercises are provided to students for practicing.

For Faculty

If you are a faculty member, then you can ask for video tutorials on any of the topic, exercise, tutorial, or concept. As faculty, you can register on our website to get electronic desk copies of our latest books, self-assessment, and solution of practical. Faculty resources are available in the Faculty Member page of our website (www.cadcamcaeworks.com) once you  login. Note that faculty registration approval is manual and it may take two days for approval before you can access the faculty website.

Formatting Conventions Used in the Text

All the key terms like name of button, tool, drop-down etc. are kept bold.

Free Resources

Link to the resources used in this book are provided to the users via email. To get the resources, mail us at cadcamcaeworks@gmail.com with your contact information. With your contact record with us, you will be provided latest updates and informations regarding various technologies. The format to write us mail for resources is as follows:

Subject of E-mail as Application for resources of ________book.

Also, given your information like

Name:

Course pursuing/Profession:

E-mail ID: 

Note: We respect your privacy and value it. If you do not want to give your personal informations then you can ask for resources without giving your information.

About Authors

The author of this book, Gaurav Verma, has authored and assisted in more than 17 titles in CAD/CAM/CAE which are already available in market. He has authored Autodesk Fusion PCB Black Book for working on electronics design. He has authored AutoCAD Electrical Black Books which are available in both English and Russian language. He has also authored books on various modules of Creo Parametric and SolidWorks. He has provided consultant services to many industries in US, Greece, Canada, and UK. He has assisted in preparing many Government aided skill development programs. He has been speaker for Autodesk University, Russia 2014. He has assisted in preparing AutoCAD Electrical course for Autodesk Design Academy. He has worked on Sheetmetal, Forging, Machining, and Casting designs in Design and Development departments of various manufacturing firms.

For Any query or suggestion

If you have any query or suggestion, please let us know by mailing us on cadcamcaeworks@gmail.com. Your valuable constructive suggestions will be incorporated in our books.
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Chapter  1

Starting with Autodesk Fusion

[image: ]

The major topics covered in this chapter are:
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Overview Of Autodesk Fusion 

Autodesk Fusion is an Autodesk product designed to be a powerful 3D Modeling software package with an integrated, parametric, feature based CAM module built into the software. Autodesk Fusion is the first of its kind 3D CAD, CAM, and CAE tool. It connects your entire product development process in a single cloud-based platform that works on both Mac and Microsoft Windows; refer to Figure-1. 

 [image: ]

It combines mechanical design, collaboration, simulation, and machining in a single software. The tools in Fusion enable rapid and easy exploration of design ideas with an integrated concept to production toolset. This software needs a good network connection to work in collaboration with other team members.

This software is much affordable than any other software offered by Autodesk. To use this software, one need to pay monthly subscription of Fusion. You can work offline in this software and later save the file on Autodesk Server. User can access this software from anywhere with an internet connection. The user is able to open the saved file and also able to share files with anyone from anywhere as long as he/she has the software and good internet connection. Also, the pricing of this software is so effective that anyone can use it for manufacturing of tools and parts. Autodesk Fusion is build to work in multi body manner: both parts and assemblies build in a single file. The procedure to install the software is given next.

Installing Autodesk Fusion (Student) 

•Connect your PC with the internet connection and then log on to https://www.autodesk.com/education/edu-software/overview as shown in Figure-2. 

[image: ]

•Click on the GET STARTED button, the Sign up page will be displayed; refer to Figure-3.
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•In this page, specify the personal details and in Education role drop-down, you need to select Student option and provide your date of birth. (There is free subscription for students with license term of 1 year which can be renewed).

•After filling the details, click on the Submit button from the page as shown in Figure-4. A message will be displayed confirming the account creation; refer to Figure-5.
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•Click on the DONE button. You will be sent back to education page of Autodesk.

•Click on the Get Educational Access button from the page; refer to Figure-6. The web page to confirm your educational status will be displayed.

•Provide the details in fields of this page and then click on the CONFIRM button. After completion of these processes, you may be asked to upload your documentation like ID card scan or receipt to confirm your student status. Once your account is approved which can take upto 2 days, you need to sign-in to your Autodesk Account and search for the Autodesk Fusion software.

[image: ]

•Click on the Get product button below the software name. The Access button will become active; refer to Figure-7. Click on this button to download the Autodesk Fusion software. 

[image: ]

•Open the download setup file and follow the instructions as per the setup instruction.

•The software will be installed in a couple of minutes.

Starting Autodesk Fusion 

•To start Autodesk Fusion from Start menu, click on the Start button in the Taskbar at the bottom left corner and then select Autodesk Fusion option from the Autodesk folder. Select the Autodesk Fusion icon; refer to Figure-8.
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•While installing the software, if you have selected the check box to create a desktop icon then you can double-click on that icon to run the software. 

•If you have not selected the check box to create the desktop icon and want to create the icon on desktop now in Windows 10 or later, then drag the Autodesk Fusion icon from Start menu to Desktop.

After clicking on the icon, the Autodesk Fusion software window will be displayed; refer to Figure-9.
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Starting a New document 

•Click on the File drop-down and select the New Design tool as shown in Figure-10. A new document will open.

[image: ]

•Select desired workspace from the Workspace drop-down; refer to Figure-11. 
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•There are six buttons available in Workspace drop-down in Educational version; DESIGN, GENERATIVE DESIGN, RENDER, ANIMATION, SIMULATION, MANUFACTURE, and DRAWING.

•The DESIGN button is used to create solid, surface, and sheet metal designs.

•The GENERATIVE DESIGN button is used to create multiple designs that meet your geometric, performance, and manufacturing requirements.

•The RENDER button is used to activate workspace for rendering realistic model for presentation. 

•The ANIMATION button is used to activate workspace for creating automatic or manual exploded views as well as direct control over unique animation of parts and assemblies.

•The SIMULATION button is used to perform Engineering Analyses.

•The MANUFACTURE button is used to generate G-codes for manufacturing processes like turning, milling, drilling, cutting, probing, and so on. 

•The DRAWING button is used for generating drawings from model and animation.

You will learn more about these workspaces later in this book.

File Menu 

The options in the File menu are used to manage files and related parameters. Various tools of File menu are discussed next.

Creating New Drawing 

The tools in New Drawing cascading menu are used to initialize a new drawing from animation or design; refer to Figure-12. The methods to use these tools will be discussed later in the book.
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Creating New Drawing Template

The New Drawing Template tool is used to create a template file for drafting. This template can either be created from scratch or you can use other drawing file as reference for template. This template can later be used for creating engineering drawings of the model. You will learn more about this tool later in the book.

Opening File

The Open tool is used to open files earlier saved in cloud or local drive. You can also use this tool to import supported files of other software. The procedure to use this tool is given next.

•Click on the Open tool from the File menu or press CTRL+O from keyboard. The Open dialog box will be displayed; refer to Figure-13. Note that we are working in online mode of Autodesk Fusion.

[image: ]

•By default, files saved on cloud are displayed in the dialog box. Select desired file and click on the Open button. The file will open in Autodesk Fusion.

•If you want to open a file stored in local drive then click on the Open from my computer button. The Open dialog box will be displayed; refer to Figure-14.

[image: ]

•Select desired file and click on the Open button. The status of import will be notified in the Notification Center.

•Once the status of import is complete then click on the Open button. The model will be displayed; refer to Figure-15.
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Recovering Documents

The Recover Documents tool is used to recover unsaved file versions which are created when software closes unexpectedly; refer to Figure-16. Note that there is an auto save feature in Autodesk Fusion which saves versions of file at a specific time intervals. If software has created the auto save version of your file then only you will be able to recover the file. By default, this time interval is 5 minutes and it can be changed in Preferences dialog box which will be discussed later. The procedure to use this tool is given next. 
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•Click on the Recover Documents tool from the File menu. The Document Recovery dialog box will be displayed where you need to select auto save version of your file; refer to Figure-17.

[image: ]

•Click on the file version that you want to be recovered and click on the Open button from the displayed menu. The file version will open in Autodesk Fusion. If the opened version is as desired then save it otherwise close it and open the other version from the Document Recovery dialog box.

Upload

The Upload tool is used to upload files on cloud. The procedure to use this tool is discussed next.

•Click on Upload button from the File menu. The Upload dialog box will be displayed; refer to Figure-18. Click on the Select Files button or Drag & Drop the files to be uploaded in the Drag and Drop Here area of the dialog box.

•If you want to change the location where files will be uploaded then click on the Change Location button and select desired location from the Change Location dialog box; refer to Figure-19.
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•After selecting desired location, click on the Select button. You will return to Upload dialog box with updated location. Note that you can also create new folders and new locations by using the options in Change Location dialog box which will be discussed later in this book.

•Click on the Select Files button to upload files and select multiple files while holding the CTRL key from the Open dialog box displayed; refer to Figure-20.
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•Click on the Open button from the dialog box to upload files. Or, drag the files in the dialog box and drop them. The options in the Upload dialog box will be updated; refer to Figure-21.
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•If you have selected a .PRT file of NX or Creo then select the .PRT files are not assembly files check box to explicitly tell software that these PRT files are not connected to any assembly.

•After specifying desired parameters, click on Upload button from Upload dialog box. Files will be uploaded and status will be displayed in Job Status dialog box.

Save 

The Save tool is used to save the current file on cloud. You can press CTRL+S key from keyboard to save file. The procedure to save file is given next.

 

•Click on the Save tool from File menu or select the Save button from Application bar as shown in Figure-22. The Save dialog box will be displayed asking you to specify the Name and Location of your file; refer to Figure-23. 
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•Specify desired name in the Name edit box.

•Click on the down arrow next to Location edit box in the dialog box if you want to select a different location on cloud. A list of locations created for/by you in Autodesk Cloud will be displayed; refer to Figure-24.
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•By default, Demo Project is added in the Project list. To add a new project, click on the New Project button at the bottom left corner of the dialog box. You will be asked to specify name of the new project; refer to Figure-25.

[image: ]

•Specify desired name for the project in displayed edit box and click anywhere in blank area of the dialog box. The new location will be created. Select this new location to save the file; refer to Figure-26.
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•If you want to create folder in the project with desired name then click on the New Folder button from the dialog box. You will be asked to specify the name of the folder. Specify the name of folder and click in blank area of the dialog box.

•To save your file in the folder, double-click on folder name to enter the folder and then click on the Save button. The file will be saved at specified location.

Note that when next time you will use Save tool after making changes then the Save dialog box will be displayed asking you to specify description for this new version of same file; refer to Figure-27. Type a short description about what has changed in this version and click on the OK button. You will notice that file name has changed from xxxxx v0 to xxxxx v1 which describes that this is the version 1 of same file. These versions can be accessed by Data Panel which will be discussed later.
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Save As 

Using the Save As tool, you can save the file with different name at different location. The procedure to use this tool is discussed next.

•Click on Save As tool from File menu; refer to Figure-28. The Save As dialog box will be displayed as shown in Figure-29.
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•Specify desired name and location for the file, and click on the Save button. The options in this dialog box are same as discussed in Save dialog box.

Save As Latest

When you are collaborating on a model with your team and after creating many versions of the model, you find that one of the previous versions is to be considered as final model for use. In such case, open the previous version file of Autodesk Fusion using Open tool and the Save As Latest tool will be active in File menu to save this version as latest; refer to Figure-30. On clicking the Save As Latest tool, an information box will be displayed showing how versions will be renumbered by making current version latest. Click on the Continue button from the information box. The Save As Latest dialog box will be displayed; refer to Figure-31. Specify desired description text about this version in Version Description edit box and click on the OK button from dialog box. The file will be saved on cloud.

[image: ]

[image: ]

Export

The Export tool is used to export the file in different formats. The procedure to use this tool is given next.

•Click on the Export tool from the File menu; refer to Figure-32. The Export dialog box will be displayed; refer to Figure-33. 
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•In the Type drop-down, there are various options to specify export format; F3D, IGES, SAT, SMT, STEP, IPT, DWG, DXF, and so on. Select desired format from the drop-down. Note that for some file formats, a cloud conversion will be required and take some time. You will be able to see progress of conversion in Job Status dialog box.

•Specify desired name and location for the file. Note that you can save the files only in the local drive by using this dialog box.

•Click on the Export button from the dialog box to save the file.

3D Print

The 3D Print tool is used to prepare and send current model for 3D printing. This tool convert the selected body to mesh body and sends the output to 3D-Print Utility or converts it to STL format. The procedure to use this tool is given next.

•Click on the 3D Print tool from the File menu or click on the 3D Print tool from the Make panel in the UTILITIES tab of the Toolbar; refer to Figure-34. The 3D PRINT dialog box will be displayed; refer to Figure-35. 
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•By default, the Selection button is active in this dialog box and you are prompted to select model to be 3D printed. Click on the model to be 3D printed.

•Select desired format of file in which you want to output the mesh model from Format drop-down in the dialog box.

•Select desired unit to be used in 3D printing from Unit Type drop-down.

•Now, select the Preview Mesh check box to see the number of triangles forming in the selected body when it converts to mesh.

If you don’t know why it is previewed in mesh then you need to know full name of standard file format used for 3D printing. STL format is used as standard for 3D printing which abbreviates Standard Triangle Language. So, your model will be broken into very small triangles and then these triangles will be arranged in the shape of your model in layers.   

•Select desired level of resolution for printing in Refinement drop-down menu. There are four resolution in this drop-down. If you select the High, Low, and Medium command then the Surface deviation, Normal deviation, Maximum Edge Length, and Aspect Ratio parameters in the Refinement Options section will be adjusted automatically. (Click on the arrow before Refinement Options node to expand the section.) If you want to adjust these parameters manually then you need to select the Custom option in Refinement drop-down; refer to Figure-36. Note that your 3D printing machine should be able to print the model at specified resolution. A higher resolution will take more time and power in 3D Printer. Unnecessarily high refinement should be avoided in 3D printing. 
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Now, for the technical stuff : 

The Surface Deviation is difference between real surface of model and triangulated tessellation of model. In simple language, it drives the number of triangles to be generated along the surfaces/faces in mesh; refer to Figure-37. The value specified in Surface Deviation edit box will be taken as maximum deviation allowed, the software will process the deviation lower than specified value but it will not go higher.
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The Normal Deviation is gap between two normals of consecutive triangles in tessellation. In simple words, a lower value of normal deviation will increase the number of triangles perpendicular to the edges of model in a given region; refer to Figure-38. 
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The Maximum Edge Length is used to define maximum length of triangle edges. If you decrease maximum edge length then more triangles of smaller edge length will be created in best possible orientations; refer to Figure-39. 
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The Aspect Ratio defines the ratio of number of triangles along width and height of the model; refer to Figure-40. (If you have irregular shape model then don’t bother finding aspect ratio, your software knows better!!)
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•Select the Send to 3D Print Utility check box in Output section to further edit the model in 3D printing utility. Select desired 3D Printing utility from Print Utility drop-down; refer to Figure-41. Note that 3D printing utilities are not installed automatically during Fusion installation. On selecting the utility from Print Utility drop-down, an option to download and install the utility will be displayed in the dialog box. Download and install desired utility.
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•Clear the Send To 3D Print Utility check box if you want to save the project file in STL or other 3D printing file format so that you can open this file later in any 3D Printing software.

•In our case, we have selected PreForm option from the Print Utility drop-down (Needless to say, we have installed it already). Click on the OK button from the dialog box. The PreForm application window will be displayed; refer to Figure-42. 
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The tools of this application are discussed next.

Preform 

Click on the Apply button from the JOB SETUP dialog box to enter the print utility, we will come back to these options later. On clicking Apply button, the model will be displayed in PreForm application window; refer to Figure-43.

[image: ]

Orienting the Model

There are two ways to orient a model in Preform, using Orientation tool from Toolbar or by using Manipulator displayed on the model. We will discuss both the ways here.

Orienting Model Using Manipulator

Click on the Circle handle in Manipulators for direction in which you want to rotate the model for orientation and drag the handle; refer to Figure-44. Note that software will automatically place the flat face of model on the bed of virtual machine. 
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If you want to move the model at some other location then click on the Move handle in Manipulators and drag it to desired location; refer to Figure-45.
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Note that the Manipulators are displayed on model only when the model is selected. If the Manipulators are not displayed by default in your case or it is hidden then select All option from Show Manipulators cascading menu from the View menu; refer to Figure-46.
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Orienting Using Orientation Tool

•Click on the Orientation tool [image: ] from the Toolbar at the left in application window. The ORIENTATION toolbox will be displayed; refer to Figure-47.
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•Click on the Auto-Orient Selected button to automatically orient the selected model on bed. (Note: this option was clumsy while writing this book and could not generate a proper orientation so we do not recommend this tool.)

•Click on the Select Base button to define the face which will be placed flat on the bed. After selecting this button, click on the face to be used as base of model; refer to Figure-48. The model will be automatically oriented to bed. Click on the Done button from the information box displayed in top-left corner. (This is the most used and recommended method to orient the part.)
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•You can use the spinners in ORIENT AXES area of the dialog box to define orientation angles for model. (These options are generally used to tweak the orientation; refer to Figure-49. You can also use handles in Manipulators to tweak the orientation.)
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•The buttons in ORIENT TO BOUNDING BOX area of toolbox are used to orient the model along respective faces of the bounding box. (Bounding box is an imaginary cuboid which defines maximum length, width, and height occupied by the model.)

•At any time, you find that you have messed up the orientation then you can move back to original orientation by clicking on the Reset Selected button at the bottom in the toolbox.

Note that there are two sides of bed for 3D printing machine called FRONT and MIXER SIDE; refer to Figure-50. The front is the side from where you will be extracting the 3D printing model so this is the side of machine where you will be standing while controlling the machine. The Mixer side is the one where material cartridge of 3D printer will be located.
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Changing View

You can use the Up, Down, Left, Right, and Home buttons at the top-right corner of application window to switch between different views; refer to Figure-51. To dynamically change the view, right-click in modeling area, hold the button, and drag the cursor.

To zoom in and zoom out, click on the + and - buttons respectively which are available in the View Switch buttons or you can scroll up and scroll down with mouse.
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The shortcut keys for changing views are given next.








	
Up View


	
CTRL + Up key





	
Down View


	
CTRL + Down key





	
Left View


	
CTRL + Left key





	
Right View


	
CTRL + Right key





	
Home View


	
F





	
Zoom in


	
+ or Scroll up





	
Zoom out


	
- or Scroll down





	
Pan


	
SHIFT + Right-click drag





	
Dynamic View change


	
Right-click drag







Scaling Model

To scale up or scale down the model, click on the Size handle in Manipulators, hold the button and then drag in desired direction to scale up or scale down; refer to Figure-52.
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OR

•Click on the Size button from the Toolbar at the left in application window. The  SIZE toolbox will be displayed; refer to Figure-53.
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•Specify desired scale value in the Scale edit box of toolbox or you can use the spinner to change its value.

•You can also use X, Y, or Z spinners to change the scale of model. Note that size of model will increase or decrease uniformly in all direction so it does not matter whether you use Scale, X, Y, or Z spinner.

•Click on the Reset button if you want to revert back to original scale. Close the toolbox after making desired changes.

JOB INFO Settings

The options in the JOB INFO area are used to set parameters related to printer. You can also check the warnings and details related to 3D printing process. Various tools and options are discussed next.

Job Settings

•Click on the Edit Job Setup button (Printer Type selection box) from the JOB INFO area at the right in the dialog box. The Job Setup window will be displayed; refer to Figure-54.
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•Click on the Printer Type button from left area of the window and select desired type of printer you want to use for printing.

•If you have selected a 3D printer which has options to select different types of materials then select desired type of materials and versions of resins you want to print with.

•Click on the Layer Thickness button and select desired thickness of layer to increase print speed or resolution. Thicker layers print faster and thinner layers print slower.

•Click on the Print Settings button and select desired print settings to control print speed, support print shape, and other aspects of print performance.

•Click on the Job Name button and type desired name in the Job Name edit box to help differentiate your print on the printer and dashboard. 

•After specifying desired parameters in the Job Setup window, click on the Apply button to make the changes.

Job Details

Various details of the printing job will be displayed in the DETAILS rollout of the JOB INFO area like estimated printing time, number of layers in 3D printed model, and total volume of material used in 3D printing.

Print Validation Options

There are three options in the Print Validation rollout of JOB INFO area; Minima, Cups, and Form Auto Release. The Print Validation icon defines whether the model is good for printing, there are warnings for 3D printing, or there are errors stopping from 3D printing like in Figure-55, a warning is displayed telling you that you need to elevate the model and add some supports for proper extraction.
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•Toggle the Minima button to display the unsupported areas of model if the model is not oriented correctly; refer to Figure-56.
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•Toggle the Cups button from the Print Validation rollout to display areas on model that can trap air while 3D printing. Most of the time cups are generated when there are holes/cuts perpendicular to base plane.

Adding Supports

The Supports tool in the Toolbar is used to add supports to the 3d printing object. Supports are used when the model is unstable or extraction of 3d printed model from base plate can cause damage to the model. The procedure to add supports is given next.

•Click on the Supports tool from the Toolbar or press C from keyboard. The SUPPORTS toolbox will be displayed; refer to Figure-57.
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•Click on the Auto-Generate Selected button to automatically generate support features for the selected model; refer to Figure-58. Note that using this button, only positions of support elements are decided. It does not automatically decides the shape and size of support elements. So, you should click on this button after you have specified the parameters for supports in the toolbox.
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•Select the Mini-Rafts option from the Raft Type drop-down if you want to mini-rafts for supports; refer to Figure-59.
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•Select the Raft Label check box if you want to 3D printing the name of file on the support raft.

•On selecting the Breakaway Supports check box, the breakaway support structures are easier to remove in pieces, but make a mess and do not perform well with high stresses like very long flat spans.

•Set desired density and touch point size in respective edit boxes in the toolbox. Density is the thickness of support base and touch point size is the thickness of upper section of support where it touches the model.

•Select the Internal Supports check box if you want to create internal supports whose start point and end point are on the model; refer to Figure-60.
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•Specify desired parameters in the ADVANCED SETTINGS rollout of the toolbox if needed.

Creating Layout for Multiple Part Printing

•Click on the Layout tool from the Toolbar. The LAYOUT toolbox will be displayed; refer to Figure-61.
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•Set desired parameters like space between two instances of the model, raft overlap, rotation lock, and number of duplicate copies of model to be created on same bed.

•After setting desired parameters, click on the Create button. The copies of model will be created on the bed. Note that every time you click on the Create button, new copies of the model are created. So, it is better to set the duplicate count value carefully and then click on the Create button; refer to Figure-62.

[image: ]

•Click on the Layout All button to arrange the copies of model in such a way that maximum number of copies can be accommodated on the bed; refer to Figure-63. Note that after using this tool, you might be able to add more copies of the model on bed.
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•Click on the X button at top-right corner to exit the toolbox.

Printing

Now, we are ready to start 3D printing of model layout. If you have printer connected with your system then click on the  Print tool from the File menu. The PRINT dialog box will be displayed; refer to Figure-64. Click in the Job Name edit box and specify desired name for print job. If you have 3D Printer connected then it will be displayed in the Printer list. You need to select the printer from the list. If your printer is connected to a network on FORMLABS then you need to specify account information or log in to your FORMLABS account. After setting desired parameters, click on the Add to Queue button. The file will be uploaded on FORMLABS account for printing.
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•Click in the Select Printer box of Printer area in the dialog box to select desired printer. The DEVICE LIST dialog box will be displayed; refer to Figure-65.
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•Select desired printer from the list and click on the Select button from the PRINTER DETAILS dialog box displayed; refer to Figure-66.
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•If you want to add a new printer in the list of DEVICE LIST dialog box, click on the +Add button from the dialog box. The ADD DEVICE dialog box will be displayed; refer to Figure-67. Specify the IP address of network printer in the IP address input boxes and click on the Connect button. The printer will be added in the list.
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After performing desired operations, click on the Quit PreForm tool from the File menu in the application window to exit the PreForm application.

Capture Image

The Capture Image tool is used to capture the image of model in current state. The procedure is discussed next.

•Click on the Capture Image tool from File menu; refer to Figure-68. The Image Options dialog box will be displayed; refer to Figure-69.
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•Select desired option from the drop-down in Image Resolution area to define size of image. All the other parameters of Image Resolution area will be defined automatically. 

•If you want to set image resolution other than the standard one then select the Custom option from the drop-down and define the parameters. By default, you are asked to specify size in pixels but you can also define the image size in inches by selecting the Inches option from the drop-down next to Width edit box. Now, you will be able to define pixel density in the Resolution edit box manually. Clear the Lock Aspect Ratio check box to specify values of height and width individually. 

•Select Transparent Background check box for setting the background of the image to be transparent.

•Select the Enable Anti-aliasing check box to smooth jagged lines or textures by blending the color of an edge with the color of pixels around it.

•After setting desired parameters, click on the OK button from Image Options dialog box. The Save As dialog box will be displayed; refer to Figure-70.
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•Select desired format from the Type drop-down for image. There are three formats available: PNG, JPG, and TIFF.

•Set the other parameters as discussed earlier and click on the Save button to save the image.

Sharing File Link

The Share File Link tool is used to share the file or project using a link. The procedure to use this tool is given next. Click on the Share File Link tool from File menu; refer to Figure-71. 
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•On selecting this tool, the Share dialog box will be displayed, refer to Figure-72.
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•Click on the toggle buttons to activate or de-activate respective functions.

•After activating the sharing function, copy the link from Copy box and share the link via E-mail or other method with anyone. Set the Allow item to be downloaded toggle button to allow downloading of file.

•Activate the Require a password to access the public link option and specify desired password in the edit box displayed below it to secure your link with a password.

View details On Web

The View Details On Web tool is used to display the details of current file on Autodesk cloud in web browser; refer to Figure-73. You can use this option only after you have saved your file on Autodesk cloud.
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View

The View tool is used to show and hide various elements of Fusion application window.

•Click on the View tool from File menu. The View cascading menu will be displayed; refer to Figure-74. 
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Various tools in this cascading menu are given next.

Hide ViewCube 

The Hide ViewCube tool is used to hide the ViewCube. If the ViewCube is already hidden then Show ViewCube tool will be displayed in place of it. On again selecting this tool, View Cube will be displayed. You can also show/hide ViewCube by pressing the CTRL+ALT+V keys.

Hide Browser

The Hide Browser tool is used to hide the Browser from the current screen. If the Browser is already hidden then Show Browser tool will be displayed in place of it. This tool can also be activated by pressing CTRL+ALT+B together.

Hide Comments 

The Hide Comments tool is used to show and hide the Comments from Fusion software. If the Comment is already hidden then Show Comment tool will be displayed in place of it. This tool can also be used by pressing CTRL+ALT+A together.

Show Text Commands 

The Show Text Commands tool is used to show Text Commands Bar. If the Text Commands  Bar is already displayed then Hide Text Commands tool will be displayed in place of it. This tool can also be activated by pressing CTRL+ALT+C together.

Hide Navigation Bar

The Hide Navigation Bar tool is used to hide the Navigation bar. If the Navigation Bar is already hidden then Show Navigation Bar tool will be displayed in place of it. This tool can also be activated by pressing CTRL+ALT+N together.

 

Show Data Panel

The Show Data Panel tool is used to show the Data Panel. If the Data Panel is already showing then Hide Data Panel tool will be displayed in place of it. This tool can also be activated by pressing CTRL+ALT+P together.

Reset To Default Layout

The Reset To Default Layout tool is used to reset user interface to default settings. This tool can also be used by pressing CTRL+ALT+R together. 

Scripts and Add-Ins

The Scripts and Add-Ins tool is used to run and manage Scripts and Add-Ins in Autodesk Fusion. The procedure to use this tool is discussed next.

•Click on Scripts and Add-Ins tool from ADD-INS drop-down in UTILITIES tab of Ribbon. The Scripts and Add-Ins dialog box will displayed; refer to Figure-75. 
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There are two tabs in this dialog box; Scripts and Add-Ins. Select the Script tab to run Python scripts in Autodesk Fusion. Select the Add-Ins tab to run the third party applications inside Autodesk Fusion. 

Creating Script and Add-Ins

•To create a script or Add-Ins, click on the Create button from Scripts and Add-Ins dialog box. The Create New Script or Add-In dialog box will be displayed; refer to Figure-76.
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•Select Script radio button to create a script or select the Add-In radio button to create an Add-In. 

•Select desired radio button from the Programming Language area to define the language in which you will be writing script/Add-in codes.

•Set the other parameters as required and click on the Create button. A new script/Add-in will be added in the dialog box. 

•Select the newly created script/Add-in and click on the Edit button. If the script/Add-in is coded in Python then an information box will be displayed asking you to download and install VS Code. Download & install the application and once installation is complete, codes will be displayed in application where you can edit it; refer to Figure-77.
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•If you have opted for any other language then system will ask you for respective Programming software to display codes. If you like coding then you can check Learning Python, 5th Edition by Mark Lutz as reference book for Python programming.

•Click on the Run button from the Scripts and Add-Ins dialog box to run selected script. 

•If you want to debug a script/Add-in then select it from the Scripts and Add-Ins dialog box and click on the Debug button in Run drop-down; refer to Figure-78. Programming interface will be displayed based on language of selected script/Add-In.
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Fusion App Store 

The Fusion App Store tool in ADD-INS drop-down of UTILITIES tab in Ribbon is used to download and install third party Apps in Autodesk Fusion. On clicking this tool, a web page is displayed in your default web browser; refer to Figure-79.
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•Login to your Autodesk account after clicking Sign In button at the top right in the web page.

•Select desired app, set the operating system option, and click on the Download button from web page; refer to Figure-80. The software will start downloading.
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•Once downloaded, double-click on the setup file to install it and follow the instructions as displayed during installation. 

•Once the app is installed, you can access it from Add-Ins tab of Scripts and Add-Ins dialog box; refer to Figure-81.
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Undo And Redo Button 

The Undo tool is used to revert back to condition before performing most recent action. The procedure to use this tool is discussed next.

•Click on Undo tool in Application bar or press CTRL+Z keys; refer to Figure-82.

•You can’t undo some actions, like clicking commands on the File tab or saving a file.
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•The Redo tool is used to redo an action reverted by Undo tool. To use this tool, select the Redo button in Application bar or press CTRL+Y keys. 

•The Redo button activates only after you have undone an action.

User Account drop-down 

The tool in User Account drop-down are used to manage user account details and preferences for Autodesk Fusion; refer to Figure-83. The tools in this drop-down are discussed next.
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Preferences 

The Preferences tool is used to set the preferences for various functions of the software like you can set units, material libraries, display options, and so on. The procedure to use this tool is given next.

•Click on Preferences tool from User Account drop-down; refer to Figure-83. The Preferences dialog box will be displayed where you can specify various parameters for application; refer to Figure-84.
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General 

In General node, you can specify the preferences for language, graphics, mouse functioning, default workspace, and so on. Click on the General node at the left in the dialog box to display general options. Various important options are discussed next.

•Click on the User language drop-down and select desired language for Autodesk Fusion interface.

•Select desired version of the SpaceMouse SDK used by the Fusion from SpaceMouse driver drop-down.

•Click on the Graphics driver drop-down to select the graphics driver to be used by Autodesk Fusion.

•Offline cache time period (days) edit box/spinner is used to specify the number of days up to which your documents can be in the cache memory of Autodesk Fusion before you go back to online mode of Autodesk Fusion. If you specify high value then more local memory will be used by Autodesk Fusion to save temporary copy of your documents. If you specify a low value here then system will prompt you soon to go back online. The maximum number of days specified here can be 360 and minimum number of days can be 7.

•Select desired option from Default document preference drop-down to start a new design.

•Whenever Autodesk Fusion is updated, launch icons are created automatically in various locations. Select the Skip launch items creation when live update check box to skip creating new launch icons.

•Select Show Home tab at the application startup check box to show the home tab at starting of the application. 

•Select the Automatic version on close check box to automatically save the newer version of file when you close Autodesk Fusion.

•Specify desired time in minute after which a recovery copy of your model will be created automatically in the Recovery time interval (min) edit box.

•Click on the Default modeling orientation drop-down and select desired direction option to define default orientation of model. In most of the CAD software, Z axis upward is the default orientation of model. To set the common orientation, select the Z up option from the drop-down.

•Select the Show tooltips, Show command prompt, Show default measure, Show in-command errors and warnings, and Show Fusion Team notifications check boxes to display respective interface elements. 

•Select desired software style from the Pan, Zoom, Orbit shortcuts drop-down to define which software style for shortcuts of pan, zoom, and orbit should be used. If you are switching from Alias, Inventor, Solidworks, or Tinkercad to Autodesk Fusion then you can select respective option from the drop-down to use familiar shortcuts.

•Select desired option from the Default Orbit type drop-down to define the default orbit type for rotating model view. There are two options available for orbit; Constrained Orbit and Free Orbit.

•Select the Reverse zoom direction check box to reverse the zoom direction of mouse scroll and other zoom methods.

•Select the Enable camera pivot check box to display camera pivot point used as center for orbiting. 

Note that by default the pivot point is placed on center of mass point of model but if you want to change the position of pivot point then right-click in blank area of canvas and select the Set Orbit Center option. The green point will get attached to cursor and you will be asked to define the location of orbit point. Click at desired location to place the orbit center.

API Options

•Click on the API option under General node in the left of the dialog box and set desired parameters to define default location and language of scripts/Add-Ins.

Design Options

•Click on the Design option under General node in the left of the dialog box to set the parameters related to model creation. The options in the dialog box will be displayed as shown in Figure-85.

•Select the Active Component Visibility check box to display only currently active component and hide rest of the components.

•Select the Capture Design History option from Design History drop-down if you want to keep detail of every operation you perform on the model in model history. If you want to save space or want to hide operation details while sharing file then create the model after selecting Do not capture Design History option from the Design History drop-down. Note that changes made in most of the options will be applied only after you have restarted Autodesk Fusion.
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•Select the Animate joint preview check box if you want to check small animation of how joint will work. The animation can give you clues about degrees of freedom which are constrained by selected joint.

•Select the Allow 3D sketching on lines and splines check box if you want to create lines and splines which are not confined to single plane.

•Select the Auto project edges on reference check box if you want to automatically project edges of model when they are used as reference for dimensioning or constraining of other sketch elements. Refer to Figure-86.
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•Select the Auto look at sketch check box to automatically make sketching plane parallel to screen. 

•Select the Edit dimension when created check box if you want to edit the values of dimensions when you are applying dimensions to objects.

•Selecting the Show ghosted result body check box will create a ghost image of model before a sculpting operation is performed on it. Note that the ghost image will be displayed until you are in sculpt mode; refer to Figure-87. When you exit the model after making changes then the ghost image will not be displayed.
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•Select the Auto project geometry on active sketch plane check box if you want to project geometry on the sketching plane by default.

•Select the Auto hide sketch on feature creation check box to automatically hide the sketch after it has been used to create a feature.

•Select the Scale entire sketch at first dimension check box to automatically fit the sketch objects in view area with reduced dimensions after you specify first dimension of the sketch; refer to Figure-88. Note that all the other objects reduce in same ratio as the first dimension reduces its respective entity.
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•Similarly, set the other options as required on different nodes of the dialog box. We will work with options in this dialog box during rest of the book whenever a change in application settings is required.

•After setting the parameters, click on the OK button from the dialog box and restart Autodesk Fusion if needed. 

Autodesk Account

The Autodesk Account tool in User Account drop-down is used to manage your Autodesk account profile in default web browser. 

My Profile

The My Profile tool in User Account drop-down is used to manage your project data stored on cloud via web browser.

Work Offline/Online

The Work Offline/Online toggle button is displayed on clicking Job Status button at the left of User Account drop-down; refer to Figure-89. Click on this button to toggle between offline and online mode of Autodesk Fusion. 

 [image: ]

Extensions

Click on the Extensions button to display the list of current available extensions in the Extension Manager dialog box for adding more functionality to Autodesk Fusion; refer to Figure-90. If you want to use these extensions then select the extension to be used and click on Purchase button or activate button if available.
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Help drop-down

When you face any problem working with Autodesk Fusion, the tools in Help drop-down can be useful; refer to Figure-91. Tools in the drop-down are given next.
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Search Help Box

When you are facing any problem regarding tools and terms in the software, then you need to type keywords for your problem in Search Box and press ENTER to find a suitable solution to your problems; refer to Figure-92. 
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Learning and Documentation

The tools in the Learning and Documentation cascading menu are used to display video tutorials, help files, and Fusion api related content in web browser; refer to Figure-93. On clicking the Self-Paced Learning button in the Learning and Documentation cascading menu of Help menu, the website of Autodesk Fusion will be displayed; refer to Figure-93.
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Similarly, you can use Product Documentation and Fusion API tools to learn about Fusion interface, design methodology, and APIs.

Quick Setup

When you are new to Autodesk Fusion then this tool will help you to understand this software terminology and basic settings. 

•Click on Quick Setup tool from Help menu. The QUICK SETUP dialog box will be displayed; refer to Figure-95.
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•Set desired unit in the Default Units drop-down.

•The navigation functions of mouse can be set as per Autodesk Inventor, SolidWorks or Alias software by selecting respective option from the CAD Experience drop-down.

•If you are new to CAD then you can select the New to CAD option in Cad Experience drop-down. The mouse will function as per Autodesk Fusion.

Similarly, you can use Community Forum, Insider Program, Blog tool to get help from Autodesk Fusion users or provide feedback. 

Support and Diagnostics

When you are having a problem in Fusion and want Technical support team to look at software problem data, then you can create the log files and send it to the support team of Autodesk.

•To create log files, select Diagnostic Log Files tool under the Support and Diagnostics cascading menu in Help drop-down. The Diagnostic Log Files dialog box will be displayed; refer to Figure-96. 
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•Click on Open File Location button and select the log file which you want to send to technical support team for the solution of problem.

Similarly, you can use Graphics Diagnostic, Clear user cache data, Service Utility and other tools from Help drop-down in Autodesk Fusion.

Data Panel

The Data panel is used to manage Autodesk Fusion projects. The projects you save in cloud are shown in the Data panel. You can easily access the saved project files from anywhere and anytime with the help of internet access.

To show or hide the Data panel, click on the Show Data Panel or Hide Data Panel button [image: ] at upper left corner of the Fusion window; refer to Figure-97. A box will be displayed with files of current project. In this box, there are two sections; Data and People. 
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In Data section, the files which you have saved earlier in current project will be displayed. You can open any file by double-clicking on it.

In People section, the information of users will be displayed who have access the files of current project; refer to Figure-98.
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Working in a Team

Using the tools in User drop-down of Data Panel, you can create a new team or work in other's team to create designs in collaboration with others; refer to Figure-99. Various tools of this drop-down are discussed next.
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Creating a Team

•To create your own team for a given project, click on the Create or join team tool from the drop-down. An information box will be displayed about Fusion Team; refer to Figure-100. Note that this information box will be displayed for only one time when you are creating team using educational version of software as Educational version can create only 1 team for students & educators.
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•Click on the Next button from the information box. The options to create or join teams will be displayed in a dialog box; refer to Figure-101.
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•Click on the Create a Team option from the dialog box displayed. You will be asked to specify name of the team in next page of dialog box; refer to Figure-102.

[image: ]

•Specify desired name for the team to be created and click on the Next button. The next page in dialog box will ask you whether to make the team discoverable on cloud server or make it private.

•Select desired radio button from the dialog box and click on the Create button. A message box will be displayed tell you that a team with your specified name is created. Click on the Go to team button from the information box. Name of the team will be added in the Data Panel; refer to Figure-103.
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•Click on the Open Administrator Console on the Web button (similar to common settings button icon) displayed next to name of the team. The administration page for team will be displayed in the default web browser; refer to Figure-104.
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•Specify desired parameters in this page to define settings related to file sharing, access, and collaboration. Note that you can set auto-approval settings for specified domains by using the Add domain button on this page. You will be asked to specify the text in email ID displayed after @ like for matt@cadcamcaework.com the @cadcamcaework.com is domain.

•To add members in your team, click on the Members and Roles tab in the web page. The options will be displayed as shown in Figure-105.
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•To invite a new member, click on the Invite button on this page. The Invite Team Members dialog box will be displayed; refer to Figure-106.
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•Specify the email id's of team members separated by comma (,) in the Enter email addresses edit box and click on the Invite button. Once they accept invitation on their email ids, they will become members of the team. You can later assign the roles to members as desired using the Administrator page. You can now logout and close the browser to exit the admin panel of Fusion team.

After creating a team, make sure you are log-in by team name in the Data Panel and create a new project using New Project button in the Data Panel. This new project will be shared with all the team members for modifications based on roles assigned to them; refer to Figure-107.
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Cloud Account of User 

To open the cloud account of user, you need to click on the Open on the Web button next to the name of user in Data Panel; refer to Figure-108. On selecting this button, details of user’s cloud storage will be displayed in web browser. You can check and modify the files as desired. Note that you can delete any file available in Cloud account using the tools in web browser which is not possible in Data Panel; refer to Figure-109.
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Browser 

The BROWSER presents an organized view of your design steps in a tree like structure on the left of the Fusion screen; refer to Figure-110. When you select a feature or component in the BROWSER, it is also highlighted in the graphics window. 
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•Click on the Eye button to toggle the visibility of respective object.

•If you select any object in BROWSER then it is highlighted in blue color which indicates that the respective object is active for various operations. 

•To change the units of the design or sketch, select the Change Active Units button as highlighted in the above figure. The CHANGE ACTIVE UNITS dialog box will be displayed. Select desired unit and click on the OK button. 

Navigation Bar

The Navigation Bar is available at the bottom of graphics window of Fusion. It provides access of navigation commands for design. To start a navigation command, click on any tool from the Navigation Bar; refer to Figure-111. There are various tool in Navigation Bar to navigate the model which are discussed next.

•Orbit- The Orbit tools are used for rotating the current model. There are two types of orbit tools i.e. Free Orbit and Constrained Orbit. Free Orbit is used to rotate the design view freely and Constrained Orbit is used to rotate the view in constrained motion relative to current origin point. The Constrained Orbit tool is displayed on clicking down arrow next to Free Orbit tool. After selecting this tool, click at desired location on model and drag the cursor to rotate model view. You can do the same function by using SHIFT + Middle Mouse Button dragging.
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•Look At- This tool is used to view selected face parallel to screen. To use this tool, select desired face of model, and then click on the Look At tool from Navigation Bar.

•Pan- It is used to move the design parallel to the screen. You can do the same function by middle mouse button drag.

•Zoom- It is used to increase or decrease the magnification of the current view. After selecting this tool, click on the model, hold, and drag mouse upward/downward to zoom in/out. You can do the same function by rolling the mouse wheel up/down.

•Zoom Window and Fit - Zoom Window tools are used for magnification of selected area. Fit tool is used to position the entire design on the screen. You can do the same function as Fit tool does by pressing F6 from keyboard.

Display Bar

The tools of Display Bar are used to visualize the design in different viewports; refer to Figure-112. 
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Display Settings

The options in the  Display Settings flyout are used to enable or disable various commands related to Visual Style, Visibility of objects, Camera settings, and so on; refer to Figure-113.
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•Select desired visual style of 3D model from the Visual Style cascading menu. Various styles available are Shaded, Shaded with Hidden Edges, Shaded with Visible Edges only, Wireframe, Wireframe with Hidden Edges, Wireframe with Visible Edges only. (You can open a sample file of 3D model and check the effects of different visual styles.)

•Select desired option from the Environment cascading menu to define color scheme of the canvas.

•Select desired check boxes for effects that you want to add in display style from the Effects cascading menu. Similarly, you can display or hide objects from the Object Visibility cascading menu.

•The options in Camera cascading menu are used to change the display to Orthographic, Perspective, or Perspective with Ortho Faces.

•Click on the Ground Plane Offset tool from the Display Settings flyout. The GROUND PLANE OFFSET dialog box will be displayed; refer to Figure-114. Clear the Adaptive check box and set desired offset value if you want to change the location of ground plane. Note that position of ground plane is generally changed for rendering which will be discussed later.
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•If you want to run Autodesk Fusion in full screen then press CTRL+SHIFT+F from keyboard.

Grids and Snaps

•The Grid and Snaps flyout is used to activate or deactivate various options like Layout Grid, Layout Grid Lock, Snap to Grid, and so on. You can also define the size of grid and snapping increments by using Grid Settings and Set Increments tools in this flyout.

Viewports

•The options in Viewports flyout are used to switch between four viewports and single viewport in the Fusion screen. Click on the Multiple Views option from the Viewports flyout to display the current model in different views in four viewports. You can click in each of the viewport and reorient the model. If you want to set these views to synchronous again then select the Synchronize Views check box from Viewports flyout. If you want to move back to single viewport then select the Single View tool in Viewports flyout. By pressing SHIFT+! keys, you can toggle between single viewport and multiple viewports modes.

ViewCube 

The ViewCube tool is used to rotate the view of model to access different faces of model. Click at desired location on model and drag the ViewCube to perform a free orbit. There are six faces in ViewCube; Top, Bottom, Front, Back, Right, and Left to access different orientations of model. To access the standard orthographic and isometric views, click on the faces and corners of the cube; refer to Figure-115. Right-click on the ViewCube to access options related to perspective mode and other view modes.
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Mouse Functions

You can use the mouse shortcuts to zoom in/out, pan the view, and orbit the view; refer to Figure-116.
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•Scroll the Middle Mouse Button downward/upward to zoom in or zoom out, respectively. Note that this function can be reversed by using options in Preferences dialog box.

•Click and hold the Middle Mouse Button to pan the view.

•Use the Shift + Middle Mouse Button to orbit the view. 

•Press the left mouse button to select any object or tool.

•Press right mouse button (right-click) to access shortcut menus in the software.

Timeline 

The Timeline bar is very useful for saving time while editing. It records the design feature in chronological order; refer to Figure-117. Note that the Capture Design History (Parametric Modeling) option must be active in the Design node of Preferences dialog box to access Timeline bar. 
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If you want to edit any feature of model then double-click on the respective feature from Timeline bar. The respective dialog box/interface element will be displayed. Make desired changes and apply the parameters. The final design will be generated automatically with the applied changes; refer to Figure-118.
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Customizing Toolbar and Marking Menu

In Autodesk Fusion, you can add or remove any tool in the displaying panels of Toolbar. You can also add or remove tool from right-click marking menu. These operations are discussed next.

Adding Tools to Panel

•Click on the Three dot button next to tool to be added in the panel from the drop-down of Toolbar. The shortcut menu to customize toolbar will be displayed; refer to Figure-119.

•Select the Pin to Toolbar check box from the shortcut menu. The tool will be added in the panel.
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Assigning Shortcut Key

•Click on the Change Keyboard Shortcut option from the shortcut menu as shown in Figure-119. The Change Keyboard Shortcut dialog box will be displayed; refer to Figure-120.
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•Use desired combine modifier like SHIFT, CTRL, or ALT and then press desired alphanumeric key to create a shortcut button.

•If you want to remove shortcut key then use Backspace to delete shortcut key from edit box. Click on the OK button from the dialog box to apply the settings.

Adding or Removing tool from Shortcut menu/Marking menu

•Select the Pin to Shortcuts check box from the shortcut menu for tool that you want to add in right-click shortcut menu/marking menu; refer to Figure-121.
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•Clear the Pin to Shortcuts check box from the shortcut menu for tool that you want to remove from right-click shortcut menu/marking menu. 

Note that the shortcut menu is workspace specific so what you find in shortcut menu for DESIGN workspace will be different from MANUFACTURE workspace, and so on.

Removing Tool from Panel in Toolbar

To remove a tool from panel in Toolbar, select the tool and drag it to canvas; refer to Figure-122.
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Similarly, you can change position of tool by dragging it within the panel.

Resetting Panel and Toolbar Customization

Right-click on any of the tool in Toolbar. A shortcut menu will be displayed as shown in Figure-123. 
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Click on the Reset Panel Customization option to reset current panel to original state. Note that this option will be available only when you have added or removed a tool from the panel.

Click on the Reset All Toolbar Customization option from the shortcut menu if you want to reset the complete toolbar including all the panels to its original state. 

Self Assessment

Q1. ............... is used to manage the Fusion project.

Q2. The...............button is used for producing CNC codes.

Q3. Which of the following workspace is not available in Autodesk Fusion application?

a.  Patch Workspace

b.  Model Workspace

c.  Assemble Workspace

d.  Drawing Workspace

Q4.  Discuss the use of Save tool with example.

Q5.  Discuss the process of exporting a project in computer with example.

Q6.  Discuss the use of 3D Print tool with example.

Q7.  Which tool is used to generate Toolpaths for model?

Q8.  How to reset the default layout?

Q9. Explain the process of creating Script with example.

Q10. Mark the following statements as True or False:

a. Autodesk Fusion software can be used to perform CAD operations.

b. Autodesk Fusion software can be used to perform CAM operations.

c. Autodesk Fusion software can be used to perform CAE operations.

d. Autodesk Fusion software can be used to perform PLM operations.

e. Autodesk Fusion software can be used to perform direct 3D printing on 3D Printer.

Q11. Which of the following tool is used to create a new part model in Autodesk Fusion?

a. New Design

b. New Drawing->From Animation

c. New Drawing->From Design

d. New Drawing->New Drawing Template

Q12. Which of the following workspace is not available in educational version of Autodesk Fusion?

a. Animation

b. Manufacturing

c. Generative Design

d. Simulation

Q13. Which of the following tool is used to save the file in local drive in Autodesk Fusion?

a. Save

b. Save As

c. Export

d. Upload

Q14. STL format is used as standard for 3D printing which abbreviates Standard Triangle Language. (T/F)

Q15. Which parameter of an STL file can decrease the angular distance between two edges of triangle as shown in next figure (from left to right)?
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a. Surface Deviation

b. Normal Deviation

c. Aspect Ratio

d. Maximum Edge Length







Chapter  2

Sketching
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The major topics covered in this chapter are:

•Introduction

•Starting Sketch

•Sketch Creation Tools

•Sketch Editing Tools

•Sketch Palette

•Constraints

•Sketching Practical and Practice




Introduction

In Engineering, sketches are based on dimensions of real world objects. These sketches work as building blocks for various 3D operations. In this chapter, we will be working with sketch entities like; line, circle, arc, polygon, ellipse, and so on to create base feature for various 3D operations. Note that the sketching environment is the base of 3D Models so you should be proficient in sketching.

There is no separate workspace for sketching and tools to create sketches are available in Design workspace. So, we will be working in Design workspace in this chapter. We will learn about various tools of toolbar used in sketching and 3D Sketching.

Starting Sketch

•To start a new sketch, click on the Create Sketch tool from CREATE drop-down in SOLID tab of Toolbar; refer to Figure-1. The three primary planes will be displayed on canvas screen; refer to Figure-2.
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•Click on desired plane from the canvas screen. The selected plane will become parallel to the screen and act as current sketching plane. Also, the tools to create sketch will be displayed in SKETCH contextual tab in the Toolbar; refer to Figure-3. Now, we are ready to draw sketch on the selected plane.
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First, we will start with the sketch creation tools and later, we will discuss the other tools.

Sketch Creation Tools

There are various tools in CREATE drop-down for creating sketch entities. These tools are discussed next.

Line

In Autodesk Fusion, the Line tool is used to create a line or arc. The procedure to use this tool is discussed next.

•Click on Line tool of CREATE drop-down from Toolbar; refer to Figure-4. You can also press L key to select the Line tool. You will be asked to specify start point of the line.
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•Click at desired location to specify start point and move the cursor away from selected point in desired direction in which you want to create the line. Angle and Length input boxes will be displayed with the preview of line. 

•Specify desired value of length in the Length input box. Press TAB key to toggle to Angle input box; refer to Figure-5.
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•If you are creating a freestyle line then click on the screen at desired location without specifying any value in Length and Angle edit boxes. Press ESC after specifying end points to exit the tool.

•To create a line for construction purpose, click on the Construction button from SKETCH PALETTE displayed at the right in the application window after activating Line tool; refer to Figure-6. (You will learn more about SKETCH PALETTE later in this chapter.) You can also right-click on the line after creating it and then click on Normal/Construction button from Marking menu to do the same; refer to Figure-7.
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Marking menu

It is the radical display of most frequently used tool and tools related to selected entities. This menu also provides a quick access to the tools of the toolbar. This menu is the fastest way to activate the tool. To access this menu, right-click anywhere on the screen within the graphics window. To select any tool of this menu, move the cursor towards the tool and the tool will be highlighted. Click on it to activate the tool.

Creating Arc using Line Tool

You can create an arc using the Line tool which has one of its end point shared to another entity. In simple words, the starting point of arc created by Line tool will lie on end point of another line or arc. The procedure to create arc is given next.

•Click on the end point of a line or curve to define start point of arc, hold the LMB (Left - Mouse Button), and drag to the point where you want to specify the end point of arc; refer to Figure-8.
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Rectangle

The tools in Rectangle cascading menu are used to create rectangles. There are three tools in Rectangle cascading menu; 2-Point Rectangle, 3-Point Rectangle, and Center Rectangle; refer to Figure-9.
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You can also activate the Rectangle tool by pressing R key while in Sketch mode. The procedures to use these tools are discussed next.

2-Point Rectangle

•Click on the 2-Point Rectangle tool of the Rectangle cascading menu from CREATE drop-down in SKETCH contextual tab. You will be asked to specify the first point.

•Click on the sketch canvas to specify first point of rectangle. You will be asked to specify the other corner point; refer to Figure-10.
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•Specify the length and width of rectangle in the dynamic input boxes. To switch between the length dynamic input box and width dynamic input box, press TAB key.

•After specifying the parameters, press ENTER to create the rectangle. To exit the tool, press ESC key.

•If you want to create a freestyle rectangle then click on the screen to select the first corner point and other diagonal corner point of the rectangle on the sketch canvas.

•To add dimensions, right-click on the line of rectangle and click on Sketch Dimension tool in Sketch drop-down from the Marking menu. You can also activate the Dimension tool by pressing d from keyboard after selecting the line. You will learn more about dimensioning later in this chapter.

3-Point Rectangle

•Click on the 3-Point Rectangle tool of Rectangle cascading menu from CREATE drop-down. You will be asked to specify location of first corner point of rectangle.

•Click at desired location to specify first corner point of the rectangle on the sketch canvas; refer to Figure-11.
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•Next, click to specify the second corner point (end point of base line of rectangle) on the canvas or specify the dimension in dimension box.

•Next, click to specify the third point of the rectangle to define the length of rectangle and complete the rectangle creation.

Center rectangle

•Click on the Center Rectangle tool of the Rectangle cascading menu from CREATE drop-down. You will be asked to specify center point of the rectangle.

•Click on the canvas to specify the center point of the rectangle; refer to Figure-12. You will be asked to specify corner point of rectangle.
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•Type the dimension for rectangle in the edit boxes and press ENTER to create the rectangle.

•If you want to create freestyle rectangle then click on the screen to select the center point and corner point of rectangle.

Note that you can switch between different types of rectangles from the Rectangle section of SKETCH PALETTE after activating the Rectangle tool.

Circle

There are five tools in Circle cascading menu to create circles; Center Diameter Circle, 2-Point Circle, 3-Point Circle, 2-Tangent Circle, and 3-Tangent Circle; refer to Figure-13.
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The shortcut key to use the Center Diameter Circle tool is by pressing C key from keyboard. The tools to create circle are discussed next.

Center Diameter Circle

The Center Diameter Circle tool is used to create circle specifying center location and diameter value. The procedure to use this tool is given next.

•Click on the Center Diameter Circle tool from Circle cascading menu in the CREATE drop-down of SKETCH contextual tab. You will be asked to specify center point of circle. 

•Click to specify the center point for the circle; refer to Figure-14. You will be asked to specify circumferential point of circle to define diameter. 
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•Click to specify the circumferential point or enter desired value of diameter in the dynamic input box.

2-Point Circle

The 2-Point Circle tool is used to create circle by specifying two circumferential points. The procedure to use this tool is discussed next.

•Click on the 2-Point Circle tool of Circle cascading menu from CREATE drop-down and specify the first point for circle; refer to Figure-15.
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•Specify the second point on the canvas screen or type the diameter dimension in the dynamic input box and press ENTER key.

3-Point Circle

The 3-Point Circle tool is used to create circles using 3 circumferential points as references. The procedure to use this tool is discussed next.

•Click on 3-Point Circle tool of Circle cascading menu from CREATE drop-down. 

•Click on the screen to specify the first point, second point, and third point of circle; refer to Figure-16. Note that you can also select on other entities to define circumferential points for circle.
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•After specifying points, right-click on the screen and click OK button from Marking menu to complete the process. You can also press ESC key to exit the circle tool.

•If you want to add dimensions then right-click on the selected circle and click on the Sketch Dimension tool from Marking menu. You can also select Sketch Dimension tool from SKETCH drop-down.

2-Tangent Circle

The 2-Tangent Circle tool is used to create a circle which is tangent to two selected lines. The procedure to use this tool is discussed next.

•Select 2-Tangent Circle tool of Circle cascading menu from CREATE drop-down. 

•Click at desired locations on lines that should be tangent to the circle; refer to Figure-17. Preview of circle will be displayed.
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•Type desired radius value of the circle in the dynamic input box and press ENTER to create a circle or click at desired location to define diameter of the circle. 

•Press ESC to exit the tool.

3-Tangent Circle

The 3-Tangent Circle tool is used to create a circle using three tangent lines. The procedure to use this tool is discussed next.

•Click on 3-Tangent Circle tool of Circle cascading menu from CREATE drop-down.

•Select three lines to be tangent to the circle. You can also use window selection to select the lines; refer to Figure-18. The preview of circle will be displayed. 

•Right-click on the screen and click OK button from Marking menu to create the circle. You can also press ESC key to exit the tool.
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Arc

The Arc tool is used to create arcs. There are three tools in the Arc cascading menu; 3-Point Arc, Center Point Arc, and Tangent Arc; refer to Figure-19.
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The tools of Arc cascading menu are discussed next.

3-Point Arc

The 3-Point Arc tool is used to create an arc using three points (start point, end point, and circumferential point). To use this tool, you need to specify two end points and one circumferential point of the arc. The procedure to use this tool is discussed next.

•Click on 3-Point Arc tool of Arc cascading menu from CREATE drop-down. You will be asked to specify points for arc.

•Click on desired location to specify the start point of the arc; refer to Figure-20.
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•Click on the screen to specify the end point of the arc.

•Click at desired location to define the radius of arc. The arc will be created.

•Press ESC to exit the tool.

Center Point Arc

The Center Point Arc tool is used to create arc by defining center point, start point, and end point of the arc. The procedure is given next.

•Click Center Point Arc tool of Arc cascading menu from CREATE drop-down. You will be asked to specify center point of the arc.

•Click on the screen canvas to specify the center point of arc.

•Click to specify the start point of the arc or type desired value of radius in dynamic input box.

•Enter desired angle value in dynamic input box to define length of arc or click on the screen to specify the end point of the arc; refer to Figure-21.
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•The arc will be displayed. Right-click on the screen and click OK button from Marking menu to exit the tool. You can also press ESC key to exit the tool.

Tangent Arc

The Tangent Arc tool is used to create arc tangent to selected entity. 

•Click on the Tangent Arc tool of Arc cascading menu from CREATE drop-down.

•Click near the end point of an entity (line, arc, or curve) from screen to specify the start point of the arc; refer to Figure-22. A rubber-band arc will be attached to cursor starting from selected point.

•Click at desired location to specify the end point of the arc.
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•Right-click on the screen and click OK button from Marking menu to complete the process. You can also press ESC key to exit the arc tool.

What happens when you try to create an arc at corner location where two entities meet and selected point is common to both the entities; refer to Figure-23. Will the arc be created tangent to line 1 or line 2? What if the arc is being created tangent to line 1 but we want to create it tangent to line 2. In such conditions, after selecting end point, move the cursor in line with entity to be tangent for few millimeters and then specify the end point at desired location; refer to Figure-24.
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Polygon

The Polygon tool is used to create polygon of desired number of sides. There are three tools to create polygon in Polygon cascading menu; Circumscribed Polygon, Inscribed Polygon, and Edge Polygon; refer to Figure-25. The tools to create the polygons are discussed next.
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Circumscribed Polygon

Use the Circumscribed Polygon tool to create a polygon formed outside the reference circle. Note that midpoints of polygon lines will lie on the reference circle. The procedure to use this tool is discussed next.

•Click on the Circumscribed Polygon tool of Polygon cascading menu from CREATE drop-down; refer to Figure-25. You will be asked to specify center point of the reference circle.

•Click on the screen to specify the center point of the polygon; refer to Figure-26. You will be asked to specify radius of reference circle.
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•Type the value of radius in the edit box and press TAB to activate Edge Number edit box.

•Specify desired number of edges of the polygon in Edge Number edit box.

•After specifying the parameters, press ENTER to create polygon.

Inscribed Polygon

The Inscribed Polygon tool is used to create a polygon formed inside the reference circle. The procedure to use this tool is discussed next.

•Click on Inscribed Polygon of Polygon cascading menu from CREATE drop-down. You will be asked to specify center point of reference circle.

•Click on the screen to specify the center point of the circle; refer to Figure-27.

•Specify the distance between center point of polygon and vertex of polygon edge in dynamic input box.

•Press TAB and specify the value of number of edges in Edge Number dynamic input box.

•Press ENTER to create polygon.
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Edge Polygon

The Edge Polygon tool is used to create a polygon by defining single edge and number of edges of the polygon. The procedure to use this tool is discussed next.

•Click on the Edge Polygon tool of Polygon cascading menu from CREATE drop-down. You will be asked to specify start and end points of the edge line.

•Click on the screen to select the start point and end point of edge. You can also specify the value of angle and length of the edge in dynamic input boxes; refer to Figure-28. After specifying the value in dynamic input boxes, move the cursor to desired side of edge where you want to create the polygon.
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•Specify the value of number of edges of polygon in Edge Number input box.

•Press ENTER or click in desired side to create the polygon.

Ellipse

The Ellipse tool is used to create ellipses in the sketch. The procedure to create an ellipse is discussed next.

•Click on Ellipse tool of CREATE drop-down from Toolbar; refer to Figure-29. You will be asked to specify center point for ellipse.
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•Click on the screen to specify the center point for ellipse.

•Move the cursor in desired direction and specify the value of major diameter in dynamic input box. You can also specify the value of angle in Angle dynamic input box if you want major axis to be inclined.

•Click on the screen and move the cursor upward/downward. You will be asked to specify length of minor axis. Enter desired value of minor diameter in the input box; refer to Figure-30. The ellipse will be created.
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•Right-click on the screen and click OK button to exit this tool.

Slot

The Slot tool is used to create slots. There are five tools in Slot cascading menu; Center to Center Slot, Overall Slot, Center Point Slot, Three Point Arc Slot, and Center Point Arc Slot; refer to Figure-31.
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The tools of Slot cascading menu are discussed next.

Creating Center To Center Slot

The Center To Center Slot tool is used to create the linear slot defined by the distance of slot arc centers and width of slot. The procedure to use this tool is discussed next.

•Click on Center To Center Slot tool of Slot cascading menu from CREATE drop-down. 

•Click on the screen to specify the center point of first arc of slot. You will be asked to specify center point of other arc of slot.

•Click to specify the point or specify desired parameters in the input boxes.

•Move the cursor upward/downward. You will be asked to specify width of slot/diameter of slot arc. 

•Enter the value in dynamic input box or click on the screen; refer to Figure-32. The slot will be created.
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Creating Overall Slot

The Overall Slot tool creates a linear slot defined by total length and total width. The procedure to use this tool is discussed next.

•Click on Overall Slot tool of Slot cascading menu from CREATE drop-down. 

•Click on the screen to specify the start point of the slot; refer to Figure-33. You will be asked to specify end point of slot.
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•Click on the screen to specify the end point of the slot or specify the distance between start point and end point in the dynamic input box.	

•Move the cursor upward/downward and specify the width of slot in dynamic input box or click at desired location.

•Press ENTER to create the slot and exit the tool.

 

Creating Center Point Slot

The Center Point Slot tool is used to create a linear slot which is defined by center point of slot, location of arc center, and width of slot. The procedure to use this tool is discussed next.

•Click on Center Point Slot tool of Slot cascading menu from CREATE drop-down.

•Click on the screen to specify the center of slot; refer to Figure-34.
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•Click to specify the half length of the center to center distance of the slot.

•Specify the value of width for slot in the dynamic input box and press ENTER key. The slot will be created.

Creating Three Point Arc Slot

The Three Point Arc Slot tool is used to create a slot along specified arc with defined width. The procedure to use this tool is given next.

•Click on the Three Point Arc Slot tool of Slot cascading menu from CREATE drop-down. You will be asked to specify the start point of center arc.

•Click at desired location. You will be asked to specify end point of center arc.

•Click to specify the end point of arc. You will be asked to specify a circumferential point of the arc.

•Click at desired location and move the cursor upward/downward. Preview of arc will be displayed with dynamic width value.

•Type desired value of slot width in dynamic input box and the press ENTER to create the slot; refer to Figure-35.
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Creating Center Point Arc Slot

The Center Point Arc Slot tool is used to create an arc slot by specifying center point of arc, start & end point of arc, and width of slot. The procedure to use this tool is given next.

•Click on the Center Point Arc Slot tool of Slot cascading menu from CREATE drop-down in the Toolbar. You will be asked to specify the center of arc.

•Click at desired location. You will be asked to specify the start point of the arc.

•Click at desired location or type desired value of arc radius in the dynamic input box. You will be asked to specify the end point of arc.

•Click at desired location to specify end point or type desired value of angular span of arc in the dynamic input box. You will be asked to specify the width of slot.

•Click to specify the slot width or enter desired value in dynamic input box to create the slot; refer to Figure-36.
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Spline

The Spline tools are used to create spline curves. There are two tools in Spline cascading menu; Fit Point Spline and Control Point Spline; refer to Figure-37.
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The tools of Spline cascading menu are discussed next.

Fit Point Spline

The Fit Point Spline tool is used to create spline curve through the selected points. It is a freeform curve creation tool. The procedure to use this tool is discussed next.

•Click Fit Point Spline tool of Spline cascading menu from CREATE drop-down in the Toolbar; refer to Figure-37.

•Click on the screen to specify the start point for the spline. You will be asked to specify next point of spline.

•Specify other points at desired locations to form spline of desired shape; refer to Figure-38. 
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Control Point Spline

The Control Point Spline tool is used to create the spline curve driven by the selected control points. The procedure to use this tool is discussed next.

•Click on Control Point Spline tool of Spline cascading menu from CREATE drop-down in the Toolbar; refer to Figure-37.

•Click on the screen to specify the start point for the spline. You will be asked to specify next point of spline.

•Specify the other points at desired locations to form spline of desired shape; refer to Figure-39. 

•After specifying desired number of points, click on the Tick (Create and Continue) button to end the spline path.

•Press ENTER or ESC to exit the tool.
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Conic Curve

The Conic Curve tool creates a curve driven by points and rho value. The shape of the curve can be elliptical, parabolic, or hyperbolic depending on the value of Rho. The procedure to use this tool is discussed next.

•Click on Conic Curve tool of CREATE drop-down from Toolbar; refer to Figure-40.
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•Click on the screen to specify the start point of the conic curve.

•Click on the screen to specify the end point of the conic curve.

•Click on the screen to specify control point.

•Enter the Rho value in Rho dynamic input box for the conic curve; refer to Figure-41. The curve will be created. The value of rho lies between 0 to 0.99.
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Point

The Point tool is used to create sketch points. Sketch points find their major usage when creating surfaces. The point gives the flexibility to parametrically change the surface design. 

•Click on Point tool of CREATE drop-down from Toolbar; refer to Figure-42.
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•Click at desired locations in the sketch canvas to create points; refer to Figure-43.
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•Press ESC key to exit this tool or click OK button from Marking menu.

Text

The Text tool is used to create text which can be used for embossing/engraving on a solid model. The Text tool is also used to create notes and other information for the model. 

•Click on Text tool of CREATE drop-down from Toolbar; refer to Figure-44. The TEXT dialog box will be displayed along with the symbol of text attached to the cursor asking you to specify first corner of the text frame; refer to Figure-45.

Note that Text option is selected by default in the Type section of the dialog box. Select Text option to create the text inside a rectangular frame; refer to Figure-45 and select Text On Path option to create the text along selected path; refer to Figure-46.
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•Click at desired location to place first corner of text frame. You will be asked to specify second corner of text frame. 

•Move the cursor away and click at desired location to place second corner of text frame. The text frame will be created and the TEXT dialog box will be updated; refer to Figure-47.
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•Click in the Text edit box and type desired text. Preview of text will be displayed in real-time; refer to Figure-48.
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•Click on the Font drop-down and select desired font for text. There are various single line text fonts available in this drop-down which are used for CAM to name or mark the part. These fonts are of .shx format like cdm.shx.

•Select desired style for text in Typeface section. You can set the text as bold and italic by selecting respective buttons.

•Click in Height edit box and type desired value of height for text.

•Click in the Character Spacing edit box and type desired value to specify change in default spacing between characters.

•If you want to flip the text then select desired button from the Flip section.

•Select Align Left, Align Center, or Align Right option from Alignment section to align the text horizontally and select Align Top, Align Middle, or Align Bottom option from Alignment section to align the text vertically.

•Click OK button of the TEXT dialog box to complete the process.

•If you want to create the text on path then create the sketch for path and select Text On Path option from Type section of the dialog box; refer to Figure-45. The TEXT dialog box will be updated; refer to Figure-49.
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•The Path selection button is active by default and you are asked to select the path.

•Select the path created for the text to follow. The TEXT dialog box will be updated and the selected path will be displayed in the Path section of the dialog box; refer to Figure-50.
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•Click in the Text edit box and type desired text. Preview of text will be displayed in real-time; refer to Figure-51.
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•Select the placement of the text above or below the path by selecting respective button from Placement section of the dialog box.

•Select Fit to Path check box to distribute the text evenly along the entire path.

•Specify the other parameters in the dialog box as discussed earlier. Click the OK button from the dialog box to complete the process.

After creating the text, you can edit it anytime by double-clicking on it in sketch mode.

Mirror

The Mirror tool is used to create mirror copy of the selected entities with respect to a reference called mirror line. The procedure to create the mirror entities is given next.

•Click on Mirror tool of CREATE drop-down from Toolbar; refer to Figure-52. The MIRROR dialog box will be displayed; refer to Figure-53.
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•The Objects selection button is active by default and you are asked to select the objects. Select the entities or sketch whose mirror copy is to be created.

•Click on Select button of Mirror Line section and select the reference line for creating mirror copy. The preview of mirror will be displayed; refer to Figure-54.
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•If preview of mirror is as per your requirement then click on OK button from MIRROR dialog box to complete the process.

Sometimes, we need to create multiple copies of the sketch entities like in sketch of keyboard or piano. For such cases, Autodesk Fusion provides two tools, Circular Pattern and Rectangular Pattern. These tools are discussed next.

Circular Pattern

The Circular pattern tool is used to create multiple copies of an entity in circular fashion. The procedure to use this tool is discussed next.

•Click on Circular Pattern tool of CREATE drop-down from Toolbar; refer to Figure-55. The CIRCULAR PATTERN dialog box will be displayed; refer to Figure-56.
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•The Objects selection button is active by default and you are asked to select the objects. Select the entities or sketch to apply the circular pattern.

•Click on Select button for Center Point section and select the reference point to be used as center point for circular pattern. The preview of circular pattern will be displayed; refer to Figure-57.
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•Select Full option from Angular Spacing drop-down if you want to create a pattern over full 360 round. Select the Angle option from Angular Spacing drop-down if you want to define the span of pattern in angle value. Select the Symmetric option from Angular Spacing drop-down if you want to create a circular pattern symmetric to the center line; refer to Figure-58.
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•Select the Suppression check box if you want to suppress any copy in pattern and then clear the check box for that entity in the preview to be suppressed. Clear the Suppression check box from the dialog box to generate all instances of pattern.

•Click in the Quantity edit box and type desired value for number of copies of object to be created in the circular pattern. You can also set the quantity by moving drag handle.

•After specifying the parameters, click on OK button from CIRCULAR PATTERN dialog box to complete the process. 

Rectangular Pattern

The Rectangular Pattern tool is used to create multiple copies of an entity in horizontal and vertical direction. You can create pattern in two linear directions at the same time. The procedure to create rectangular pattern is given next.

•Click on the Rectangular Pattern tool of CREATE drop-down from Toolbar; refer to Figure-59. A RECTANGULAR PATTERN dialog box will be displayed; refer to Figure-60. 
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•The Objects section button is active by default and you are asked to select the objects. Select the sketch or entities for rectangular pattern.

•Click on Select button of Direction/s section and select the reference lines for directions of rectangular pattern. If you do not select reference lines then patterns are automatically created along horizontal and vertical axes; refer to Figure-61.
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•Select Extent option from Distance Type drop-down if you want to specify the total span in which object copies will be created. Select Spacing option from Distance Type drop-down to set distance between two consecutive copies of object. In our case, we are selecting Extent option.

•Select the Suppress check box if you want to suppress any entity in the pattern.

•Click in the Quantity edit box and type desired value for number of copies.

•Click in the Distance edit box and type desired distance within which copies will be created; refer to Figure-62.
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•Select One Direction option from Direction Type drop-down if you want to create copies in only one direction. Select Symmetric option from Direction Type drop-down if you want to create copies in both sides of selected direction.

•Similarly, specify the parameters for other direction. 

•After specifying the parameters, click OK button from RECTANGULAR PATTERN dialog box to complete the process.

Project/Include

The tools in this cascading menu are used to project edges/curves of selected solids or surfaces on the sketch. These tools will be discussed later in this book while working with 3D models. Hover on the Project/Include option of CREATE drop-down from Toolbar to display Project/Include cascading menu; refer to Figure-63.
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Sketch Dimension

The Sketch Dimension tool is used to dimension the entities automatically based on selections. This tool can create different type of dimension like horizontal, vertical, diameter, radius, or inclined dimensions. The procedure to use this tool is discussed next.

•Click on the Sketch Dimension tool of CREATE drop-down from Toolbar; refer to Figure-64.
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•Select the entity you want to dimension and then click at desired distance to place dimension; refer to Figure-65. 
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Based on how you move the cursor, the dimension will be horizontal, vertical, or inclined. So, after selecting an inclined line, you need to move the cursor in different ways starting from the object to get different type of dimensions. If you want to create inclined dimension for a line then move the cursor perpendicular to the line after selecting it. If you want to create horizontal dimension of an inclined line then move the cursor straight along vertical axis. In the same way, move the cursor straight horizontal to create vertical dimension of an inclined line. This technique can also be applied while dimensioning two points.

Sketch Editing Tool

The standard tools to edit sketch entities are categorized in this section. The tools in this section are discussed next.

Fillet 

The Fillet tool is used to create fillet at the corners created by intersection of two entities. Fillet is sometimes also referred to as round. The procedure to use this tool is discussed next.

•Click on Fillet tool of MODIFY drop-down from Toolbar; refer to Figure-66. You will be asked to select the entities.
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•Select the first entity and then second entity.

•Enter the value of radius in floating window; refer to Figure-67. The fillet will be created.
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Chamfer

The Chamfer tool is used to bevel the corners of sketch geometry in an active sketch. There are three tools in Chamfer cascading menu of MODIFY drop-down in the Toolbar; refer to Figure-68. The procedures to use these tools are discussed next.
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Equal Distance Chamfer

•Click on the Equal Distance Chamfer tool from Chamfer cascading menu; refer to Figure-68.

•Hover the cursor on the vertex of the sketch or select the first line and hover the cursor on the second line. The preview of chamfer will be displayed; refer to Figure-69.
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•Click on the vertex or on the second line of the sketch and type desired distance value in the Distance edit box or drag the distance manipulator handle to specify the distance of chamfer; refer to Figure-70.
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•After specifying the chamfer distance, press Enter. The equal distance chamfer will be created; refer to Figure-71.
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Distance and Angle Chamfer

•Click on the Distance and Angle Chamfer tool from Chamfer cascading menu; refer to Figure-68.

•Hover the cursor on the vertex of the sketch or select the first line and hover the cursor on the second line, the preview of chamfer will be displayed as shown in Figure-69.

•Click on the vertex or on the second line of the sketch and type desired distance value in the Distance edit box or drag the distance manipulator handle to specify the distance of chamfer; refer to Figure-72.
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•After specifying the chamfer distance, press Tab key from the keyboard.

•Type desired angle value in the Angle edit box or drag the angle manipulator handle to specify the angle of chamfer; refer to Figure-73.
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•After specifying the chamfer angle, press Enter. The distance and angle chamfer will be created; refer to Figure-74.
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Two Distance Chamfer

•Click on the Two Distance Chamfer tool from Chamfer cascading menu; refer to Figure-68.

•Hover the cursor on the vertex of the sketch or select the first line and hover the cursor on the second line, the preview of chamfer will be displayed as shown in Figure-69.

•Click on the vertex or on the second line of the sketch and type desired value for the first distance in the Distance 1 edit box or drag the highlighted distance manipulator handle to specify the first distance of chamfer; refer to Figure-75.
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•After specifying the first distance, press Tab key from the keyboard.

•Type desired value for the second distance in the Distance 2 edit box or drag the highlighted distance manipulator handle to specify the second distance of chamfer; refer to Figure-76.
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•After specifying the second distance of chamfer, press Enter. The two distance chamfer will be created; refer to Figure-77.
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Trim

The Trim tool is used to remove unwanted portion of a sketch entity. While removing the segments, the tool considers intersection point as the reference for trimming. The procedure to use this tool is discussed next. 

•Click on Trim tool of MODIFY drop-down from Toolbar; refer to Figure-78.
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•Click on the entity to trim. You can also trim multiple entities by clicking on them.Figure-79 shows the procedure of trimming.
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•Press ESC key to exit this tool.

Extend

The Extend tool does the reverse of Trim tool. This tool is available below the Trim tool. The Extend tool extends the sketch entities up to the nearest intersecting entities. The procedure to use this tool is discussed next.

•Click on the Extend tool of MODIFY drop-down from Toolbar; refer to Figure-80.
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•Hover the cursor on the entity that you want to extend. Preview of the extension will display.

•Click on the entity if the preview is as per your requirement. Figure-81 shows the process of extending entities.
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•Press ESC key to exit this tool.

Break

The Break tool is used to break the entity at selected reference points. The procedure to use this tool is discussed next. 

•Click on Break tool of MODIFY drop-down from Toolbar; refer to Figure-82.
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•Hover the cursor on the entity. The preview of break will be displayed. Note that there must be any intersecting curve on selected entity to apply break.

•If preview is as per your requirement then click on the entity to break; refer to Figure-83.
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•Press ESC key to exit this tool.

Sketch Scale

The Sketch Scale tool is used to enlarge or reduce the size of selected entities with respect to the selected point based on specified scale factor. The procedure to use this tool is discussed next. 

•Click on the Sketch Scale tool of MODIFY drop-down from Toolbar; refer to Figure-84. The SKETCH SCALE dialog box will be displayed; refer to Figure-85.
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•The Entities selection box is active by default. Click on the entities to be scaled.

•Click on Select button of Point section and select the reference point about which selected entities will be scaled up/down. The updated SKETCH SCALE dialog box will be displayed; refer to Figure-86. Make sure the point to be selected as reference has not been selected during entities selection. 
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•Click in the Scale Factor edit box or dynamic input box and type desired value for scale. The preview will be displayed. You can also set the scaling value by moving the drag handle from screen. A value between 0 to 1 will reduce the size and value higher than 1 will increase the size of selected entities.

•If preview is as per your requirement then click on the OK button of SKETCH SCALE dialog box to complete the process.

Offset

The Offset tool is used to create copies of the selected entities at a specified distance. If you are the user of AutoCAD then this is the most common tool used for creating layouts. The procedure to use this tool is discussed next.

 

•Click on Offset tool of MODIFY drop-down from Toolbar; refer to Figure-87. The OFFSET dialog box will be displayed; refer to Figure-88.
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•The Sketch curves selection button is active by default. Select the entities for offset. The updated OFFSET dialog box will be displayed.

•Select the Chain Selection check box if you want to select all the entities in current chain. Otherwise, clear the check box if you want to select only segments of chain for offset.

•Click in the Offset position edit box and type desired distance for offset; refer to Figure-89. You can also set the offset distance by moving the drag-handle from screen.
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•Click OK button of OFFSET dialog box to finish the process.

Sketch Palette

When sketch mode is active, the SKETCH PALETTE dialog box is displayed at bottom right corner of Fusion screen. This dialog box contain commonly used sketch options and sketch constraints; refer to Figure-90. 

[image: ]

The various tools of Sketch Palette are discussed next.

Options

In Options section of SKETCH PALETTE dialog box, there are various options to activate or deactivate sketch functions. These options are discussed next.

•Linetype- Select Construction button from Linetype section while creating any sketch object like line, circle, rectangle, etc. The object will be created as construction geometry and select Centerline button from Linetype section while creating sketch of only line and rectangle object to create them as centerline. The object will be created as centerline geometry; refer to Figure-91. Click again on these buttons to return to normal sketching mode. 
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•Look At- If due to any reason, you have rotated the model while sketching and want to make the sketching plane parallel to screen again then click on the Look At button once.

•Sketch Grid- This option controls the display of sketch grid. To view grid, select the Grid check box otherwise clear the check box to hide.

•Snap- This option controls the grid Snap. To activate grid snapping, select Snap check box and clear the Snap check box to disable. Note that the snapping of key points like end point, intersection point, mid point, etc. will still be active even if you clear the Snap check box. 

•Slice- This option cuts the solid/surface part using Sketch Plane if it is coming before sketching plane while creating sketch. This tool does not change the geometry because it is only a display option. To enable, select the Slice check box and clear the Slice check box to disable.

•Profile- This option is used to display closed profiles in the sketch. This tool is useful to check geometry when you are going to apply protrusion tools like Extrude or Revolve later on the sketch. If your sketch is not a closed profile then you cannot create solid protrusions using that sketch. To enable this tool, select the Profile check box and to disable it clear the check box. 

•Points- The Points option is used to display points at the end of different open sketch entities. Select the check box to enable this option.

•Dimensions- This option is used to display the dimensions of entities. Select the check box to enable this option.

•Constraints- This option is used to display or hide the constraints in the sketch. Constrains are used to restrict the movement of object in defined fashion. To display constraints in the sketch, select the Constraints check box and clear the check box to hide constraints.

•Projected Geometries- This tool is used to display the projected geometries on the sketch. Select the check box to enable and clear the check box to disable this option. Note that projected geometries are generally displayed in dark pink color.

•Construction Geometries- This tool is used to display the construction geometries like construction planes, construction axes, construction points, etc.

 

•3D Sketch- This option enables to pull sketch objects out of the sketch plane and create a 3D sketch. To enable this tool, select the 3D Sketch check box and to disable it clear the check box. 

Feature Options

The Feature Options section of SKETCH PALETTE is displayed when sketch creation tools like rectangle, circle, slot, polygon, and so on are active which have variation in defining their parameters; refer to Figure-92. Select desired option from the Feature Options section to switch to different input style for same tool.
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Constraints

The tools in CONSTRAINTS panel of SKETCH contextual tab are used to apply constraints to the sketch; refer to Figure-93. Constraints are used to restrict the shapes/position of sketch entities with respect to other entities.
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•Make sure the Constraints check box is selected from SKETCH PALETTE dialog box before working with constraints; refer to Figure-94.
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Various constraints available in Autodesk Fusion are discussed next.

 [image: ] The Horizontal/Vertical Constraint makes one or more selected lines to become horizontal/Vertical. To apply this constraint, click on the Horizontal/Vertical button and select the entities. Press ESC to exit the tool. You can also make two points horizontally or vertically in-line by using this constraint.

What if you were trying to make a line vertical constrained but it is becoming horizontal constrained. In such cases, you should drag the end point of line towards vertical reference and then apply the Horizontal/Vertical constraint.

 [image: ] The Coincident Constraint makes selected point to be coincident with a line, arc, circle, or ellipse. To apply this constraint, select the Coincident button from CONSTRAINTS panel in SKETCH contextual tab and select the entities for coincident. Press ESC to exit the tool.

 [image: ] The Tangent Constraint makes selected arc, circle, spline, or ellipse to become tangent to other arc, circle, spline, ellipse, line, or edge. To apply this constraint, click on the Tangent button and select required entity. Press ESC to exit the tool; refer to  Figure-95.
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 [image: ] The Equal Constraint makes the selected lines to have equal length and the selected arcs or circles to have equal radii/diameter. To apply this constraint, click on the Equal button and select required entity to apply the equal constraint; refer to Figure-96. Press ESC to exit the tool.
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 [image: ] The Parallel Constraint makes the selected lines parallel to each other. To apply this constraint, click on the Parallel button and then select desired entities; refer to Figure-97. Press ESC to exit the tool.
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 [image: ] The Perpendicular Constraint makes the selected lines perpendicular to each other. To apply this constraint, click on the Perpendicular button and select the entities; refer to Figure-98. Press ESC to exit the tool.
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 [image: ] The Fix/Unfix Constraint makes the selected entity to be fixed at current position. If you apply this constraint to a line or an arc, its location will be fixed but you can change its size by dragging the endpoints or specifying value. To apply this constraint, click on the Fix/Unfix button and select the entities. Press ESC to exit the tool. 

Fix option is useful when you want to restrict the movement of an entity while applying other constraints. Like in Figure-99, if you want the arc to move in place of line then you can fix the line by applying Fix constraint before applying MidPoint constraint.

 [image: ] The MidPoint Constraint makes selected point of an entity to be placed on the midpoint of another sketch entity. To apply this constraint, click on the MidPoint button. Select the point and then select the entity whose midpoint is to be used for constraining; refer to Figure-99. Press ESC to exit the tool.
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 [image: ] The Concentric Constraint makes selected arc or circle to share the same center point with other arc, circle, point, vertex, or circular edge. To apply this constraint, click the Concentric button and then select the two entities to apply the concentric constraint; refer to Figure-100. Press ESC to exit the tool.
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 [image: ] The Collinear Constraint makes the selected lines to lie on the same infinite line; refer to Figure-101. To use this constraint, select the Collinear constraint button and select the entities. Press ESC to exit the tool.
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 [image: ] The Symmetry Constraint makes two selected lines, arcs, points, and ellipses to remain symmetric about a reference line. To apply this constraint, click on the Symmetric button and select the two objects to be symmetric about the reference line. You will be asked to select reference object. Select the line to be used as symmetry reference. The constraint will be applied; refer to Figure-102. Press ESC to exit the tool.
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 [image: ] The Curvature Constraint is used to create a curvature continuous (G2) condition between selected sketch entities which meet at sharp vertex. To use this tool, click on Smooth button and select desired entities near sharp vertex; refer to Figure-103. Press ESC to exit the tool.

While applying curvature constraint to splines, make sure you select the splines not the control handles.
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Except for Horizontal/Vertical and Fix constraint, you can also select an external entity such as an edge, plane, axis, or sketch curve of an external sketch as reference to apply the constraint.

Practical 1

Create the sketch as shown in Figure-104. Also, dimension the sketch as per the figure.

[image: ]

Steps to be Performed:

Below is the step by step procedure of creating the sketch shown in the Figure-104.

Starting Sketching Environment

•Start Autodesk Fusion if not started already.

•Select the New Design tool from File menu to start a new design; refer to Figure-105.

[image: ]

•Select the Create Sketch tool from CREATE drop-down; refer to Figure-106. You will be asked to select a sketching plane; refer to Figure-107.
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•Select the “Top”(XY) plane for sketching.

Creating Lines

•Click on the Line button from CREATE drop-down or press L key from keyboard to select line. The Line tool will become active and you will be asked to select the start point.

•Click on the origin and move the cursor towards right; refer to Figure-108.
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•Type the value 30 in the dimension box displayed near line and press TAB key to lock the dimension. Click on the screen to create a line.

•Move the cursor vertically upwards and type the value 40 in the dimension box and press TAB key to lock the dimension and then click on the screen to complete the line.

•Move the cursor towards right and type the value 20 in the dimension box. Lock the dimension as discussed earlier and click on screen; refer to Figure-109.
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•Move the cursor upward and type the value 55 in the dimension box. Press TAB key to lock the dimension and then click on the screen to complete the line.

•Move the cursor left and type the value 20 in the dimension box. Press TAB key to lock the dimension and then click on the screen to complete the line.

•Move the cursor upwards and type the value 40 in the dimension box. Press TAB key to lock the dimension and then click on the screen to complete the line.

•Move the cursor towards left and type the value 30 in the dimension box. Press TAB key to lock the dimension and then click on the screen to complete the line.

•Move the cursor downward and click on the origin to close the sketch. Press ESC to exit the line tool.

The sketch after performing the above steps is displayed as shown in Figure-110.
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Practical 2

In this practical, you will create the sketch as shown in Figure-111.
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Steps to be performed:

Below is the step by step procedure of creating the sketch shown in the Figure-111.

Starting Sketching Environment 

•Start Autodesk Fusion if not started already.

•Select the New Design tool from File menu to start a new design.

•Select the Create Sketch tool from CREATE drop-down.

•After selecting this tool, you need to select the plane for creating sketch.

•Select the Top Plane to create the sketch.

Creating Lines

•Click on the Line button from CREATE drop-down or press L key. You are asked to specify the start point of the line.

•Click on the origin and move the cursor towards right. Type the value 25 in the dimension box and press TAB key to lock the dimension. Click on the screen to complete the line.

•Move the cursor downward and type the value 6 in the dimension box. Lock the dimension as discussed earlier and click on screen.

•Move the cursor to the left and type the value 12 in the dimension box. Lock the dimension as discussed earlier and click on screen.

•Move the cursor downwards and type the value 50 in the dimension box. Till this point, our sketch should display like Figure-112.
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Creating Arcs

•Select the Tangent Arc tool from Arc cascading menu in CREATE drop-down.

•Click on the end point of the vertical line recently created and move the cursor downwards in such a way that the end point of arc is in-line with the origin.

•Specify the dimension value 13 in the dimension box and press ENTER to complete the arc; refer to Figure-113.
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Note that you can also create tangent arc by dragging the cursor while creating line using Line tool. To specify dimension of tangent arc, you need to drag the cursor while creating line, hold the left click, specify the radius value for tangent arc, and then release the left click.

Creating Fillet

•Click on the Fillet tool from MODIFY drop-down/panel in the SKETCH contextual tab in the Toolbar.

•Select the lines as shown in Figure-114.

•Enter the value as 3 in the radius box.
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Creating Mirror Copy

•Press L key and create a line from origin to end point of the Arc.

•Press ESC key from keyboard to exit the tool.

•Now, select the newly created line, right-click on it, and select Normal Construction from Marking menu or select the newly created line and press x from keyboard to convert line into construction geometry. Press ESC to exit selection.

•Select the Mirror tool from CREATE drop-down and select all the entities we have sketched except construction line; refer to Figure-115.
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•Click on the Mirror Line selection button in the dialog box and select the construction line from sketch. Preview of mirror feature will be displayed.

•Click OK button from the MIRROR dialog box.

Creating Circle and Lines to complete.

•Click on the Center Diameter Circle tool from Circle cascading menu.

•Click at the center point of the bottom arc and move the cursor; refer to Figure-116.
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•Enter the dimension as 13 in the input box.

•Click on the Line tool from CREATE drop-down and click anywhere on the center line (except mid point and end points) to specify the start point of the line; refer to Figure-117.
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•Move the cursor horizontally towards right and specify the value as 9. Press TAB and click on the screen.

•Move the cursor vertically downwards and click when line passes the arc; refer to Figure-118.

[image: ]

•Press ESC to exit the tool. Click on the Trim tool from MODIFY drop-down and remove the extra portion outside the arc. Press ESC to exit the Trim tool.

•Mirror both the lines as we did earlier. The sketch should display as shown in Figure-119.
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Dimensioning Sketch

Some of the dimensions are applied automatically while creating sketch. To create rest of the dimensions, click on the Sketch Dimension tool from CREATE panel/drop-down. Dimension symbol will get attached to cursor.

•Click on the arc and place the dimension at proper spacing if not created already.  Type the radius in dynamic input box as 13 and press ENTER. 

•Click on the two lines as shown in Figure-120.
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•Click to place the dimension at its proper place. In the dynamic input box, enter the value as 40.

Similarly, dimension all the entity in the sketch until the sketch is fully defined. The final sketch after dimensioning will be displayed as shown in Figure-121. You can delete extra dimensions before applying real dimensions.
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Fully Defined, Under-Defined, and Over-Defined Sketches

Till this point, you have worked on various sketching tools and you have created sketch for two practical sessions. You might have noticed that some entities are displayed in blue color while some are displayed in bold black color. Also, there are dimensions which are enclosed in bracket. Here, we will discuss why these colors and different dimensions appear.

Fully Defined Sketches

A fully defined sketch is the one whose specifications can not be changed unintentionally. In some complex sketches, when you change the dimension of one entity, the dimension of other entity gets changed automatically. If you have the sketch fully defined then the dimension of the entities will not change unintentionally. In technical terms, a fully defined sketch is the one in which entities have zero degree of freedom. In Autodesk Fusion, the sketch that is fully defined will be displayed in bold black color; refer to Figure-122. In a fully defined sketch, if you try to drag any entity of the sketch then it will not move because its degree of freedom is zero. A fully defined sketch is always recommended for creating features in CAD.
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Under Defined Sketches

An under-defined sketch is the one in which all the required dimensions are not applied. An under-defined sketch is displayed in blue color in Autodesk Fusion. When you change the value of a dimension or drag an entity in the under-defined sketch then other entities may change shape/size accordingly. An under-defined sketch is not recommended for CAD modeling.

Over Defined Sketches

An over defined sketch is the one where more dimensions are applied than those required to fully define the sketch. In over-defined sketches, extra dimensions are bound by parenthesis like the 50 dimension as shown in Figure-121. 

Practical 3

Create the sketch as shown in Figure-123. Also, dimension the sketch as per the figure.
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Steps to be performed:

Below is the step by step procedure of creating the sketch shown in Figure-123.

Starting Sketching Environment

•Start Autodesk Fusion if not started already.

•Select the New Design tool from File menu to start a new design.

•Select the Create Sketch tool from CREATE drop-down.

•On selecting this tool, you will be asked to select a plane for creating sketch.

•Select the Top Plane to create the sketch.

Creating Lines

•Select Line tool from CREATE drop-down and create a vertical line starting from origin and moving upward. (No need of dimensions, just make it a long one as it is going to be centerline.) 

•Select the line and right-click on this line. Marking menu will be displayed. Select Normal/Construction tool to make this line as a center line; refer to Figure-124.

•Press ESC to exit the tool.
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•Press L key to start Line tool again and click at the end point of center line to create a line.

•Move the cursor towards right and specify the value as 15 in the dimension box. Press TAB key to lock the dimension and click on the screen.

•Move the cursor upward with some outward angle. Specify length as 35 in dimension box. Press TAB key to lock the dimension and switch to angle dimension. Specify the angle value as 93 degree and click on the screen.

•Move the cursor to the left, specify the value as 7 in the length input box and 140 degree in angle input box; refer to Figure-125. 
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Creating Mirror copy

•Select the Mirror tool from CREATE drop-down and select the entities we have sketched except center line for mirror.

•Click on the Mirror Line selection button and select the center line of sketch as mirror line. Preview of mirror will be displayed; Figure-126.
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•Click OK button from MIRROR dialog box to complete the mirror copy.

•Now, select Line tool and create a line joining the open ends of sketch; refer to Figure-127.
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•Create a vertical line from one end of the sketch of length 25 mm as shown in Figure-128.
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Creating Arcs

•Click Tangent Arc tool from Arc cascading menu in CREATE drop-down.

•Click on the end point of vertical line recently created and move the cursor upwards. Create three consecutive arc joining each other as shown in Figure-129. Press ESC to exit the tool.  
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•Select Sketch Dimension tool from CREATE drop-down or press D key to select this tool.

•Apply radius dimensions to three arcs as 10, 22, and 7, respectively; refer to Figure-130. Make sure horizontal and vertical constraints are applied to the straight lines in the sketch.
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•Select the Line tool and create a line joining end of recently created arc to horizontal line in the sketch; refer to Figure-131. Press ESC tool to exit the command.
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You may find that there is not a smooth transition between newly created line and arc as in our case. In such cases, apply the tangent constraint between line and arc; refer to Figure-132.
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Dimensioning Sketch

•Select the unwanted dimensions and delete them by pressing DELETE key.

•Click on the Sketch Dimension tool or press D key to select the tool.

•Select the entity and apply the dimension; refer to Figure-133. 
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•Drag the dimension to proper place.

Similarly, dimension all the other entities in the sketch until it is fully defined. The final sketch after dimensioning will be displayed as shown in Figure-134.
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Following are some sketches for practice.

Practice 1

Create the sketch as shown in Figure-135.
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Practice 2

Create the sketch as shown in Figure-136.
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Practice 3

Create the sketch as shown in Figure-137.
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Practice 4

Create the sketch as shown in Figure-138.
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To get more exercise, mail us at cadcamcaeworks@gmail.com

Self Assessment

Q1. In Autodesk Fusion, which of the following workspace has tool to start a new sketch?

a. RENDER

b. DESIGN

c. DRAWING

d. SIMULATION

Q2. Which of the following shortcut keys can be used to convert selected line into a construction line?

a. L

b. c

c. y

d. x

Q3. While the Line tool is active in sketch, if you drag the cursor then a tangent arc is created. (T/F)

Q4. Which of the following tool is not available in Autodesk Fusion Sketch mode to create an arc?

a. Center Point Arc

b. 3-Point Arc

c. Tangent Arc

d. Elliptical Arc

Q5. Which of the following Polygon tool should be used to create polygon if distance between two parallel edges of polygon and number of edges are given?

a. Circumscribed Polygon

b. Inscribed Polygon

c. Edge Polygon

d. All of the above.







Chapter  3

3D Sketch and Solid Modeling
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The major topics covered in this chapter are:

•3D Sketches 

•Selection Tools

•Solid Modeling

•Create drop-down

•Construction Geometry

•Project/Include Tools




3D Sketches

3D Sketches are those sketches which are not confined to single plane. Assume a line connecting end points of two lines in YZ and ZX planes; refer to Figure-1. Such a sketch can be called 3D Sketch; refer to Figure-2. 
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In Autodesk Fusion, there are no specific tools for creating 3D sketches except a check box to enable or disable 3D sketching in SKETCH PALETTE. So, we are back to basics of plane orientations for creating 3D sketches. The process of creating a 3D sketch is explained next with the help of an example.

Creating 3D Sketch

Create the sketch of frame as shown in Figure-3.
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Creating Base Sketches and Planes

•After starting a new design file in Autodesk Fusion, click on the Create Sketch button from the CREATE drop-down. You will be asked to select a sketching plane.

•Select the XY plane as sketching plane and create a center point rectangle as shown in Figure-4.
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•Nope! Don’t exit the sketching environment yet!! Select the whole sketch by window selection; refer to Figure-5 and press CTRL+C from keyboard. This will keep a copy of current sketch in clipboard memory of software.

•Click on the Finish Sketch button from FINISH SKETCH panel of the Toolbar to exit sketching environment.
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•Click on the Offset Plane tool from the CONSTRUCT drop-down of the SOLID tab in the Toolbar and select XY Plane from Origin node of BROWSER; refer to Figure-6. (You will learn more about the plane and construction geometries later in this chapter.) 
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•Specify the distance value as 300 in OFFSET PLANE dialog box and click on the OK button. A new plane will be created at a distance of 300 from XY plane.

•Click again on the Offset Plane tool from the CONSTRUCT drop-down in the Toolbar and create another plane at an offset distance of 300 from earlier created plane; refer to Figure-7.
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•Select Plane1 from the Construction node in BROWSER and click on the Create Sketch button from CREATE drop-down in the Toolbar. The sketching environment will be activated.

•Press CTRL+V from keyboard to paste earlier copied sketch. The MOVE/COPY dialog box will be displayed with sketch pasted; refer to Figure-8.
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•There is no need to change any parameter because our sketch is well constrained and same as we wanted. Click on the OK button from the dialog box and exit the sketching environment.

•Create the same sketch on other offset plane. The sketches will be displayed as shown in Figure-9.
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Creating 3D Lines

(Till the time, this book is authored, we are able to use only lines and splines for creating 3D sketches.)

 

•Click on the Preferences option from the User Account drop-down at the top-right corner of the application window. The Preferences dialog box will be displayed. (This dialog box has been discussed earlier in Chapter 1.)

•Select the Design option from General node at the left in the dialog box. The options will be displayed as shown in Figure-10.
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•Select the Allow 3D sketching of lines and splines check box as highlighted in above figure and click on the OK button from the dialog box.

Now, we are ready to create 3-dimensional lines.

•Click on the Create Sketch tool from the CREATE drop-down in the Toolbar and select any of the sketching plane. The sketching plane will become parallel to screen.

•Rotate the model by using SHIFT+Middle Mouse Button (MMB).

•Click on the Line tool from CREATE drop-down and hover the cursor on earlier created sketches. You will find that the snap points of all the sketches get highlighted when you hover the cursor over them.

•Now what left is just clicks and clicks. Join various points of sketches to form frame sketch as shown in Figure-11.
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•Click on the Finish Sketch tool from the FINISH SKETCH panel of the Toolbar to exit the sketching environment. So, it is the property of snap points for various elements that allow creating 3D sketch entities.

Selection Tools

You have earlier selected the objects by clicking on them or by making a window to select them. In Autodesk Fusion, sometimes you will reach in situations where only features are to be selected or only faces are to be selected. In such cases, we apply selection filters. You can also define the pattern in which you want to select objects using the options in SELECT drop-down of the Toolbar; refer to Figure-12. These tools are discussed next.
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Select Tool

This tool is always active while working in Autodesk Fusion. Because of this tool, you are able to select any tool from toolbar or object from canvas.

Window Selection

This tool is active by default when you start working on Autodesk Fusion. This tool is used to activate window selection mode. You can activate this tool by selecting it from SELECT drop-down or by pressing 1 key from keyboard (Note that 1 is not to be pressed from NUMPAD on your keyboard). After activating window selection mode, there are two ways in which you can create window to select objects; Window selection and Cross Window selection (sometimes called Cross selection). Click in the canvas and drag the cursor towards right to perform window selection. Release the button when you have formed window of desired size. Click in the canvas and drag the cursor towards left to perform cross window selection. Both the selection methods and their uses are given in Figure-13 and Figure-14. 
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Freeform Selection

Click on the Freeform Selection tool from SELECT drop-down or press 2 from keyboard to activate this selection mode. Click and drag the cursor to create a freeform boundary for selection. Dragging cursor towards right will make objects completely inside the boundaries selected and dragging cursor towards left will make objects inside or touching the boundaries selected.

Paint Selection

Click on the Paint Selection tool from SELECT drop-down or press 3 from keyboard to activate this selection mode. In this selection mode, all the objects over which cursor passes while dragging will be selected.  

Selection Tools

The selection tools discussed earlier are conventional selection tools. You can also select the objects by their names, types, and sizes. These tools are available in the Selection Tools cascading menu of SELECT drop-down; refer to Figure-15.

[image: ]

Select By Name Method

•Click on the Select By Name tool from the Selection Tools cascading menu of SELECT drop-down in the Toolbar. The SELECT BY NAME dialog box will be displayed; refer to Figure-16.
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•Type the name of object to be selected in the Name edit box of the dialog box. 

•Select the Bodies check box to allow selection of bodies and select the Components check box to allow selection of components. 

•Click on the Find button in the dialog box. All the components and bodies matching the specified name will be selected; refer to Figure-17.
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•Click on the OK button from the dialog box to complete the process.

Select By Boundary Method

The Select By Boundary method is used to select objects which fall under defined shapes of cylinder, box, or sphere. The procedure to use this method is given next.

•Click on the Select By Boundary tool from the Selection Tools cascading menu of SELECT drop-down. The SELECT BY BOUNDARY dialog box will be displayed; refer to Figure-18.
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•Select desired option from the Boundary Shape drop-down to define the shape of selection boundary.

•Click on desired point in the model to place centroid of boundary shape. Preview of boundary will be displayed; refer to Figure-19.
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•Specify desired parameters in the Boundary Size section to define size of boundary shape.

•Select the Inside Boundary option from the Selection Type drop-down if you want to select the objects inside the boundary. Select the Outside Boundary option from the Selection Type drop-down if you want to select the objects outside the boundary shape.

•Select the Intersected check box if you want to select all the objects that are intersecting with created boundary shape.

•Click on the OK button from the dialog box to make selection.

Select By Size Method

The Select By Size method is used when you want to select the entities based on their sizes. The procedure for using this method is given next.

•Click on the Select By Size tool from the Selection Tools cascading menu of the SELECT drop-down in Toolbar. The SELECT BY SIZE dialog box will be displayed; refer to Figure-20.
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•Specify the range of size within which entities will be selected and then click on the OK button.

Selection by Seed and Boundary

The Seed and Boundary tool is used to select faces on a solid or surface by using a seed surface/face as template for selection and outlines of a face/surface as boundary. The procedure to use this tool is given next.

•Click on the Seed and Boundary tool from the Selection Tools cascading menu of the SELECT drop-down in the Toolbar. The SEED AND BOUNDARY dialog box will be displayed; refer to Figure-21.
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•Select the face of model to be used as boundary for selection. (No objects outside this boundary will be selected by the tool). On selecting face for boundary, the SEED AND BOUNDARY dialog box will be updated and selection button for seed object will be displayed; refer to Figure-22.
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•Click on the Select button for Seed Object in dialog box and then select the face from model within the boundary to be used as reference for selecting nearby faces. The Update button will be displayed in the dialog box; refer to Figure-23.
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•Click on the Update button to update the selection based on seed object. All the nearby faces within boundary will get selected; refer to Figure-24.
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•Clear the Include Boundary Objects check box if you do not want to boundary faces in selection.

•Click on the OK button to complete selection.

Component Drag

Select the Component Drag check box to enable the movement of components by dragging in the canvas. Hold the Alt key to move the components by dragging in the canvas.

Selection Priority

The options in Selection Priority cascading menu of SELECT drop-down in Toolbar are used to define which entities will be given preference while selecting objects; refer to Figure-25. Select the Select Body Priority option if you want to select bodies in place of faces/edges. Similarly, select other options in the cascading menu to select respective entities.
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Selection Filters

The check boxes in Selection Filters cascading menu are used to define which objects can be selected and which objects cannot be selected; refer to Figure-26. Select desired check boxes to activate selections of respective objects. In default condition, the Select All check box is selected.
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Solid Modeling

Till this point, we have worked on 2D sketches and have created them on Top or Front plane. We have also created 3D sketches. Now, we will learn the tools for solid modeling. Solid modeling is the most advanced method of geometric modeling in three dimensions. Solid modeling is the representation of the solid objects in your computer in digital form. Various tools to perform solid modeling are available in the SOLID tab of Toolbar. We will learn about various tools and commands used to create solid models in next topic.

Create drop-down

In Create drop-down, there are various 3D modeling tools used to create and manage solid objects; refer to Figure-27. These tools are discussed next.
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New Component

Click on New Component tool from Create drop-down; refer to Figure-28. A new component will start. You will find use of this tool later in Assembly chapter of the book. (No! we are not skipping this tool, we will discuss it later :-)
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Extrude

The Extrude tool is used to create a solid volume by adding height to the selected sketch. In other words, this tool adds material in the direction perpendicular to the plane of sketch by using the boundaries of sketch. The procedure to use this tool is discussed next.

•Create a closed profile sketch as discussed in previous chapter.

•After creating sketch, exit the sketch environment by selecting the Finish Sketch tool from Toolbar or Right-click outside the sketch and select Finish Sketch button from the Sketch drop-down in Marking menu; refer to Figure-29.
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•Click on Extrude tool of Create drop-down from Toolbar; refer to Figure-30. The EXTRUDE dialog box will be displayed; refer to Figure-31.

•Click on the Presets drop-down from top of the dialog box and select desired preset to apply or save the current values as a preset to use them. Click on the New Preset [image: ] button to create new preset for the dialog box.

•Select the type of extrusion you want to create from Type section of the dialog box. Select Extrude button to extrude entire area within selected closed profiles as solid. Select Thin Extrude button to extrude a thin wall along selected closed profiles.
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•The Extrude option is selected by default in the Type section of the dialog box and the profile selection is active by default. Select the sketch to be extruded by clicking on the shaded area in the sketch. If your sketch has multiple closed profiles then make sure to select correct shaded area. For example, in Figure-29, we can select inside the circle, outside the circle, or both to create extrusion. The extruded body will be of the shape selected here.

Start drop-down

•There are three tools in Start drop-down; refer to Figure-32. 
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•Select Profile Plane option from Start drop-down, if you want to extrude the sketch starting from current sketching plane; refer to Figure-33. 

•Select Offset option if you want to extrude the sketch starting from some offset distance. The updated EXTRUDE dialog box will be displayed; refer to Figure-34.

•Click in Offset edit box and type desired value of distance between starting of extrusion and sketch plane; refer to Figure-35.
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•Select the Object tool from Start drop-down in the dialog box, if you want to extrude the profile starting from selected surface/face (or at a distance from selected face) of another body.

•After selecting Object tool, click on Select button of Object section and select the object from where you are going to start the extrude; refer to Figure-36.
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•Click in Distance edit box and specify the height of extrusion. You can also drag the Arrow handle displayed on the sketch upward to define extrude height. 

•If you want to create tapered walls of extrude feature then specify desired angle value in the Taper Angle edit box. You can specify both positive and negative values in this edit box. You can also use the rotation handle displayed in the preview to specify taper value. Applying taper angle is also called draft in some software.

Direction drop-down

•There are three tools in Direction drop-down of EXTRUDE dialog box; refer to Figure-37.
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•Select One Side option from Direction drop-down if you want to specify the height of extrusion in one direction.  

•Select Two Sides option from Direction drop-down if you want to specify the height of extrusion in both upward and downward directions of sketching plane; refer to Figure-38. The options to specify parameters for side 1 and side 2 will be displayed in the dialog box.
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•Select Symmetric option from Direction drop-down if you want to specify the height of extrusion symmetric in both upward and downward directions of sketching plane. You will be asked to specify height of extrusion for one side and the profile will be extruded symmetrically on the other side with same value. Select the Half length or Whole length button from Measurement section as required; refer to Figure-39.

[image: ]

Extent Type drop-down

•Select Distance option from Extent Type drop-down in the EXTRUDE dialog box if you want to set the height of extrusion manually. Click in the Distance edit box and specify desired height. 

•Select To Object option from Extent Type drop-down if you want to define a surface/face at which extrusion will end; refer to Figure-40. After selecting this option, click on the face or surface up to which extrusion is to be created.
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•Select All option from Extent Type drop-down, if you want to cut through the model or part from extrusion. The extrusion will goes through from the body of model; refer to Figure-41. If you want to add material in place of removing then select the Join option from the Operation drop-down in the dialog box.
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•Click on the Flip button to reverse the direction of extrusion.

Operation drop-down

•There are five options in Operation drop-down of EXTRUDE dialog box; refer to Figure-42. These options are discussed next.
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•Select Join option of Operation drop-down if you want to combine the extrude feature with intersecting bodies; refer to Figure-43.
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•Select Cut option if you want to remove material from base body by using current extrude feature; refer to Figure-44.
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•Select Intersect option from Operation drop-down if you want to create the region commonly bounded by extrude feature and intersecting solid bodies; refer to Figure-45.
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•Select New Body option from Operation drop-down if you want to create a new body. A new body creation becomes important when you are creating molds and want all the tool bodies to be individual objects. 

•Select the New Component option from Operation drop-down if you want to create a new component of the current extrude feature. New components are created for assembly. You will learn more about this option later in the book.

Extruding Thin Wall

If you want to extrude a thin wall along selected closed profiles, then select Thin Extrude button from Type section of the dialog box. The options in the EXTRUDE dialog box will be updated; refer to Figure-46.

Wall Location drop-down

There are three options in Wall Location drop-down of EXTRUDE dialog box; refer to Figure-47. These options are discussed next.
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•Select Side 1 option from the drop-down if you want to offset/move the extrusion to the one side of the profile; refer to Figure-48.
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•Specify desired thickness of extrusion in the Wall Thickness edit box of the dialog box.

•Select the Chaining check box to automatically select the connected geometry.

•Specify the parameters in the dialog box as discussed earlier and click on OK button. The extrusion inside the profile will be created.

•Similarly, select Side 2 option from the drop-down to offset/move the extrusion to the other side of the profile and select Center option from the drop-down to center the extrusion on the profile.

Revolve

Revolve tool is used to create a solid volume by revolving a sketch about selected axis. In other words, if you revolve a sketch about an axis then the volume covered by revolving sketch boundary is called revolve feature. The procedure to use this tool is discussed next.

•Create a closed profile sketch with a center line as discussed in previous chapter.

•Click on Revolve tool from CREATE drop-down of Toolbar; refer to Figure-49. The REVOLVE dialog box will be displayed; refer to Figure-50.
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•Click on Select button for Profile selection from REVOLVE dialog box and then select the sketch for profile from the screen canvas.

•Click on Select button for Axis selection from REVOLVE dialog box and then select the sketch edge, line, or center line from the screen canvas; refer to Figure-51.

[image: ]

•After selecting the entities, the preview of revolve feature will be displayed; refer to Figure-52.
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•Select Project Axis check box to project the axis to the same sketch plane as the selected profile.

•Specify desired value of revolve angle in the Angle dynamic input box. You can also set the value of angle by moving the drag handle; refer to Figure-53.
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Direction drop-down

The options in Direction drop-down are used to define in which direction profile will be revolved.

 

•Select One Side option from Direction drop-down to revolve the profile in one direction.

•Select Two Sides option from Direction drop-down if you want to revolve the profile in both sides with different revolution angles; refer to Figure-54.
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•Select the Symmetric option from Direction drop-down if you want to revolve the model in both direction with same angle i.e. symmetrically.

Extent Type

•Select the Partial option from Type drop-down if you want to revolve the profile by specified angle.

•Select the To Object option from Type drop-down if you want to revolve the model up to a plane, face, surface, or vertex; refer to Figure-55.
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•Select the Full option from Type drop-down if you want to revolve the profile to 360 degree angle. 

•Set the other options as discussed earlier.

•Click OK button from REVOLVE dialog box to create the feature.

Sweep

The Sweep tool is used to create a solid volume by moving a sketch along the selected path. In other words, if you move a sketch along a path then the volume that is covered by moving sketch boundary is called sweep feature. Note that to create a solid sweep feature, you will need two sketches, one for the profile and another for the path already created in the canvas. The steps to use this tool are discussed next.

•Click on Sweep tool from CREATE drop-down; refer to Figure-56. The SWEEP dialog box will be displayed with Feature tab opened by default; refer to Figure-57.
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In this dialog box, there are three options in Type drop-down to create sweep feature; Single Path, Path + Guide Rail, and Path + Guide Surface. The procedures to create sweep feature by using these options are discussed next.

Single Path

The Single Path tool sweeps the selected profile along a single path.

•Click on the Select button of Profile section from the SWEEP dialog box and select the sketch for profile from the canvas screen.

•Click on the Select button of Path section from SWEEP dialog box and select the path from the canvas screen; refer to Figure-58. Note that few more options are now available in the dialog box.
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•Select the Chain Selection check box if you want to select chain of entities connected with path curve being selected; refer to Figure-59.

•The distance in the Distance edit box is not the actual distance value rather it is the percentage of total distance along the path. 1 is the maximum value which is the total path distance of sweep. Enter 0.5 value in the edit box to create the sweep along only half length of the path. You can also adjust the length of the sweep by entering value in dynamic input box or by moving the drag arrow handles displayed on the model.
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•Click in the Taper Angle edit box and specify desired angle value to apply draft to the faces of feature.

•Click in the Twist Angle edit box and specify the angle value by which you want to twist the profile along path while creating sweep feature; refer to Figure-60.
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•The options in the Orientation drop-down of SWEEP dialog box are used to define how the profile is pulled along the sweep path. 

•Perpendicular option is the default selection of Orientation drop-down. This option creates the sweep feature in such that profile section is always perpendicular to the path. This allow more curvature on the path; refer to Figure-61.
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•Parallel option of Orientation drop-down creates sweep feature in such a way that the profile section is always parallel to its original orientation; refer to Figure-62.
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•After specifying the parameters, click on OK button to create the sweep feature.

Path + Guide Rail

Selecting this option sweeps the selected sketch along the path and uses the guide rail to control the shape. The procedure to use this tool is discussed next.

•Select the Path + Guide Rail option from Type drop-down of SWEEP dialog box. The options in the dialog box will be displayed as shown in Figure-63.

•Click on the Select button for Profile from the SWEEP dialog box and then select the sketch created for profile from the canvas screen.

•Click on the Select button for Path from SWEEP dialog box and then select the sketch/edge for path from the canvas screen. 

Note that you can also select edges of solids/surfaces as path or guide rails and faces of solids as profile section.
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•Click on the Select button for Guide Rail from the SWEEP dialog box and then select the sketch for guide from the canvas screen; refer to Figure-64. Preview of sweep feature will be displayed and additional options will be available in the SWEEP dialog box.
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•Click in the Extent drop-down and select the Perpendicular to Path option if you want to create the sweep feature till the profile is perpendicular to path. Select the Full Extents option from the drop-down if you want to create sweep till the end point of path.

•Specify desired values for distance in Path Distance and Guide Rail Distance edit boxes as discussed earlier. Note that the Guide Rail Distance edit box will be available only when Full Extents option is selected in the Extents drop-down.

•Select the Scale option from Profile Scaling drop-down in SWEEP dialog box, if you want to equally scale the profile in both X and Y direction; refer to Figure-65. The profile will be scaled up depending on the distance between path and guide rail. 

•Select the Stretch option from Profile Scaling drop-down if you want to scale the profile in X direction only. In this way, profile will keep following guide rail while moving along the path; refer to Figure-65.

•Click on None option from Profile Scaling drop-down if you don’t want to scale the profile along sweep. On selecting this option, guide rail is used as an orientation guide only; refer to Figure-65.
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Note that the profile, path, and guide rail are same in all three cases.

•The tools of Operation drop-down are same as discussed earlier in this book. Click on the OK button from the dialog box to create the features.

Path + Guide Surface

This option sweeps the selected sketch along the path and uses the guide surface to control the shape. The procedure to use this tool is discussed next.

•Select the Path + Guide Surface option of Type drop-down from SWEEP dialog box. The options in the dialog box will be displayed as shown in Figure-66. 

•Select the profile for sweep and click on the Select button for Path.

•Select the curve/edge for path and click on the Select button for Guide Surface. 

•Select the surface by which you want to control the shape of sweep feature; refer to Figure-67. Preview of feature will be displayed.
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•Set the parameters as discussed earlier and click on the OK button to create the feature.

Part file of this example is available in resources folder of this book. You can try different combinations of sweep for this example. 

The Analysis tab of SWEEP dialog box is used to analyze the previewed result. We will discuss the options of this tab, later in this book.

Construction Geometry

Till now, we have created all the features on default planes but sometimes, we need to create features that cannot be created on default planes. In such cases, we create some construction geometries. Construction geometries are used as references for other features. Some of the well known entities that come under construction geometries are:

•Planes

•Axes

•Points

•Coordinate Systems

•Curves

•Sketches

You have learned about sketches earlier in the book. Now, we will work on other features. All the tools for construction geometry features are available in the CONSTRUCT drop-down; refer to Figure-68. These tools are discussed next.
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Offset Plane

The Offset Plane tool is used to create a plane at specified distance from a face/plane reference. The procedure to use this tool is discussed next.

•Click on the Offset Plane tool of CONSTRUCT drop-down from Toolbar; refer to Figure-69. The OFFSET PLANE dialog box will be displayed; refer to Figure-70.

[image: ] [image: ] 

•Plane selection is active by default. Click on the plane/face of model to be used as reference for offset plane; refer to Figure-71. The preview for offset plane will be displayed.
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•Click in the Distance edit box of OFFSET PLANE dialog box and enter the distance at which you want to create the plane. You can also set the distance by moving the drag handle.

•After specifying the distance for offset plane, click on the OK button from OFFSET PLANE dialog box. The plane will be created; refer to Figure-72.
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Plane at Angle

The Plane at Angle tool is used to create a plane at specified angle. The procedure to use this tool is discussed next.

•Click on the Plane at Angle tool of CONSTRUCT drop-down from Toolbar; refer to Figure-73. The PLANE AT ANGLE dialog box will be displayed; refer to Figure-74.
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•Line selection of PLANE AT ANGLE dialog box is active by default. Click on the line/edge/axis from the model as reference for creating a plane. The updated PLANE AT ANGLE dialog box will be displayed; refer to Figure-75.
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•Specify desired angle value in Angle edit box or drag the handle.

•After specifying the angle for plane, click on the OK button from PLANE AT ANGLE dialog box. The plane will be created; refer to Figure-76.
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Tangent Plane

The Tangent Plane tool is used to create a plane tangent to the selected face/surface. The procedure to use this tool is discussed next.

•Click on the Tangent Plane tool of CONSTRUCT drop-down from Toolbar; refer to Figure-77. The TANGENT PLANE dialog box will be displayed; refer to Figure-78.
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•The Face selection of TANGENT PLANE dialog box is active by default. Click on the round face of model to which plane should be tangent. The updated dialog box will be displayed; refer to Figure-79.
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•Selection of Reference Plane is optional. If you want to select the reference plane to define orientation of the tangent plane then click on the Select button of Reference Plane section and click on plane/face. The plane will orient accordingly to selected plane. 

•Click in the Angle edit box and specify the angle of plane with respect to the reference plane. If you have not specified reference plane then angle will be calculated from original position. You can also set the angle by moving the drag handle.

•After specifying the parameters, click on the OK button from TANGENT PLANE dialog box to create a tangent plane; refer to Figure-80.

[image: ]

Midplane

The Midplane tool is used to create a plane at the midpoint of two faces/planes. The procedure to use this tool is discussed next.

•Click on the Midplane tool of CONSTRUCT drop-down from Toolbar; refer to Figure-81. The MIDPLANE dialog box will be displayed; refer to Figure-82.
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•Now, you need to select two planes or faces to create a mid plane; refer to Figure-83.
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•After selecting the second plane or face, preview of plane will be displayed; refer to Figure-84. 
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•Click on the OK button from the dialog box. The plane will be created.

Plane Through Two Edges

The Plane Through Two Edges tool is used to create a plane with the reference as two linear edges. The procedure to use this tool is discussed next.

•Click on the Plane Through Two Edges tool of CONSTRUCT drop-down from Toolbar; refer to Figure-85. The tool will be activated and the PLANE THROUGH TWO EDGES dialog box will be displayed; refer to Figure-86. 
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•Click on two straight edges of model to create plane; refer to Figure-87.
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•On selecting the second edge, the preview of plane will be displayed; refer to Figure-88.

[image: ]

•Click on the OK button from the dialog box to create the plane.

Plane Through Three Points

The Plane Through Three Points tool is used to create a plane with the help of three points as reference. The procedure to use this tool is discussed next.

 

•Click on the Plane Through Three Points tool of CONSTRUCT drop-down from Toolbar; refer to Figure-89. The PLANE THROUGH THREE POINTS dialog box will be displayed; refer to Figure-90.
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•Select three points from model as reference to create a plane; refer to Figure-91.

[image: ]

•After selecting the third point, the preview of plane will be displayed along with model; refer to Figure-92. Click on the OK button from the dialog box.

[image: ]

Plane Tangent to Face at Point

The Plane Tangent to Face at Point tool is used to create a plane which is tangent to selected face and aligned to selected point. The procedure to use this tool is discussed next.

•Click on the Plane Tangent to Face at Point tool of CONSTRUCT drop-down from Toolbar; refer to Figure-93. The PLANE TANGENT TO FACE AT POINT dialog box will be displayed; refer to Figure-94.
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•Click on the model to select a point and face; refer to Figure-95. You can select round as well as flat faces in this case.
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•On selecting the second face or point, preview of plane will be displayed; refer to Figure-96. Click on the OK button from the dialog box to create the plane.
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Plane Along Path

The Plane Along Path tool is used to create a plane along selected path. The plane will be perpendicular to the path at selected point. The procedure to use this tool is discussed next.

•Click on the Plane Along Path tool of CONSTRUCT drop-down from Toolbar; refer to Figure-97. The PLANE ALONG PATH dialog box will be displayed; refer to Figure-98.
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•Path selection of PLANE ALONG PATH dialog box is active by default. Click on the edge/curve from model as reference for plane; refer to Figure-99.
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•On selecting the path, the updated PLANE ALONG PATH dialog box will be displayed along with the preview of plane; refer to Figure-100.
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•Click in the Distance edit box and specify the distance of plane in percentage between 0 to 1. You can also adjust the distance by moving the drag handle.

•After specifying the parameters, click on the OK button from PLANE ALONG PATH dialog box. The plane will be created.

Till now, we have created plane through different references. In next section, we will create axis through different references.

Axis Through Cylinder/Cone/Torus

The Axis Through Cylinder/Cone/Torus tool is used to create axis through center of cylinder, cone, or torus body. The procedure to use this tool is discussed next.

•Click on the Axis Through Cylinder/Cone/Torus tool of CONSTRUCT drop-down from Toolbar; refer to Figure-101. The AXIS THROUGH CYLINDER/CONE/TORUS dialog box will be displayed; refer to Figure-102.
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•Click on the round face of cylinder, cone, or torus from model, preview of the axis will be displayed; refer to Figure-103. Click on the OK button from the dialog box to create the axis.
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Axis Perpendicular at Point

The Axis Perpendicular at Point tool is used to create an axis perpendicular to the selected face at selected point. The procedure to use this tool is discussed next.

•Click on the Axis Perpendicular at Point tool of CONSTRUCT drop-down from Toolbar; refer to Figure-104. The tool will be activated and AXIS PERPENDICULAR AT POINT dialog box will be displayed; refer to Figure-105.
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•Click at desired location on the face of model; refer to Figure-106.

[image: ]

•After selecting the point on any face, preview of axis will be displayed; refer to Figure-107. Click on the OK button from the dialog box to create axis.
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Axis Through Two Planes

The Axis Through Two Planes tool is used to create an axis at the intersection of two planes or planar faces. The procedure to use this tool is discussed next.

•Click on the Axis Through Two Planes tool of CONSTRUCT drop-down from Toolbar; refer to Figure-108. The AXIS THROUGH TWO PLANES dialog box will be displayed; refer to Figure-109.
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•Planes selection button of AXIS THROUGH TWO PLANES dialog box is active by default. You need to select two planes to create an axis; refer to Figure-110.
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•On selecting the second plane, preview of axis will be displayed; refer to Figure-111.
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•Click on the OK button from the dialog box to create the axis.  

Axis Through Two Points

The Axis Through Two Points tool is used to create an axis passing through two reference points. The procedure to use this tool is discussed next.

•Click on the Axis Through Two Points tool of CONSTRUCT drop-down from Toolbar; refer to Figure-112. The tool will be activated and AXIS THROUGH TWO POINTS dialog box will be displayed; refer to Figure-113.
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•Select the two points from model; refer to Figure-114. Preview of axis will be displayed. Click on the OK button from the dialog box to create the axis.
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Axis Through Edge

The Axis Through Edge tool is used to create an axis on the selected edge/axis. The procedure to use this tool is discussed next.

•Click on the Axis Through Edge tool of CONSTRUCT drop-down from Toolbar; refer to Figure-115. The tool will be activated and AXIS THROUGH EDGE dialog box will be displayed; refer to Figure-116.
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•Click on desired edge of model to create the axis; refer to Figure-117. Preview of axis will be displayed.
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•Click on the OK button from the dialog box to create the axis.

 

Axis Perpendicular to Face at Point

The Axis Perpendicular to Face at Point tool is used to create an axis by using a face and a point as reference. The procedure to use this point is discussed next.

•Click on the Axis Perpendicular to Face at Point tool of CONSTRUCT drop-down from Toolbar; refer to Figure-118. The tool will be activated and AXIS PERPENDICULAR TO FACE AT POINT dialog box will be displayed; refer to Figure-119.
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•Click on the model to select the point and face as a reference for creating plane; refer to Figure-120.
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•On selecting the face, preview of axis will be displayed; refer to Figure-121.
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Note that axis will always be created passing through the point.

Till now, we have learned to create plane and axis. In next topics, we will learn the procedure to create points. Points can be used as origin, coordinate system location, or reference for other features. The tools to create points are discussed next.

Point at Vertex

The Point at Vertex tool is used to create a point by selecting any vertex of the model. The procedure to use this tool is discussed next.

•Click on the Point at Vertex tool of CONSTRUCT drop-down from Toolbar; refer to Figure-122. The tool will be activated and POINT AT VERTEX dialog box will be displayed; refer to Figure-123.
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•Click on the vertex of model to create a constructional point; refer to Figure-124.
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Note that you can create only one point at a time using this tool.

•Click on the OK button from the dialog box to create point.

Point Through Two Edges

The Point Through Two Edges tool is used to create a point at intersection of two edges/axes intersecting each other. The procedure to use this tool is discussed next.

•Click on the Point Through Two Edges tool of CONSTRUCT drop-down from Toolbar; refer to Figure-125. The tool is activated and POINT THROUGH TWO EDGES dialog box will be displayed; refer to Figure-126.
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•Select the two intersecting lines on the model to create point; refer to Figure-127.
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•On selecting the second line, preview of point will be displayed. Click on the OK button from the dialog box to create the point; refer to Figure-128.
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Point Through Three Planes

The Point Through Three Planes tool is used to create a point at the intersection of three planes/faces. The procedure to use this tool is discussed next.

•Click on the Point Through Three Planes tool of CONSTRUCT drop-down from Toolbar; refer to Figure-129. The tool will be activated and POINT THROUGH THREE PLANES dialog box will be displayed; refer to Figure-130.
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•Select the three intersecting planes/faces from the model; refer to Figure-131.
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•On selecting the third plane, preview of the constructional point will be displayed; refer to Figure-132.
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•Click on the OK button from the dialog box to create the point.

Point at Center of Circle/Sphere/Torus

The Point at Center of Circle/Sphere/Torus tool is used to create a point at the center of selected circle/sphere/torus. The procedure to use this tool is discussed next.

•Click on the Point at Center of Circle/Sphere/Torus tool of CONSTRUCT drop-down from Toolbar; refer to Figure-133. The tool will be activated and respective dialog box will be displayed; refer to Figure-134.
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•Select the circle, or round face of sphere/torus to create the center point. Preview of point will be displayed; refer to Figure-135.
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•Click on the OK button from the dialog box to create the point.

 

Point at Edge and Plane

The Point at Edge and Plane tool is used to create a point with the help of edge and plane as references. The procedure to use this tool is discussed next.

•Click on the Point at Edge and Plane tool of CONSTRUCT drop-down from Toolbar; refer to Figure-136. The tool will be activated and respective dialog box will be displayed; refer to Figure-137.
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•Select the edge and plane/face to create a point at the intersection; refer to Figure-138. 
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•On selecting the plane, preview of point will be displayed. Click on the OK button from the dialog box to create the point; refer to Figure-139.
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Point Along Path

The Point Along Path tool is used to create a point along selected path. The procedure to use this tool is discussed next.

•Click on the Point Along Path tool of CONSTRUCT drop-down from Toolbar; refer to Figure-140. The POINT ALONG PATH dialog box will be displayed; refer to Figure-141.
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•Path selection of POINT ALONG PATH dialog box is active by default. Click on the edge/curve from model as reference for point. On selecting the path, the updated POINT ALONG PATH dialog box will be displayed; refer to Figure-142.
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•Click in the Distance edit box and specify the distance of point in percentage between 0 to 1. You can also adjust the distance by moving the drag handle.

•After specifying the parameters, click on the OK button from POINT ALONG PATH dialog box. The point will be created; refer to Figure-143.
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Project/Include Tools

There are various tools in Project/Include cascading menu of CREATE drop-down in Toolbar of Sketch mode, which are used to generate sketch entities on current sketching plane or surfaces by using edges, faces, and other geometries of selected objects; refer to Figure-144. You can also generate intersection curves using 3D objects. The tools in this cascading menu are given next.

[image: ]

Project Tool

The Project tool is used to project selected surface/face/edge/point/sketch of other features on selected sketching plane. Like, you can project the boundaries of selected face on the sketching plane. The procedure to use this tool is given next.

•Click on the Project tool from Project/Include cascading menu of SKETCH drop-down in the Toolbar after activating sketch on desired sketching plane. The PROJECT dialog box will be displayed; refer to Figure-145.
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•Hover the cursor at desired geometry. Preview of project feature will be displayed; refer to Figure-146.

•Click at desired face/edge/point/curve to project it on sketching plane. You can select multiple objects to project them on sketching plane.

•Click on the OK button from the dialog box to apply projection.
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Intersect Tool

The Intersect tool is used when you want to create sketch geometries at the intersection of selected object and intersecting active sketching plane. The procedure to use this tool is given next.

•Start a sketch on desired plane.

•Click on the Intersect tool from Project/Include cascading menu of the CREATE drop-down in the Toolbar. The INTERSECT dialog box will be displayed; refer to Figure-147 and you will be asked to select the objects that are intersecting with current sketching plane.
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•Select the objects that are intersecting with current sketching plane and their intersection curves are to be generated; refer to Figure-148.
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•On selecting the objects that are intersecting with current sketching plane, a preview of the intersection curve will be displayed. Click on the OK button to create the generated curves; refer to Figure-149.
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Include 3D Geometry Tool

The Include 3D Geometry tool is used to include the boundaries of selected objects in current sketch. Note that this tool will not project the curves on selected sketching plane but you can use the curves for other purposes like as a reference. The procedure to use this tool is given next.

•Start a sketch on desired plane.

•Click on the Include 3D Geometry tool from the Project/Include cascading menu of the CREATE drop-down in Toolbar. You will be asked to select the 3D geometry to be included in current sketch.

•Select desired object. Boundary curves of selected object will be created on itself; refer to Figure-150.
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•Press ESC to exit the tool.

Project to Surface Tool

The Project to Surface tool is used to project selected curves on the selected faces/surfaces. The procedure to use this tool is given next.

•Click on the Project to Surface tool from the Project/Include cascading menu of the CREATE drop-down in the Toolbar. The PROJECT TO SURFACE dialog box will be displayed; refer to Figure-151. You will be asked to select a sketching plane.
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•Select the plane which is parallel to face/surface on which sketch is to be projected. The sketching environment will become active. Click on the Project to Surface tool, the PROJECT TO SURFACE dialog box will be displayed; refer to Figure-152.
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•Select the face(s) on which you want to project selected curves.

•Click on the Select button for Curves from the dialog box and select the curves to be projected. Preview of projection will be displayed; refer to Figure-153.
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•Select the Closest Point option from the Project Type drop-down if your object is well within the boundaries of selected face or you want to project along the surface vector to the closest point on the faces; refer to Figure-153. If some of the part of curve is outside the nearest surface then rest of the curve will not be projected; refer to Figure-154. Select the Along Vector option from the Project Type drop-down if you want to define the direction along which the curve will be projected and select a direction references like edge, axis, face, or plane. Preview of the projection will be displayed; refer to Figure-155.
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•Click on the OK button from the dialog box to create projection.

Intersection Curve Tool

The Intersection Curve tool is used to create projection curves generated by selected curve and selected surfaces/faces. The procedure to use this tool is given next.

•Start a new sketch on the plane perpendicular to projection direction.

•Click on the Intersection Curve tool from the Project/Include cascading menu of the CREATE drop-down in Toolbar. The INTERSECTION CURVE dialog box will be displayed; refer to Figure-156.
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•Select the curve that you want to be projected and then select the faces/surfaces on which curve is to be projected. Preview of intersection curve will be displayed; refer to Figure-157.
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•Click on the OK button from the dialog box to create curves.

Self Assessment

Q1. Discuss the procedure of cutting material from a body.

Q2. Which tool is used to combine two bodies?

Q3. Discuss the use of Sweep tool with example?	

Q4. Discuss the procedure of creating plane using Offset Plane tool with example.

Q5. Create a plane tangent to the face of model.

Q6. Create a plane using three points as reference.

Q7. Create a plane using edge of a model as reference.

Q8. Create a point at the center of cylinder.







Chapter  4

Advanced 3D Modeling
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The major topics covered in this chapter are:
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Introduction

In the last chapter, you have learned the procedure to use some 3D modeling tools and creating the constructional geometry. In this chapter, you will use the constructional geometry tools with some advanced 3D modeling tools. The tools are available in the panel of DESIGN workspace.

 

Loft

The Loft tool is used to create a solid volume by joining two or more sketches created on different planes; refer to Figure-1. The procedure to use this tool is given next.
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•Click on the Loft tool from CREATE drop-down in the Toolbar; refer to Figure-2. The LOFT dialog box will be displayed as shown in Figure-3.
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•By default, Profiles selection box is active and you are asked to select sketches for loft feature. You can also select faces/surfaces as profile for loft. 

•Click one by one on the sketches created at different planes. Note that you need to select the sketches in order by which they can be joined to each other successively. The preview of loft will be displayed; refer to Figure-4.
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•To make adjustments to the loft, you can move the loft points along the profile edge.

•Click the End condition drop-down of Profile 1 from Profiles selection box. The options will be displayed as per the geometry selected.

If you have selected sketches only as profiles then Connected and Direction options are available in the drop-down; refer to Figure-5. If you have selected sketches and faces of model or only faces of the model as profiles then Connected (G0), Tangent(G1), and Curvature(G2) options are available in the End condition drop-down; refer to Figure-6. If you have selected a point as profile at the end then Sharp and Point Tangent options will be available in the End condition drop-down; refer to Figure-7.
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•Select desired end condition option from the End condition drop-down. One line explanation of each end condition option is given in Figure-8.
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•Select the Direction option from the End Condition drop-down. The updated LOFT dialog box will be displayed with options to specify Takeoff Weight and Takeoff Angle; refer to Figure-9. As the name suggests, these options are used to specify scale and angle at which loft will start or end at selected profile.
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•If you have selected Tangent, Curvature, or Point Tangent option from the End Condition drop-down then Tangency Weight edit box will be displayed in the dialog box to specify scale factor of tangency.

•Enter the value as 4 in Takeoff Weight edit box and specify the outward angle in Takeoff Angle edit box by 20 degree. You will find a bulge in the loft feature; refer to Figure-10.
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•Select the Chain Selection check box if you also want to select the adjacent edges and included as one profile. Clear the check box if you want to select the each edge of profile individually. This check box hardly has any effect in modeling but you will find its uses in surfacing while creating loft feature.

•After setting desired parameters, click OK button from LOFT dialog box to create the loft feature.

Loft feature can be very useful in joining two faces or surfaces to create solid volume; refer to Figure-11. You can adjust the shape of loft by using the drag points on the edges. 
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Guide Type

There are two ways to control transition between profiles of loft; using Rails and using Centerline. Rails are 2D or 3D curves that affect the loft shape between sections at boundaries. To refine the shape of loft, you need to add number of rails. These rails must intersect each section and terminate on or beyond the first and last sections. Rails must be tangentially continuous. A Centerline tool is a type of rail to which the loft sections are held normal. It behaves like a sweep path. Centerline lofts maintain a more consistent transition between the cross-sectional areas of selected loft sections. Center lines follow the same criteria as rails, except they need not intersect the sections and only one centerline can be selected. We have discussed two examples next for tent and ring which use rails and centerline, respectively.

Using Rails

•To select rails for the loft, click the Rails button in Guide Type section; refer to Figure-12.
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•In this case, we have created a sketch of tent like structure using a rectangle and four arcs (to be used as rail) on different planes; refer to Figure-13.
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•Select the Loft tool from CREATE drop-down. The LOFT dialog box will be displayed.

•Select the rectangle and point of the sketch in Profiles section of LOFT dialog box. The preview of model will be shown.

•Click on the Arrow selection button of Rails from Guide Type section box, to select the rails for the loft.

•Select the four arcs of the model; refer to Figure-14.
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•Click OK button of LOFT dialog box to complete the process of making loft. The shape of loft will be modified according to rails selected.

Using Centerline

•To use the Centerline guide type, we have created a sketch of ring like structure with the help of circle and rectangle on different planes; refer to Figure-15.
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•Select the Loft tool from CREATE drop-down. The LOFT dialog box will be displayed.

•Select the circle and rectangle as profile in Profiles section of LOFT dialog box.

•Since these two profiles are coplanar, you may not get any preview and an error might welcome you. 

•Click on Centerline button from Guide Type section and select the circle to be used as center line. The preview will be displayed; refer to Figure-16. 
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•By default, Closed check box is clear so you will be getting half of the ring. Select the Closed check box to complete the loft. Preview of the loft feature will be modified; refer to Figure-17.
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•Click OK button of LOFT dialog box to complete the process. The tools of Operation drop-down are same as discussed earlier.

Rib

The Rib tool is used to create supporting features in the model by using curve(s). The procedure to use this tool is discussed next.

•Click on Rib tool from CREATE drop-down; refer to Figure-18 or right-click on the screen canvas and select Rib from Marking menu displayed. The RIB dialog box will be displayed; refer to Figure-19. Note that the curve for rib should be created in such a way that its projection is within solid faces of the model; refer to Figure-20.
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•The Profile section of RIB dialog box is active by default. Select the sketch curve joining edges of solid model to create rib. The updated RIB dialog box will be displayed; refer to Figure-21.

[image: ]

•Select the Symmetric option from Thickness Direction section to set the thickness of rib on both side of curve. Select One Side option from Thickness Direction section to apply the thickness of rib in one direction or one side.

•Specify desired value of thickness in Thickness edit box or floating window.

•Select the To Next option from Extent Type drop-down from RIB dialog box to create the rib up to next surface or model; refer to Figure-22.
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•Select the Distance option from Extent Type drop-down to specify the depth of rib. Type the numerical value of depth in Depth edit box or adjust the depth by moving the Drag arrow.

•You can also enter the value of depth in minus(-) to reverse the direction of depth in Depth edit box; refer to Figure-23.
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•Click on the Flip Direction button to flip the direction of rib.

•After specifying the parameters, click OK button of RIB dialog box to complete the process.

The Draft Angle and Fillet Radius section is inactive at this moment. It is a part of the Design Extension which is free in student version of this software. To activate these sections, follow the procedure discussed next.

•Click on the Extensions button from the toolbar; refer to Figure-24. The Extension Manager dialog box will be displayed; refer to Figure-25.

[image: ]

[image: ]

•Click on the Start Trial Now button highlighted in the dialog box; refer to Figure-25. The Design Extension access will be enabled successfully; refer to Figure-26.
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•Now, click on the Rib tool again. The new RIB dialog box will be displayed; refer to Figure-27.
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•Select desired preset from Presets drop-down to apply or save the current values of the dialog box or create new preset by clicking on the [image: ] New Preset button.

•Select the sketch curve as profile to create rib. The updated RIB dialog box will be displayed; refer to Figure-28.
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•Select From Bottom button from Start section to measure the thickness starting from the bottom and select From Top button to measure the thickness starting from the top.

•Specify desired draft angle and fillet radius value in the Draft Angle and Fillet Radius edit boxes, respectively.

•Click on the Draft Pull Direction button of Draft Pull Direction section and select desired plane or face to define the pull direction.

•Select the Flip Pull Direction button to flip the pull direction for draft.

•Click on the OK button to create the rib feature.

Web

The Web tool works like Rib tool which is used to create geometry from sketch curves that intersect with pre-existing bodies. The Web tool uses multiple curves to create several merged ribs at once. The procedure to use this tool is discussed next.

•Click on Web tool from CREATE drop-down of SOLID tab in the Toolbar; refer to Figure-29. The WEB dialog box will be displayed; refer to Figure-30.
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•The Profile selection is active by default. Select the sketch to create web; refer to Figure-31. 
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•Enter desired value of thickness in the Thickness edit box or floating window. You can also set the thickness by moving the drag handle.

•The other options in the dialog box are same as discussed earlier. Preview of rib will be displayed according to parameters specified; refer to Figure-32.
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•Click OK button from WEB dialog box to complete the process.

EMBOSS

The Emboss tool is used to raises or recesses a sketch profile relative to selected faces on a solid body by specified depth and direction. The procedure to use this tool is discussed next. 

•Click on the Emboss tool from CREATE drop-down of SOLID tab in the Toolbar; refer to Figure-33. The EMBOSS dialog box will be displayed; refer to Figure-34.
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•The Select button of Sketch Profiles section is active by default. Select the sketch profile which you want to emboss on a solid body; refer to Figure-35.
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•Click on the Select button of Faces section and select the face on a solid body on which the sketch profile is to be embossed; refer to Figure-36. The updated EMBOSS dialog box along with the preview of emboss will be displayed; refer to Figure-37.
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•Select Tangent Chain check box to automatically select tangent geometry.

•Type desired value in the Depth edit box to specify the depth to emboss or deboss.

•Select Emboss button from Effect section of the dialog box to add material to the body and select Deboss button to remove material from the body.

•Drag the distance and angle manipulator handles or enter desired values in the Horizontal Distance, Vertical Distance, and Rotation Angle edit boxes from Alignment section to position the emboss feature on the solid body.

•After specifying desired parameters, click on the OK button from the dialog box. The emboss or deboss feature will be created; refer to Figure-38.
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Hole

The Hole tool is used to create holes that comply with real machining tools. With the help of Hole tool, three types of holes are created. The procedure to use this tool is discussed next.

•Click on Hole tool from CREATE drop-down or right-click on the screen canvas and select Hole from Marking menu displayed; refer to Figure-39. The HOLE dialog box will be displayed; refer to Figure-40.
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•There are two types of tools in Placement section which are discussed next.

Single Hole

•Click on Single Hole button from Placement section to create one hole. The  Select button for Face section will be activated. 

•Select the face/plane on which you want to create hole. The updated HOLE dialog box will be displayed with preview of hole; refer to Figure-41.
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•Click on Select button of first Reference section from HOLE dialog box, click at the center of hole and then click at the edge from where you want to specify the distance of hole; refer to Figure-42.
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•Enter desired value of distance in the dynamic input box or Distance edit box in dialog box. Click on another edge to define other reference and set desired distance value.

•Click on Simple button in Hole Type section to create simple hole of specified dimensions. 

•Click on Counterbore button in Hole Type section to create a counterbore hole and specify the dimension in their respective edit boxes at the bottom in the dialog box; refer to Figure-43.
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•Click on Countersink button in Hole Type drop-down to create a countersink hole and specify the dimension in their respective edit box at the bottom in the dialog box; refer to Figure-44.
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•Click on desired button in the Hole Tap Type section to define tapping inside the hole. Select the Simple button to create straight holes without tapping.  

•Select the Clearance button to create standard holes with defined fit. The options will be displayed accordingly; refer to Figure-45. Select desired options to define size of hole.

•Select the Tapped button to create holes as per their class and designation in standard hole profile database; refer to Figure-46.
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•Select desired options to define shape and size of hole. If you want to model threads created by tapping in the hole then select the Modeled check box. Preview of hole will be displayed with selected thread type; refer to Figure-47.
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•Select the Distance option from Extents drop-down to specify the distance of hole in the model. Select the To option from Extents drop-down to set the length of hole up to next model or face. Select the All option from Extents drop-down to create a hole passing through all the features in its path.

•Click on Flip Direction button to reverse the direction of hole.

•Expand the Objects To Cut node and select check boxes for bodies that you want to be cut by the hole.

•After specifying the parameters, click OK button of HOLE dialog box to complete the process; refer to Figure-48.
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Multiple Holes

The Multiple Holes button in HOLE dialog box is used to create multiple similar hole at a time. To use this tool, you must have sketch points already created on the model where you want to cut holes. The procedure to use this tool is discussed next.

•Click on the Multiple Holes button in Placement section from HOLE dialog box. The Sketch Point selection tool will be activated. Select the sketch points for defining positions of holes; refer to Figure-49.
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•Set the other options as discussed earlier.

•After specifying the parameters, click OK button from HOLE dialog box to finish the process. The holes will be created; refer to Figure-50.
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Thread

The Thread tool is used to cut helical thread on cylindrical faces. Using this tool, you can save the custom threads in library. The procedure to use this tool is discussed next.

•Click on the Thread tool from the CREATE drop-down in the Toolbar; refer to Figure-51. The THREAD dialog box will be displayed; refer to Figure-52.
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•The Faces selection of THREAD dialog box is active by default. Select the round faces to which threads are to be applied. 

•Select the Modeled check box to create the model feature of thread otherwise it will be created as cosmetic feature.

•On selecting Modeled check box, preview of thread will be displayed; refer to Figure-53.
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•Clear the Full Length check box to specify the length of thread on the selected face. Otherwise, thread will be created up to the entire length of selected face.

•Click on the Thread Type drop-down to select the type of thread profile; refer to Figure-54. Most of the engineering thread profiles are available in this drop-down.
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•Click on the Size drop-down and select desired size of thread. You can also adjust the size by using the Drag Handle.

•Click on the Designation drop-down and select the designation of thread; refer to Figure-55.

•Click on the Class drop-down and select the class of thread.

•Click on Direction drop-down and select the direction for thread; refer to Figure-56.
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•Select the Remember Size check box to remember these thread setting for the next time, when the Thread tool will be invoked.

•Click OK button from THREAD dialog box to create the thread; refer to Figure-57.
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Box

The Box tool is used to create a rectangular box on selected work plane. The procedure to use this tool is discussed next.

•Click on Box tool in CREATE drop-down from Toolbar; refer to Figure-58. You will be asked to select the plane for creating the sketch for box. 
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•Select Top plane or any other desired plane/face.

•Click on the screen to specify the first point of sketch.

•Move the cursor to display preview of rectangle and click at desired location to specify other corner of rectangle. You can also enter the numerical value of Length and Width in their specific edit box; refer to Figure-59.
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•You can toggle between these two edit boxes by pressing TAB key. The Box dialog box will be displayed along with the preview of box; refer to Figure-60.
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•Specify desired value of height in the Height edit box of the BOX dialog box.

•The options of Operation section were discussed earlier.

•Click OK button from the BOX dialog box to create the box; refer to Figure-61.
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Cylinder

This tool is used to create a cylindrical body by adding depth to a circular region. The procedure to use this tool is discussed next.

•Click on Cylinder tool in CREATE drop-down from Toolbar; refer to Figure-62. You are asked to select plane for creating base sketch. Select desired plane/face.
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•Click on the screen to specify the center point of base circle.

•Type desired value of diameter in the floating window; refer to Figure-63 and press ENTER to create a sketch of circle. The CYLINDER dialog box will be displayed along with preview of cylinder; refer to Figure-64.
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•If you want to edit the diameter of cylinder then click in the Diameter edit box of CYLINDER dialog box and specify desired value.

•Click in the Height edit box and specify the height of cylinder.

•Click OK button from the CYLINDER dialog box to create the cylinder; refer to Figure-65.
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Sphere

The Sphere tool is used to create a T-spline, solid, or surface sphere on a work plane or face. The procedure to use this tool is discussed next.

•Click on the Sphere tool in CREATE drop-down from Toolbar; refer to Figure-66. You are asked to select the plane for creating the sketch for circle. Select desired plane/face.
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•Click on the screen at desired location to specify the center point of sphere. The SPHERE dialog box will be displayed along with the preview of sphere; refer to Figure-67.
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•Click in the Diameter edit box and specify desired value of diameter for sphere.

•The options of Operation drop-down are same as discussed earlier.

•Click OK button of SPHERE dialog box to finish the process; refer to Figure-68.
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Torus

The Torus tool is used to create T-spline, solid, or surface torus on a work plane or face. The procedure to use this tool is discussed next.

•Click on Torus tool in CREATE drop-down from Toolbar; refer to Figure-69. You are asked to select the plane/face for creating the center circle of torus. Select desired face/plane.
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•Click on the screen to specify center point of sketch. Specify the diameter of torus in dynamic input box and press ENTER; refer to Figure-70. The TORUS dialog box will be displayed along with the preview of torus; refer to Figure-71.
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•If you want to edit the diameter of circle earlier created then click in the Inner Diameter edit box and specify desired value.

•Click in the Torus Diameter edit box and type the diameter of torus. You can also adjust the diameter of torus by moving the drag handle.

•Select the On Center option of Position drop-down from TORUS dialog box, if you want to use inner circle as center of the torus. Select the Inside option of Position drop-down if you want to position the torus inside of the inner circle. Select the Outside option of Position drop-down if you want to position the torus section outside of the inner circle.

•The options of Operation drop-down are same as discussed earlier.

•Click OK button of TORUS dialog box to finish the process; refer to Figure-72. 
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Coil

The Coil tool is used for creating helix-based features like springs. The procedure to use this tool is discussed next.

•Click on the Coil tool of CREATE drop-down from Toolbar; refer to Figure-73. You will be asked to select a face/plane to create base sketch.
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•Click on desired face/plane. You will be asked to specify center of the base circle.

•Click on the screen to specify the center point of sketch. Type desired value of diameter of coil in dynamic input box and press ENTER; refer to Figure-74.
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•The COIL dialog box will be displayed along with the preview of coil; refer to Figure-75.
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•Select the Revolution and Height option from Type drop-down if you want to create the coil by specifying number of revolutions in the coil and height of coil. Select the Revolution and Pitch option from Type drop-down if you want to create the coil by specifying number of revolutions in the coil and distance between two successive turns of the coil. Select the Height and Pitch option from Type drop-down to specify total height of the coil and distance between two successive turns of the coil. Select the Spiral option from Type drop-down to create a spiral coil. Note that the options in the dialog box will be modified based on your selection in Type drop-down. In our case, we are selecting the Revolution and Height option; refer to Figure-76.

•Click on the Rotation button to flip the rotation side of coil to clockwise or counterclockwise direction; refer to Figure-77.
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•Click in the Diameter edit box and enter desired value to change the diameter of coil.

•Click in the Revolutions edit box and enter desired value for number of revolutions of coil.

•Click in the Height edit box and specify the total height of coil. You can also set the height of coil by moving the drag handle.

•Click in the Angle edit box and specify desired angle value to create taper coil.

•Select Circular option from Section drop-down of COIL dialog box to set the circular profile of coil. Select the Square option from Section drop-down to set square profile of coil. Select Triangular(External) option from Section drop-down to set the external triangular profile of coil. Select Triangular(Internal) option of Section drop-down to set internal triangular profile of coil; refer to Figure-78.
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•Select On Center option of Section Position drop-down from COIL dialog box to position the coil in such a way that the base circle is at center of the coil. Click on the Inside button of Section Position drop-down if you want to position the coil inside the base circle. Click on the Outside section of Section Position drop-down if you want to position the coil outside the base circle.

•Click in the Section Size edit box and specify the size of coil section. If section is circle then this will be diameter and if section is triangle or square then it will be length of one edge of section.

•The options of Operations drop-down were discussed earlier.

•Click OK button of COIL dialog box to finish the process of creating a coil; refer to Figure-79.
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Pipe

The Pipe tool is used to create pipes of different sections that follow a selected path. The procedure to use this tool is discussed next.

•Click on Pipe tool of CREATE drop-down from Toolbar; refer to Figure-80. The PIPE dialog box will be displayed and you will be asked to select a path for pipe; refer to Figure-81.
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•Select the sketch or edge of a model for path of the pipe; refer to Figure-82.
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•On selecting the path, the updated PIPE dialog box will be displayed. Click in the Distance edit box and enter desired value. The value of distance lies between 0 to 1. You can also set the distance (length) of pipe on the selected path by moving the drag handle.

•The options of Section drop-down were discussed earlier in Coil tool.

•Click in the Section Size edit box and specify the diameter of pipe.

•Select the Hollow check box to create a hollow pipe. The updated PIPE dialog box will be displayed along with the preview of pipe; refer to Figure-83.
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•Click in the Section Thickness edit box and specify thickness of pipe.

•The options of Operation drop-down were discussed earlier in this book.

•Click OK button of PIPE dialog box to complete the process of creating the pipe; refer to Figure-84.
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Pattern

The Pattern tool is used to create copies of features or bodies at regular intervals. There are three tools in Pattern cascading menu; refer to Figure-85. These tools are discussed next.
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Rectangular Pattern

The Rectangular Pattern tool is used to create copies of objects in one or two directions. The procedure to use this tool are discussed next.

•Click on Rectangular Pattern  tool of Pattern cascading menu from CREATE drop-down in the Toolbar; refer to Figure-86. The RECTANGULAR PATTERN dialog box will be displayed; refer to Figure-87.
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•Select Faces option from Type drop-down if you want to select faces for pattern. Select Bodies option from Type drop-down if you want to select bodies for creating copies. Select Features option from Type drop-down if you want to select features for creating copies. Select Components option from Type drop-down if you want to select component for creating copies; refer to Figure-88.
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•We are using Bodies option from Type drop-down. Select the body for creating its copies; refer to Figure-89.
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•Click on Select button of Axes option and select the default axes or edges of the model to define direction in which copies will be created; refer to Figure-90. 
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•Select the Extent option from Distribution drop-down if you want to specify total length within which copies will be created. Select the Spacing option from Distribution drop-down to set the distance between two consecutive instances of object. In our case, we have selected Extent option.

•Select the Suppress check box if you want to suppress any instance of pattern.

•Click in the Quantity edit box and specify the number of instances to be created in the pattern along selected direction.

•Click in Distance edit box and specify the distance value within which pattern instances will be created. You can also set the distance by moving the drag handle.

•Select the One Direction option from Direction Type drop-down if you want to create the copies in one side of selected direction. Click on Symmetric option from Direction Type drop-down to create the copies in both sides of selected direction.

•Similarly, specify the quantity, distance, and direction type for other direction.

•After specifying the parameter, click OK button from RECTANGULAR PATTERN dialog box to finish the process; refer to Figure-91.
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Circular Pattern

The Circular Pattern tool is used to create copies of selected objects around selected axis/edge. The procedure to use this tool is discussed next.

•Click on Circular Pattern tool from Pattern cascading menu; refer to Figure-92. The CIRCULAR PATTERN dialog box will be displayed; refer to Figure-93.
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•Select desired option from Type drop-down. The options of Type drop-down are same as discussed in Rectangular Pattern tool.

•Objects selection is active by default. Select the feature to be patterned; refer to Figure-94.
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•Click on Select button of Axis section and select the edge/axis about which the circular pattern will be created; refer to Figure-95.
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•Select the Full option from Distribution drop-down if you want to create the copies of object around 360 degree path. Select Angle option from Distribution drop-down if you want to create the copies within specified angle range. Click on Symmetric option from Distribution drop-down if you want to create copies symmetrically in specified angle range.

•Select the Suppression check box if you want to suppress the any instance of pattern.

•Click in the Quantity edit box and type the number of copies to be created in pattern.

•Select Optimized option from Compute Option drop-down to create identical copies by patterning feature faces. Select Identical option to create identical copies by replicating results of original features. Select Adjust option to create potentially different copies by patterning features and calculating extents or terminations of each instance individually.

•After specifying the parameters, click on the OK button from CIRCULAR PATTERN dialog box to finish the process; refer to Figure-96.
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Pattern on Path

The Pattern on Path tool is used to create copies of the selected object along  selected path. The procedure to use this tool is discussed next.

•Click on the Pattern on Path tool of Pattern cascading menu from CREATE drop-down; refer to Figure-97. The PATTERN ON PATH dialog box will be displayed; refer to Figure-98.
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•Click on Faces option from Type drop-down. Other options of Type drop-down are same as discussed earlier.

•Objects selection is selected by default. Select the faces for creating the copies; refer to Figure-99.
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•Click on Select button for Path option and select the path for creating copies.   

•On selecting path, the updated PATTERN ON PATH dialog box will be displayed; refer to Figure-100.

[image: ]

•Select the Suppression check box if you want to suppress any instance of pattern.

•Click in the Distance edit box and specify the distance value along the path. 

•Click in the Quantity edit box and specify the number of copies to be created.

•The Start Point option is used to specify the distance from the start point to place where the first pattern instance will be created. It is shown in the screen canvas as a white point and determines the starting point of the selected path. It can be set to any value between zero and one using the Start Point edit box, but it is easier to adjust it manually by dragging the start point; refer to Figure-101.
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•The options of Distance Type and Direction drop-down were discussed earlier in this chapter.

•Select Path Direction option from Orientation drop-down if you want to rotate each instance according to the pattern path. Select Identical option from Orientation drop-down to keep the instances in the same orientation as the original object.

•Click OK button from PATTERN ON PATH dialog box to complete the process of creating the copies; refer to Figure-102.
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Geometric Pattern

The Geometric Pattern tool is used to create a pattern with size and distribution gradients across a face on a solid body. The procedure to use this tool is discussed next.

•Click on the Geometric Pattern tool of Pattern cascading menu from CREATE drop-down; refer to Figure-103. The GEOMETRIC PATTERN dialog box will be displayed; refer to Figure-104.
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•The Select button of Face section is active by default. Select desired face on a solid body to create the pattern to it; refer to Figure-105. The updated Geometric Pattern dialog box will be displayed; refer to Figure-106.
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•Select desired option from Object Type section to pattern across the selected face. Select Sphere option to pattern primitive sphere across the selected face. Select Cylinder option to pattern primitive cylinder across the selected face. Select Box option to pattern primitive box across the selected face. Select Custom option to pattern a custom object across the selected face.

•Specify minimum and maximum sizes for the objects in the pattern in the Size Limit 1 and Size Limit 2 edit boxes from Object Size rollout.

•Specify the rate of transition from one size limit to the other in the Spread edit box or by sliding the Spread slider.

•In the Object Distribution rollout, select Rectangular, Triangular, Hexagonal, Circular, or Radial option from Distribution Type section to distribute objects across the faces in a repeating rectangular, triangular, hexagonal, circular, or radial pattern, respectively.

•For the rectangular pattern, select desired option from Spacing Type drop-down. Select Increment option to space objects in the pattern at specified distance relative to each other. Select Extent option to space objects in the pattern evenly over the specified distance.

•For the circular and radial pattern, specify the distance between each concentric circle in the pattern in the Radial Distance edit box.

•Specify the distance between each object in the pattern in the Distance edit box.

•Select Align Left, Align Center, or Align Right option from U Alignment section to align the objects in the pattern to the left of the face, center of the face, or right of the face relative to its U direction, respectively.

•Specify desired distance value to offset the pattern from the edge of the face in the U direction in the U Offset edit box.

•Select Align Bottom, Align Middle, or Align Top option from V Alignment section to align the objects in the pattern to the bottom, middle, or top of the face relative to its V direction, respectively.

•Select Clear Perimeter check box to remove incomplete objects from the perimeter of the selected faces.

•Specify the distance value to offset the perimeter of the selected faces to adjust the boundary of the pattern in the Perimeter Offset edit box.

•After specifying desired parameters, click on the OK button from the dialog box. The geometrical pattern will be created; refer to Figure-107.
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Mirror

The Mirror tool is used to create mirror copy of selected objects to the opposite side of a selected face or plane. The procedure to use this tool is discussed next.

•Click on Mirror tool of CREATE drop-down from Toolbar; refer to Figure-108. The MIRROR dialog box will be displayed; refer to Figure-109.
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•Select desired option from Object Type drop-down to select respective objects for mirroring. The other options of Object Type drop-down have already been discussed earlier.

•Select the bodies to be mirrored.

•Click on Select button of Mirror Plane section and select the plane/face to be used as mirror plane. Preview of mirror copy will be displayed; refer to Figure-110.
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•Select desired option from Operation drop-down which have been discussed earlier in this chapter.

•If you have selected Features in Object Type drop-down then Compute Type drop-down will also be displayed in the dialog box; refer to Figure-111. Select the Optimized option if you want to create copy of feature with minimum processing time and less flexibility to individually change features later. Select Identical option if you want to create copy of feature using same background programming which was used while creating the base feature. Select the Adjust option if you want to recompute each instance of the feature as a separate feature.
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•Click OK button of MIRROR dialog box to finish the process of creating mirror copy; refer to Figure-112.
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Thicken

The Thicken tool is used to add thickness to surfaces to make them solid. (You will learn about surfaces in Chapter 9 Surface Modeling of this book.) The procedure to use this tool is discussed next.

•Open any file that has surfaces or create a surface by following basic tools of Chapter 9 of this book. 

•Click on Thicken tool of CREATE drop-down from Toolbar; refer to Figure-113. A THICKEN dialog box will be displayed; refer to Figure-114.
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•Faces selection is active by default. Select the surface to add thickness; refer to Figure-115.
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•Click in the Thickness edit box of dialog box and specify desired value of thickness.

•Click on One Side option from Direction drop-down to apply the thickness to one side of surface. Click on Symmetric option from Direction drop-down to apply the thickness to both sides of surface equally. In our case, we have selected Symmetric option.

•The options of Operation drop-down were discussed earlier in this chapter.

•Click OK button of THICKEN dialog box to finish the process; refer to Figure-116.
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Boundary Fill

The Boundary Fill tool is used to create a volume from bounded by selected planes, bodies, and surfaces. This volume is called cell and can be used to cut, add, or create new body in the model. The procedure to use this tool is discussed next.

•Click on Boundary Fill tool of CREATE drop-down from Toolbar; refer to Figure-117. The BOUNDARY FILL dialog box will be displayed; refer to Figure-118.
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•The Select Tools selection is active by default. Select the bodies/planes/surfaces for boundary fill; refer to Figure-119.
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•Click on Select button of Select Cells section and select the check boxes for cells to be created.

•The tools of Operation section were discussed earlier in this chapter.

•Click OK button of BOUNDARY FILL dialog box to finish the process; refer to Figure-120. If the parent body is overlapping with new boundary fill bodies then hide the parent body using eye icon in BROWSER to check the result. 
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Create Form

The Create Form tool is used to create or modify the form of model using freestyle editing tools. Clicking this tool takes you to Form mode. You will learn more about Form mode later in Chapter 12 and 13 of this book. The procedure to use this tool is discussed next.

•Click on Create Form tool of CREATE drop-down from Toolbar; refer to Figure-121. The Form mode will be activated and related toolbar will be displayed; refer to Figure-122.
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•Now, create or modify the model as desired.

•Click Finish Form button from Toolbar to exit the Form mode and return to Model Workspace; refer to Figure-123.
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Create Base Feature

The Create Base Feature tool inserts a base feature operation in the Timeline. Any operations performed on the design while in a base feature are not recorded in the Timeline. This tool is used when you want to safeguard some of the operations while sharing the file.

•Click on Create Base Feature tool of CREATE drop-down from Toolbar; refer to Figure-124. The tools in the Toolbar will be same as for DESIGN workspace.
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•Do desired operation that you do not want to record in Timeline and then click on FINISH BASE FEATURE button from Toolbar to exit the mode; refer to Figure-125.
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CREATE PCB FEATURE

The Create PCB tools in CREATE drop-down is used to create and modify PCB design in collaboration with EAGLE users. There are two tools in Create PCB cascading menu; refer to Figure-126. The procedures to use these tools are given next.
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Create Associative PCB

•Click on the Create Associative PCB tool from Create PCB cascading menu; refer to Figure-126. A pop-up window will be displayed asking you to save the current design; refer to Figure-127.
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•Click on the Save and Continue button. The Save dialog box will be displayed as discussed earlier.

•Specify desired name and location for the file and click on the Save button. The CREATE ASSOCIATIVE PCB dialog box will be displayed; refer to Figure-128.
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•Select desired sketch profile from canvas; refer to Figure-129 and specify desired parameters in the dialog box.
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•Click on the OK button from the dialog box. The 3D PCB Workspace will be activated and related toolbar will be displayed; refer to Figure-130.
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Create Independent PCB

•Click on the Create Independent PCB tool from Create PCB cascading menu; refer to Figure-126. The CREATE INDEPENDENT PCB dialog box will be displayed; refer to Figure-131.
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•Select desired sketch profile from canvas; refer to Figure-132 and specify desired parameters in the dialog box.
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•Click on the OK button from the dialog box. The 3D PCB Workspace will be activated and related toolbar will be displayed as discussed earlier.

Adding Holes to PCB

The PCBHole tool is used to create holes for adding components to the PCB. The procedure to use this tool is given next.

•Click on the PCBHole tool from the MODIFY drop-down in the 3D PCB tab of the Ribbon. The PCBHOLE dialog box will be displayed.

•Select the face of PCB where you want to place the hole. Preview of hole will be displayed; refer to Figure-133.
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•Click at the center of hole and select desired edge of PCB to define first reference. The options to define distance from selected reference will be displayed; refer to Figure-134.
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•Similarly, specify distance for other reference and click on the OK button. The hole will be created.

The tools of 3D PCB are beyond the scope of this book. You will learn about PCB and Electronic Design in our another book.

plastic tools

The Plastic tools are used to assign and manage plastic rules that control certain settings in the components that are assigned to them. The tools are discussed next.

Assign Plastic Rule

The Assign Plastic Rule tool is used to assign plastic rule to a component to automatically control the properties of plastic features like physical material and thickness. The procedure to use this tool is discussed next.

•Click on the Assign Plastic Rule tool from SETUP panel in the PLASTIC tab of the Toolbar; refer to Figure-135. The ASSIGN PLASTIC RULE dialog box will be displayed; refer to Figure-136.
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•The Select button of Component section is active by default. Select the component in the Model Space that you want to assign the plastic rule; refer to Figure-137.
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•Select desired plastic rule from the cloud library in the Library node of the Plastic Rule section in the dialog box.

•After selecting desired plastic rule, click on the OK button from the dialog box. The plastic rule will be assigned to the component; refer to Figure-138.
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Manage Plastic Rules

The Manage Plastic Rules tool is used to create new rules, edit existing rules, or save rules to a library to use them in multiple designs. The procedure to use this tool is discussed next.

•Click on the Manage Plastic Rules tool from SETUP panel in the PLASTIC tab of the Toolbar; refer to Figure-139. The MANAGE PLASTIC RULES dialog box will be displayed; refer to Figure-140.
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•If you want to edit the rule, then select the rule you want to edit and click on Edit Plastic Rule button or right-click on the rule that you want to edit and select Edit Plastic Rule button; refer to Figure-141. The Edit Plastic Rule dialog box will be displayed; refer to Figure-142.
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•Edit the parameters of the rule as desired and click on the Save button from the dialog box. The plastic rule will be edited.

•If you want to create new plastic rule then select the rule and click on New Plastic Rule button or right-click on the rule and select New Plastic Rule button; refer to Figure-143. The New Plastic Rule dialog box will be displayed; refer to Figure-144.
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•Specify desired parameters of the rule in the dialog box and click on the Save button. The new plastic rule will be created.

Snap Fit

The Snap Fit tool is used to create a cantilever snap fit feature to fasten two solid bodies together in a design. The procedure to use this tool is discussed next.

•Click on the Snap Fit tool from CREATE panel in the PLASTIC tab of the Toolbar; refer to Figure-145. The SNAP FIT dialog box will be displayed as shown in Figure-146.
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•Select desired option from Type section in the dialog box to create the snap fit feature. The Parallel Hook And Groove option is selected by default which is used to create a snap fit feature with a hook and groove, parallel to a face on a pair of solid bodies. Select Perpendicular Hook And Groove option to create a snap fit feature with a hook and groove, perpendicular to a face on a pair of solid bodies. Select Hook And Loop option to create a snap fit feature with a hook and loop on a pair of solid bodies.

•Select the Automatic button from the Selection Mode section to automatically select all visible sketch points based on reference points. Select the Manual button from the section to select each sketch point for snap fit manually. 

•The Select button of Sketch Points section is active by default. Select the sketch point to position the hook side of each snap fit feature; refer to Figure-147. The preview of snap fit along with updated SNAP FIT dialog box will be displayed; refer to Figure-148.
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•Select Flip button to flip the snap fit feature over the selected sketch point.

•The target body will be selected automatically in the Body section on which the snap fit feature will be placed.

•Select desired option from the Rotation Type drop-down to define how rotation value will be specified. For example, select the Aligned option from drop-down to align the face of snap fit with selected face of the model or select the Independent option to specify angle value independent of any model reference.

•Specify desired value in the Rotation Angle edit box to rotate the hook around the sketch point or drag the Rotation manipulator handle.

•Select Distance option from Extent Type drop-down to extrude the bottom of the hook from the sketch plane to a specified depth in the Depth edit box. Select To Next option to extrude the bottom of the hook from the sketch plane to the nearest faces on a solid body.

•Expand the Hook node and specify desired values in the edit boxes to adjust the dimensions of the hook side of the snap fit feature.

•Select the Groove check box and specify desired values in the edit boxes to create the groove side of the snap fit feature.

•After specifying desired parameters in the dialog box, click on the OK button. The snap fit feature will be created; refer to Figure-149.
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Boss

The Boss tool is used to create a boss feature to fasten two solid bodies together and reinforce thin areas of a design. The procedure to use this tool is discussed next.

•Click on the Boss tool from CREATE panel in the PLASTIC tab of the Toolbar; refer to Figure-150. If your model is not saved yet then the Cannot create fastener pop-up window will be displayed asking you to save the design to create fastener or continue without creating the fastener; refer to Figure-151.
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•Click on the Save button to save the design. The Save As dialog box will be displayed.

•Specify desired name and location of the design and click on the Save button. The design will be saved.

•Click on the Continue button to create the boss feature without creating the fastener. The BOSS dialog box will be displayed; refer to Figure-152.
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•The Select button of Sketch Points section is active by default. Select desired sketch point to place the boss; refer to Figure-153. The No plastic rule assigned pop-up window will be displayed along with the updated BOSS dialog box; refer to Figure-154.
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•Click on the Assign Plastic Rule button to assign the plastic rule or click on the Continue button from the pop-up window to create boss feature without assigning the plastic rule. The preview of boss feature will be displayed; refer to Figure-155. Note that you may need to drag the offset position handle for generating preview of feature. 
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•All buttons are selected by default in the Visibility section. The Side 1 Transparency button reduces the opacity of the Side 1 body while you edit the boss feature. The Side 2 Transparency button reduces the opacity of the Side 2 body while you edit the boss feature. The Section Analysis button cuts a section through the center of the boss feature while you edit.

•Select the Flip button to flip the boss feature over selected sketch point to switch Side 1 and Side 2 bodies.

•Specify desired distance value in the Offset Position edit box to offset the position of the boss feature from the sketch plane.

•Select desired option from Head section and Drive section of the Fastener node to create fastener of desired head type.

•Select desired thread form from Thread Form drop-down and thread angle from the Thread Angle drop-down to apply to the fastener.

•Select desired diameter from Thread Diameter drop-down to apply to the fastener.

•Select desired type of hole type and step from Hole Type section and Step Type section of Side node in the dialog box, respectively to create boss feature.

•Expand the Advanced node and specify desired values in the edit boxes to adjust the dimensions of the side of the boss feature.

•Click on the Ribs tab to create ribs on sides of boss feature. The related options will be displayed.

•Select the Side 1 check box to activate rib feature on side 1 of boss feature; refer to Figure-156. Set the parameters as discussed earlier for the rib. 
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•After specifying desired parameters in the dialog box, click on the OK button. The boss feature will be created; refer to Figure-157.

[image: ]

Creating Rest Feature

The Rest tool is used to create a flat rest area in the model based on a closed loop sketch. The procedure to use this tool is given next.

•Click on the Rest tool from the CREATE drop-down of PLASTIC tab in Toolbar. The REST dialog box will be displayed and you will be asked to select a profile; refer to Figure-158.

•Select the sketch profile from the model. Preview of rest feature will be displayed and options will be displayed as shown in Figure-159. 
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•Set desired parameters in the dialog box and click on the OK button. 

Self Assessment

Q1. Which of the following is not the default plane available in Autodesk Fusion?

a. Front Plane

b. Right Plane

c. Top Plane

d. Left Plane

Q2. Discuss the procedure of creating multiple holes with example.

Q3. Which of the following tool is not available in CREATE drop-down of Autodesk Fusion?

a. Thread

b. Box

C. Torus

d. Curve

Q4. Thicken tool is used to add thickness and length. (T/F)

Q5. The Pattern On Path tool is available in the CREATE drop-down. (T/F)

Q6. Discuss the use of Pipe tool with examples.

Q7. Discuss the use of Web tool with examples.

Q8. Which tool is used to create a solid body connecting two sketch from different planes?

Q9. Discuss the use of Pattern On Path tool with examples.

Q10. The ................. tool is used to cut helical thread on cylindrical faces.

Q11. Why plastic rules are assigned to the component? And which tool is used to assign the plastic rule to the component?

Q12. The .................. tool is used to create new rules, edit existing rules, or save rules to a library to use them in multiple designs.

Q13. The Boss tool is used to create a boss feature to fasten two solid bodies together and reinforce thin areas of a design. (T/F)







Chapter  5

Practical and Practice
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The major topics covered in this chapter are:

•Practical

•Practice




Practical 1

Create the model as shown in Figure-1. The views of the model with dimension are given in Figure-2.
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Before we start working on Practical 1, it is important to understand two terms; first angle projection and third angle projection. These are the standards of placing views in the engineering drawings. The views placed in the above figure are using third angle projection. In first angle projection, the top view of model is placed below the front view and right side view is placed at the left of the front view. You will learn more about projection in chapter related to drafting.

Creating the Sketch

•Click on Create Sketch tool from CREATE drop-down in Toolbar. You will be asked to select a plane for creating sketch.

•Select Top Plane from the canvas screen.

•Click on Center Diameter Circle tool of Circle cascading menu from CREATE drop-down in Toolbar. You will be asked to place the center point of circle.

•Click at the Origin to place the center point of circle. Enter 50 in floating window as diameter of circle and press ENTER key.

•Sketch another circle of radius 10 (diameter 20) taking center point as origin.

How to show radius in place of diameter of circle? Create the circle with diameter value. Right-click on diameter dimension and select Toggle Radius button from Marking menu; refer to Figure-3.
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•Select Center Rectangle tool of Rectangle cascading menu from CREATE drop-down in Toolbar.

•Click at Origin as center point for rectangle and enter 5 as width & 25 as length in floating window to create a rectangle; refer to Figure-4.
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•Select Trim tool of MODIFY drop-down from Toolbar and trim the entities in such a way that the sketch is displayed as shown in Figure-5.
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•Click on Finish Sketch button from Toolbar to exit the sketch mode.

Creating Extrude Feature

•Click on Extrude tool of CREATE drop-down from Toolbar or press E key from keyboard to select Extrude tool. The EXTRUDE dialog box will be displayed.

•Profile selection is active by default. Select the recently created sketch profile. The updated EXTRUDE dialog box will be displayed.

•Specify the height of extrusion as 25 in Distance edit box or floating window. The preview of extrusion will be displayed; refer to Figure-6. (You need to rotate the model by using SHIFT+Middle Mouse Button to check the preview.)
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•Click OK button from EXTRUDE dialog box to complete the process of extrusion. The model will be displayed as shown in Figure-7.

•Save the file and close it.
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Practical 2

Create the model as shown in Figure-8. The dimensions are given in Figure-9. Assume the missing dimensions.
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Creating sketch for model

•Start a new sketch using Top Plane.

•Select Centre Rectangle tool of Rectangle cascading menu from CREATE drop-down.

•Click on the origin to specify the centre point of rectangle and specify 60 and 50 in floating window as dimensions of rectangle; refer to Figure-10. Press TAB to toggle between edit boxes.
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•Select Line tool from CREATE drop-down. Create a line of length as 70 and angle of 80 degree as shown in Figure-11.
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•Select Mirror tool of CREATE drop-down from Toolbar and create a mirror copy of recently created line about centerline as shown in Figure-12.
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•Create a line joining end points of two earlier created lines as shown in Figure-13.

[image: ]

•Select Center Point Slot tool of Slot cascading menu from CREATE drop-down and create a slot of diameter as 15 and length as 8 at a distance of 65 from origin on the centerline; refer to Figure-14.
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•Press T from keyboard or click on the Trim tool from MODIFY drop-down in Toolbar to activate trimming tool. Select the inner lines of rectangle to remove them; refer to Figure-15. 
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•Click on the Finish Sketch button to exit sketch.

Creating Extrude Feature

•Select Extrude tool from CREATE drop-down or press E key. The EXTRUDE dialog box will be displayed.

•Profile selection is active by default. Click in the sketch outside the slot.

•Specify 10 as height of extrusion in Distance edit box of EXTRUDE dialog box; refer to Figure-16. (Rotate the model to get clear view.)
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•Click OK button from EXTRUDE dialog box to complete the process of extrusion.

•Click on the Create Sketch tool from CREATE drop-down. You are asked to select the plane to create sketch. Select the side face of model as shown in Figure-17.
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•Select the 2-Point Rectangle tool from Rectangle cascading menu in the CREATE drop-down of Toolbar. Create a rectangle of dimensions 25 and 60 with two holes of diameter 10 as shown in Figure-18. 

•Click on the Finish Sketch button to exit sketching. 
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•Select Extrude tool from CREATE drop-down. The EXTRUDE dialog box will be displayed.

•Select the upper portion of recently created sketch in Profiles selection and specify -5 as height of extrusion.

•Select Join from Operation drop-down of EXTRUDE dialog box to join the two extrusions.

•Click OK button from EXTRUDE dialog box to finish this process; refer to Figure-19.
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Creating Midplane

•Select Midplane tool of CONSTRUCT drop-down from Toolbar. The MIDPLANE dialog box will be displayed. You are asked to select the faces between which you want to create a midplane.

•Select both the faces as shown in Figure-20.

•The preview of midplane will be displayed. Click OK button from the MIDPLANE dialog box to complete the process; refer to Figure-21.
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Creating Rib

•Select Create Sketch tool from CREATE drop-down. You will be asked to select the plane for creating sketch. Select the newly created midplane from BROWSER.

•Create a line as shown in Figure-22 with end points coincident to the vertices of model and finish the sketch. 

[image: ]

•Select Rib tool from CREATE drop-down. The RIB dialog box will be displayed.

•Select the recently created line for Profile section.

•Select Symmetric option from Thickness Direction section.

•Select To Next option from Extent Type drop-down.

•Click in Thickness edit box and enter 5 as thickness of rib; refer to Figure-23. (You might need to click on the Flip Direction button from the dialog box to get desired preview.)
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•Click OK button of RIB dialog box to finish the process. The model will be displayed as shown in Figure-24.
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Practical 3

Create the model as shown in Figure-25. The dimensions of the model are given in Figure-26.
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Creating sketch for model

•Start a new design file in Autodesk Fusion. Select Create Sketch tool from CREATE drop-down in the Toolbar. You are asked to select sketching plane. Select Top Plane to create sketch. Select Center Diameter Circle tool of Circle cascading menu from CREATE drop-down. 

•Create three circle of 8, 20, and 100 as diameter dimension of circles; refer to Figure-27.
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•Press L key to select Line tool and create a line of length 10.

•Select 3-Point Arc tool from Arc cascading menu and create an arc of 60 radius and 35 length as shown in Figure-28.
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Creating Circular Pattern

•Select Circular Pattern tool from CREATE drop-down. The CIRCULAR PATTERN dialog box will be displayed.

•Objects selection is active by default. Select the recently created line and arc for circular pattern.

•Click on Select button of Center Point section and select the major circle to define its center as center point for pattern; refer to Figure-29.
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•The updated CIRCULAR PATTERN dialog box will be displayed. Click in Quantity edit box and specify 10 as quantity of circular pattern.

•Click OK button from CIRCULAR PATTERN dialog box to complete the process.

Trimming

•Select the Trim tool from MODIFY drop-down and remove all the extra entities from sketch as shown in Figure-30.
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•After removing the extra entities from sketch, the sketch will be displayed as shown in Figure-31.
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Creating Extrude

•Select Extrude tool from CREATE drop-down or press E key. The EXTRUDE dialog box will be displayed.

•Profile selection is active by default. Click between 20 diameter and 8 diameter circle to extrude the middle section.

•Select Symmetric option of Direction drop-down from EXTRUDE dialog box.

•Click in Distance edit box of EXTRUDE dialog box and specify 15 as height of extrusion. Rotate the model to check preview; refer to Figure-32.
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•Click OK button of EXTRUDE dialog box to finish this extrusion. The sketch of extrude feature will hide automatically. Click on the crossed eye icon before Sketch 1 in the Sketches node of BROWSER to display the sketch again.

•Right-click on the screen and select Repeat Extrude button from Marking Menu. The EXTRUDE dialog box will be displayed.

•Select the area outside the 20 diameter circle earlier created.

•Select Symmetric button of Direction drop-down from EXTRUDE dialog box.

•Click in Distance edit box of EXTRUDE dialog box and specify 13 as height of extrusion; refer to Figure-33.
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•Click OK button from EXTRUDE dialog box to complete the process of extrusion. The model will be displayed as shown in Figure-34.
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You can now hide the sketch and save the file.

Practical 4

Create the model as shown in Figure-35. The dimensions of the model are given in Figure-36.
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Creating sketch for model

•Start a new design file in Autodesk Fusion. Click on the Create Sketch tool from CREATE drop-down in the Toolbar. You are asked to select sketching plane.

•Select Top Plane to create sketch. Select Center Diameter Circle tool of Circle cascading menu from CREATE drop-down. 

•Create two circles of diameter 70 mm and 40 mm and create three circles of diameter 20 mm each; refer to Figure-37. After creating the circles, apply Horizontal/Vertical constraint to the circles.
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•Select 3-Point Arc tool of Arc cascading menu from CREATE drop-down and create three arcs of radius 20 mm each; refer to Figure-38. After creating the arcs, apply Concentric constraint to all the arcs.
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•Select Line tool from CREATE drop-down and create three lines joining the arcs; refer to Figure-39. After creating the lines, apply Tangent constraint to all the lines.
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•Select 3-Point Arc tool of Arc cascading menu and create two arcs of radius 8 mm each; refer to Figure-40. After creating the arcs, apply Tangent constraint to the arcs.
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Trimming

•Select the Trim tool from MODIFY drop-down and remove extra entities from sketch as shown in Figure-41.
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•After removing extra entities from sketch, the sketch will be displayed as shown in Figure-42.
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Creating Extrude

•Select Extrude tool from CREATE drop-down or press E key. The EXTRUDE dialog box will be displayed.

•Profile selection is active by default. Select the profile from the sketch as shown in Figure-43.
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•Select One Side option of Direction drop-down from EXTRUDE dialog box.

•Click in Distance edit box of EXTRUDE dialog box and specify 12 as distance of extrusion.

•Click OK button of EXTRUDE dialog box to finish this extrusion. The first sketch will be extruded and another sketch to be extruded will hide automatically; refer to Figure-44. 
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•Click on the crossed eye icon before Sketch 1 in the Sketches node of BROWSER to display the sketch again.

•Right-click on the screen and select Repeat Extrude button from Marking Menu. The EXTRUDE dialog box will be displayed.

•Select the profile to extrude as shown in Figure-45.
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•Select One Side option of Direction drop-down from EXTRUDE dialog box.

•Click in Distance edit box of EXTRUDE dialog box and specify 50 as distance of extrusion.

•Click on the OK button from Extrude dialog box to finish the extrusion. The second sketch will be extruded; refer to Figure-46.
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Creating Offset Plane

•Select Offset Plane tool from CONSTRUCT drop-down. The OFFSET PLANE dialog box will be displayed and you are asked to select the plane.

•The Select button of Plane section is active by default. Select YZ plane from BROWSER.

•Click in the Distance edit box of the dialog box and enter 24.5 as distance value; refer to Figure-47.

•Click on OK button from the dialog box to complete the process.
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Creating the Sketch

•Select Create Sketch tool from CREATE drop-down. You are asked to select the plane.

•Select newly created offset plane from BROWSER as sketching plane. The sketching environment will be displayed.

•Select Center Diameter Circle tool of Circle cascading menu from CREATE drop-down and create two circles of diameter 15 mm and 30 mm; refer to Figure-48.
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Intersecting the Sketch

•Select Slice check box from SKETCH PALETTE dialog box. The slice of the model will be created; refer to Figure-49.
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•Select Intersect tool of Project/Include cascading menu from CREATE drop-down. The INTERSECT dialog box will be displayed. You are asked to select the geometries.

•The Select button of Geometry section is active by default. Select sliced part of the model as geometry to be intersect; refer to Figure-50.
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•Click on OK button from INTERSECT dialog box to complete the process.

•Hide the body by clicking on eye icon before Body1 in the Bodies node of BROWSER. The intersected geometry will be displayed; refer to Figure-51.
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•Select Line tool from CREATE drop-down and create the lines as shown in Figure-52.
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•Select the intersected geometry by pressing CTRL key and right-click; refer to Figure-53. A Marking Menu will be displayed.
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•Select Normal/Construction button from Marking Menu. 

•Click on Finish Sketch button from Toolbar.

Extruding the sketch

•Select Extrude tool from CREATE drop-down. The EXTRUDE dialog box will be displayed. You are asked to select the profile.

•The Select button of Profile section is active by default. Select the sketch to extrude as shown in Figure-54.
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•Specify the parameters as shown in the Figure-54. Click in the Distance edit box and enter -14 mm as distance of extrusion.

•Click on OK button from EXTRUDE dialog box to complete the process. The another sketch to be extruded will hide automatically.

•Click on the crossed eye icon before Sketch 2 in the Sketches node of BROWSER to display the sketch again.

•Select the sketch and click RMB. A Marking Menu will be displayed. Click Repeat Extrude button from Marking Menu. The EXTRUDE dialog box will be displayed again along with profile selected for extrusion.

•Specify the parameters as specified for previous extrusion; refer to Figure-55.
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•Click on OK button from the dialog box to complete the extrusion.

•Select recently extruded sketch and click RMB. A Marking Menu will be displayed; refer to Figure-56.
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•Click Repeat Extrude button from Marking Menu. The EXTRUDE dialog box will be displayed along with profile selected for extrusion.

•Click in the Distance edit box and enter -4 as the distance for extrusion.

•Select Cut option from Operation drop-down. The preview of extrusion will be displayed; refer to Figure-57.
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•Click on OK button from EXTRUDE dialog box to complete the process.

Mirroring the body

•Click on the crossed eye icon before Body1 in the Bodies node of BROWSER to display the body.

•Select Mirror tool from CREATE drop-down. The MIRROR dialog box will be displayed. You are asked to select the object.

•Select Bodies option from Object Type drop-down of dialog box.

•The Select button of Objects section is active by default. Select recently created body to be mirror; refer to Figure-58. You are asked to select the mirror plane.
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•Click on the Select button of Mirror Plane section and select YZ plane as mirror plane. The preview of mirror will be displayed; refer to Figure-59.
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•Click on OK button from dialog box to complete the process.

Combining the bodies

•Select Combine tool from MODIFY drop-down. The COMBINE dialog box will be displayed. You are asked to select target body.

•The Select button of Target Body section is active by default. Select the body from the model as shown in Figure-60. You are asked to select the tool body.
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•The Select button of Tool Bodies section is active by default. Select the bodies to combine with target bodies as shown in Figure-61.
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•Click on OK button from the dialog box to complete the process of combining the bodies. The model will be displayed as shown in Figure-62.
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Practice 1

Create the model as shown in Figure-63. The dimensions are given in Figure-64.
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Practice 2

Create the model as shown in Figure-65. The dimensions are given in Figure-66.
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Practice 3

Create the model as shown in Figure-67. The dimensions are given in Figure-68.
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Practice 4

Create the model as shown in Figure-69. The dimensions are given in Figure-70
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Practice 5

Create the model as shown in Figure-71. The dimensions are given in Figure-72. (Hint: You will need Rectangular Pattern tool and Move/Copy tool in this model.)
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Practice 6

Create the model as shown in Figure-73. The dimensions are given in Figure-74.
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Practice 7

Create the model as shown in Figure-75. The dimensions are given in Figure-76.
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Practice 8

Create the model as shown in Figure-77. The dimensions are given in Figure-78.
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Practice 9

Create the model as shown in Figure-79. The dimensions are given in Figure-80. 
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Practice 10

Create the model as shown in Figure-81. The dimensions are given in Figure-82.
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Chapter  6

Solid Editing
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The major topics covered in this chapter are:
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Solid editing tools

In the previous chapters, we have learned to create solid models and remove materials from them. In this chapter, we will learn to edit the models. Like the other tools, Autodesk Fusion has packed all the editing tools into one drop-down. These tools are available in MODIFY drop-down from Toolbar; refer to Figure-1. The tools in this drop-down are discussed next. 
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Press Pull

The Press Pull tool is used to modify the body by drag and drop methods. The options displayed to perform press pull operations depends on the selected geometry. The procedure to use this tool is discussed next.

•Select Press Pull tool of MODIFY drop-down from Toolbar; refer to Figure-2. The PRESS PULL dialog box will be displayed; refer to Figure-3. You can also select Press Pull tool by pressing Q key.
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•Select a face, if you want to offset or move the face. The OFFSET FACE dialog box will be displayed. The Offset Face tool will be discussed later.

•Select an edge, if you want to fillet the edge. The FILLET dialog box will be displayed. The Fillet tool will be discussed later in this unit.

•Select a sketch, if you want to extrude the profile. The EXTRUDE dialog box will be displayed. This tool was discussed earlier in this book.

Offset Face

The Offset Face tool is used to offset or move the face. The procedure to use this tool is discussed next.

•Select Press Pull tool from MODIFY drop-down. The PRESS PULL dialog box will be displayed. 

•Click on the face of the model to offset. The OFFSET FACE dialog box will be displayed; refer to Figure-4.
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•Select Automatic button from Offset Type drop-down if you do not want to update the sketch or base feature on applying the offset. This action is not added to time line.

•Select Modify Existing Feature button from Offset Type drop-down if you want to update the sketch or base feature on applying offset. This action is not added to time line.

•Select New Offset button from Offset Type drop-down if you want to create a new face. This action is added to time line.

•Click in Distance edit box of OFFSET FACE dialog box or floating window from screen and enter desired value as the distance for offset. You can also move drag handle to set the distance. The preview of offset face will be displayed; refer to Figure-5.
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•Click OK button from OFFSET FACE dialog box to complete the process.

Fillet

The Fillet tool is used to apply round at the edges. This tool works in the same way as the Sketch Fillet do. It is recommended that, apply the fillets after creating all the features required in the model because fillets can increase the processing time during modifications. The procedure to use this tool is given next.

•Select Fillet tool of MODIFY drop-down from Toolbar; refer to Figure-6 or press Q and select an edge. The FILLET dialog box will be displayed; refer to Figure-7.
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•Edges selection is active by default. Click on the edge(s) from the model to apply fillet. You can select multiple edges also without holding the CTRL key. The updated FILLET dialog box will be displayed; refer to Figure-8.
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•The options of the updated FILLET dialog box are discussed next.

Radius Type Drop-Down

There are three options in Radius Type drop-down; refer to Figure-9. These options are used to specify the type of round to be created. These options are discussed next.
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Constant Radius Type

•Select Constant button from Radius Type drop-down to apply the fillet of fix size on the selected edge.

•Click in the Radius edit box of FILLET dialog box and enter 10 as the radius of fillet. You can also move the drag-handle from canvas screen to set the radius of fillet; refer to Figure-10.
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•Select the Tangent Chain check box to include tangentially connected edges in fillet.

•Specify desired value in Tangency Weight edit box to increase or decrease the scale of tangency weight.

•Select the Curvature (G2) option from Continuity drop-down if you want to apply the curvature continuity to the selected fillet.

•Select desired option from Corner Type section to define fillet shape at vertex formed by three edges meeting at single point.

•Click OK button from FILLET dialog box to apply the fillet.

Chord Length Radius Type

•Select Chord Length option of Radius Type drop-down from FILLET dialog box if you want to specify the chord length to control the size for the fillet.

•Click in the Chord Length edit box and enter desired value for fillet. You can also set the value by moving the drag handle. The preview will be displayed; refer to Figure-11. 
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•The other parameters are same as discussed in last topic.

Variable Radius Type

•Select Variable option from Radius Type drop-down of FILLET dialog box if you want to specify radii at selected points along the edge. The updated FILLET dialog box will be displayed.

•Click on the edge to create points for applying fillet and specify radius for each point in the dialog box or dynamic input box; refer to Figure-12.
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•To delete the created point, select the specific point from the edge and click on the Remove selection set button from the FILLET dialog box. Point earlier created to apply fillet will be displayed with arrows.

•The other parameters of this dialog box were discussed earlier.

•After specifying the parameters, click on the OK button from FILLET dialog box to create the fillet.

Rule Fillet

The Rule Fillet option is used to add fillets or rounds to a design based on specified rules. The edges are determined by specified rules rather than selection in the canvas. The procedure to use this tool is discussed next.

•Select Rule Fillet option from Type drop down in FILLET dialog box; refer to Figure-13. The FILLET dialog box with rule fillet options will be displayed; refer to Figure-14.
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•The Faces/Features selection is active by default. Select desired faces/features from model to apply rule fillet.

•Click in the Radius edit box and specify desired value of radius for fillet. The preview of fillet will be displayed; refer to Figure-15. You can also set the radius by moving the drag handle.
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•Select All Edges option from Rule drop-down if you want to add the fillets to all edges of the input faces/features and select Between Faces/Features option if you want to add the fillets at the intersection of the input faces/features. Note that you can also select features from Time line.

•Select Rounds Only option from Topology drop-down if you want to create only rounds and select the Fillets Only option if you want to create only fillets. Selecting the Rounds And Fillets option in this drop-down will create both fillets and rounds.

•Click OK button from FILLET dialog box to finish this process.

FULL ROUND FILLET

The Full Round Fillet option is used to create full round fillet by selecting a face only and it will automatically find the two opposite edges. The procedure to use this tool is discussed next.

•Select Full Round Fillet option from Type drop-down in Fillet dialog box; refer to Figure-16. The FILLET dialog box with full round fillet options will be displayed; refer to Figure-17.
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•The Select button of the Center Faces section is active by default. Select desired center face of the model to create full round fillet; refer to Figure-18.
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•On selecting center face of the model, full round fillet of the model will be created and the updated FILLET dialog box will be displayed; refer to Figure-19.
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•Click on Select button of Side 1 section and press & hold CTRL key to select faces on first side of the full round fillet and click on Select button of Side 2 section and press & hold CTRL key to select faces on second side of the full round fillet to modify the fillet.

•After specifying the parameters, click on OK button from the dialog box to finish the process.

Chamfer

The Chamfer tool is used to bevel the sharp edges of the model. The procedure to create chamfer by using this tool is given next.

•Click on the Chamfer tool of MODIFY drop-down from Toolbar; refer to Figure-20. The CHAMFER dialog box will be displayed; refer to Figure-21.
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•Edges/Faces/Features selection is active by default. Click on the edge of model to apply chamfer. The updated CHAMFER dialog box will be displayed; refer to Figure-22.
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•Select the Tangent Chain check box to include tangentially connected edges in selection.

•Select Equal Distance option from Type drop-down of CHAMFER dialog box if you want to specify equal distance for both sides of the chamfer.

•Select Two Distance option from Type drop-down of CHAMFER dialog box if you want to specify distance for each side of the chamfer.

•Enter the value of distance for each side in the respective edit box. You can also set the distance by moving the drag handle from canvas screen.

•Select Distance and Angle option from Type drop-down if you want to specify distance and angle values to create the chamfer.

•Click in the Specify distance value edit box and enter desired value for distance for chamfer. The preview of chamfer will be displayed; refer to Figure-23.  
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•Select Chamfer option from Corner Type drop-down to create a chamfer to join beveled edges at the corner. 

•Select Miter option from Corner Type drop-down to merge beveled edges into a mitered corner point. 

•Select Blend option from Corner Type drop-down to blend beveled edges into adjacent faces.

•Click OK button of CHAMFER dialog box to finish the process. 

Shell

The Shell tool is used to make a solid part hollow and remove one or more selected faces. The procedure to use this tool is given next.

•Select Shell tool of MODIFY drop-down from Toolbar; refer to Figure-24. The SHELL dialog box will be displayed; refer to Figure-25.

[image: ] [image: ]

•The Faces/Body selection button is active by default. Click on the face/body of the solid to apply shell. The updated SHELL dialog box will be displayed; refer to Figure-26.
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•Select the Tangent Chain check box to include tangentially connected edges in selection.

•Click in the Inside Thickness edit box and specify desired value of shell thickness. The preview of shell will be displayed; refer to Figure-27.
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•Select Inside option from Direction drop-down if you want to shell the faces towards the interior of the part.

•Select Outside option from Direction drop-down if you want to shell the faces towards the exterior of the part.

•Select Both option from Direction drop-down if you want to shell the faces towards the interior and the exterior of the part by equal amount. Click in the Inside Thickness and Outside Thickness edit boxes and specify desired value to specify thickness for shell.

•Click OK button from SHELL dialog box to complete the process.

Draft

The Draft tool is used to apply taper to the faces of a solid model. This tool is mainly useful when you are designing components for moulding or casting. Draft tool applies taper on the face and this taper allows easy & safe ejection of parts from dies. The procedure to use this tool is discussed next.

•Select Draft tool of MODIFY drop-down from Toolbar; refer to Figure-28. The DRAFT dialog box will be displayed; refer to Figure-29.
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•The Fixed Plane draft type is selected by default in the Type section of the dialog box. Fixed Plane draft type creates tapered face using angle specified from selected fixed plane.

•The Pull Direction selection button is active by default. Click on the face or plane of the model which you want to use as fixed reference.

•Click on Select button of Faces section and select the faces to be tapered.

•Click on the Flip Pull Direction button from DRAFT dialog box to flip the direction of draft.

•Click in the Angle edit box and specify desired value of angle for draft. The preview of draft will be displayed; refer to Figure-30. You can also set the angle of draft by moving the drag handle.
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•The options of Draft Sides drop-down were discussed earlier in this book.

•Click OK button from DRAFT dialog box to finish the process.

•Select Parting Line draft type from Type section of the dialog box to create draft along a parting line. The updated DRAFT dialog box will be displayed; refer to Figure-31.
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•Select desired face or plane of the model to define pull direction in Pull Direction section.

•Select desired plane, face, edge, or sketch curve on the model to use as parting tool in Parting Tool section.

•Select desired faces on the model which you want to draft in the Faces section of the dialog box.

•Specify desired value of angle for draft in the Angle edit box. The preview of parting line draft type will be displayed; refer to Figure-32.
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•Select Fix Parting Line option from Parting Line Type drop-down to fix the parting line in place.

•Select desired option from Draft Sides drop-down as discussed earlier in this book.

•Select Move Parting Line option from Parting Line Type drop-down to move the parting line to apply draft.

•Select Angle Above option from Direction drop-down to maintain angle above parting line.

•Select Angle Below option from Direction drop-down to maintain angle below parting line.

•Select Both option from Direction drop-down to maintain angle on both sides of parting line.

•Click on the Select button from Fixed Edges section of the dialog box and select edges of the model to prevent deformation when parting line moves.

•The other options in the dialog box have been discussed earlier.

•Click OK button from DRAFT dialog box to finish the process.

Scale

The Scale tool is used to enlarge or reduce selected bodies, sketches, or components based on specified scale factor. The procedure to use this tool is discussed next.

•Select Scale tool of MODIFY drop-down from Toolbar; refer to Figure-33. The SCALE dialog box will be displayed; refer to Figure-34.
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•The Entities selection is active by default. Click on the entities to be scaled up or down.

•On selecting the entity for scale, point is automatically selected in Point section. If you want to use a different point as scale reference then click on the Select button for Point option in the dialog box and select desired point.

•Select Uniform option from Scale Type drop-down if you want to scale the selected entities uniformly in all the directions.

•Select Non-Uniform option from Scale Type drop-down if you want to scale the entity non-uniformly in x, y, and z direction. 

•Click in the Scale Factor edit box and specify desired value for scale. The preview will be displayed; refer to Figure-35.

•Click on OK button of SCALE dialog box to complete the process.
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Combine

The Combine tool is used to cut, join, and intersect the selected bodies. The procedure to use this tool is discussed next.

•Select Combine tool of MODIFY drop-down from Toolbar; refer to Figure-36. The COMBINE dialog box will be displayed; refer to Figure-37.
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•The Target Body selection button is active by default. Click on the component from model to be used as a target body.

•Click on other components to select in Tool Bodies section. The preview of combine will be displayed; refer to Figure-38.
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•The options of Operations drop-down have been discussed earlier in this book.

•Select the New Component check box to create a new component with results.

•Select the Keep Tools check box to retain the tool bodies after the combine result.

•Click OK button of COMBINE dialog box to finish the process.

Replace Face

The Replace Face tool is used to replace an existing face with a surface or work plane. The procedure to use this tool is discussed next.

•Select Replace Face tool of MODIFY drop-down from Toolbar; refer to Figure-39. The REPLACE FACE dialog box will be displayed; refer to Figure-40.
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•Source Faces selection is active by default. Click on the component face to select the face. 

•Select the Tangent Chain check box to include tangentially connected faces in selection.

•Click Select button of Target Faces section and click on the face or plane to apply this tool. The preview will be displayed; refer to Figure-41.
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•Click OK button of REPLACE FACE dialog box to finish the process.

Split Face

The Split Face tool is used to divide faces of a surface or solid to add draft, delete an area, or create features. The procedure to use this tool is discussed next.

•Select Split Face tool of MODIFY drop-down from Toolbar; refer to Figure-42. The SPLIT FACE dialog box will be displayed; refer to Figure-43.
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•The Faces To Split option is active by default. Click on the model face to be split. You can select multiple faces by holding the CTRL key.

•Click on the Select button of Splitting Tool option and select the face which will split the other faces.

•Select Split With Surface option from Split Type drop-down, if you want to project the splitting tool face which you had selected upon the splitting face.

•Select Along Vector option from Split Type drop-down, if you want to define the projection direction of splitting face by selecting a face, edge, or axis. 

•Select Closest Point option from Split Type drop-down, if you want to define the direction of projection as the closest distance between the splitting body and target faces.

•Select the Extend Splitting Tool check box to extend the tool to completely intersect the target faces.

•After specifying the parameters, click on OK button from SPLIT FACE dialog box to finish the process; refer to Figure-44.
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Split Body

The Split Body tool works similar to Split Face tool but in this tool, component or part is selected in place of faces. The procedure to use this tool is discussed next.

•Select Split Body tool of MODIFY drop-down from Toolbar; refer to Figure-45. The SPLIT BODY dialog box will be displayed; refer to Figure-46.
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•The Body To Split selection is active by default. Click on the component to be split.

•Click on Select button of Splitting Tool option and select the body of which splitting will be done.

•Select the Extend Splitting Tool(s) check box to extend the tool to completely intersect the target faces. 

•After specifying various parameters, click OK button of SPLIT BODY dialog box to complete the process; refer to Figure-47.
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Silhouette Split

The Silhouette Split tool is used to split selected body at the silhouette outline visible from the view direction. The procedure to use this tool is discussed next.

•Select Silhouette Split tool of MODIFY drop-down from Toolbar; refer to Figure-48. The SILHOUETTE SPLIT dialog box will be displayed; refer to Figure-49.
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•The View Direction selection option is active by default. Click on the plane or face to select the direction to split.

•Click on Select button of Target Body and select the body which you want to split.

•Select Split Faces Only option from Operation drop-down, if you want to split the faces of the selected body but keeps it as a single body.

•Select Split Shelled Body option from Operation drop-down, if you want to split the selected body into two bodies. To use this option , the selected body must be shelled first.

•Select Split Solid Body option from Operation drop-down, if you want to split the selected body at the parting line. The parting line of the selected body must be planar.

•After specifying the parameters, click OK button of SILHOUETTE SPLIT dialog box to finish the process; refer to Figure-50.
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Move/Copy

The Move/Copy tool is used to move a face, body, sketch curve, components, or sketch geometry. Using this tool, you can also move the whole geometry. The procedure to use this tool is discussed next.

•Select Move/Copy tool of MODIFY drop-down from Toolbar; refer to Figure-51. The MOVE/COPY dialog box will be displayed; refer to Figure-52.
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•Select Component option from Move Object drop-down, if you want to move a component.

•Select Bodies option from Move Object drop-down, if you want to move a body.

•Select Faces option from Move Object drop-down, if you want to move a face.

•Select Sketch Objects option from Move Object drop-down, if you want to move the selected sketch. 

•In our case, we are selecting the Bodies option from Move Object drop-down.

•Selection section is active by default. Click on the body to be moved. The updated MOVE/COPY dialog box will be displayed.

•Select Free Move button from Move Type section, if you want to move selected body freely.

•On selecting the Free Move button, a Manipulator will be displayed on the selected body. Use the Manipulator to move the body or enter the value in respective field of MOVE/COPY dialog box; refer to Figure-53.
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•Select Translate button from Move Type section, if you want to move the body along X, Y, and Z directions.

•On selecting the Translate button, three arrows will be displayed on the entity. Drag desired arrow to move the body in respective direction. You can also enter the specific value of direction in the respective edit box from MOVE/COPY dialog box; refer to Figure-54.
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•Select Rotate button from Move Type section, if you want to rotate the entity.

•On selecting the Rotate option, the Axis option will be displayed in the MOVE/COPY dialog box. 

•Click on the Select button from Axis section of MOVE/COPY dialog box and select the axis/edge for rotation of entity. The drag handle will be displayed on the selected face.

•Move the drag handle as required or specify the value in the Angle edit box of MOVE/COPY dialog box; refer to Figure-55.
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•Select Point to Point button from Move Type section, if you want to move the body from one point to another point.

•Click on the Select button of Origin Point option from MOVE/COPY dialog box and select the start point of body from where you want to move the body.

•Click on the Select button of Target Point option from MOVE/COPY dialog box and select the finish point from model.

•After selecting the points, the preview will be displayed.

•If the preview is as required then click on OK button from MOVE/COPY dialog box to complete the process; refer to Figure-56.
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•Select Point to Position button from Move Type section, if you want to move the body by selecting a point and a position from model.

•Select a point of the body. The updated MOVE/COPY dialog box will be displayed; refer to Figure-57.
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•Click in the Position X edit box and specify the value. Similarly, specify the value in Position Y and Position Z edit boxes as required.

•After specifying the parameters, click on the OK button from MOVE/COPY dialog box to complete the process.

Align

The Align tool is used to align selected object to another object. The procedure to use this tool is discussed next.

•Click on the Align tool of MODIFY drop-down from Toolbar; refer to Figure-58. The ALIGN dialog box will be displayed; refer to Figure-59.
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•Select Bodies option from Object drop-down of ALIGN dialog box if you want to select bodies to align.

•Select Components option from Object drop-down of ALIGN dialog box if you want to select components to align.

•In our case, we are selecting Bodies option from Object drop-down.

•Click on Select button of From section of ALIGN dialog box and select point on the first body from which you want to align that body.

•Click on Select button of To section of ALIGN dialog box and select point on the second body to which the body to be aligned; refer to Figure-60.
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•On selecting the point on second body, the two selected body will align to each other at selected location; refer to Figure-61.
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•Click on the Flip button, if you want to flip the aligned body.

•Click on Angle button, if you want to rotate the aligned body.

•After specifying the parameters, click on the OK button from ALIGN dialog box to finish the process.

Delete

The Delete tool is used to delete the selected object or component. You can also press DELETE from keyboard to do the same. The procedure to use this tool is discussed next.

•Click on the Delete tool of MODIFY drop-down from Toolbar; refer to Figure-62. The DELETE dialog box will be displayed; refer to Figure-63.
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•The Objects selection is active by default. Select the object to be deleted from the existing model.

•After selecting desired object, click on the OK button from DELETE dialog box to delete the selected object; refer to Figure-64.
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Remove Tool

The Remove tool is used to delete selected components and bodies from the design while preserving the operations in the timeline. The procedure to use this tool is given next.

•Click on the Remove tool from the MODIFY drop-down in the SOLID tab of Ribbon. The REMOVE dialog box will be displayed; refer to Figure-65.
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•Select the body to be removed from the graphics area; refer to Figure-66 and click on the OK button. Selected body will be removed from graphics area but still will be available in the timeline bar; refer to Figure-67.
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Physical Material

The Physical Material tool is used to apply physical and visual material to the component or body. The procedure to use this tool is discussed next.

•Click on the Physical Material tool of MODIFY drop-down from Toolbar; refer to Figure-68. The PHYSICAL MATERIAL dialog box will be displayed; refer to Figure-69.

[image: ] [image: ]

•Select required option from Library drop-down.

•Select required physical material from Library section of PHYSICAL MATERIAL dialog box.

•Now, drag the specific material from the Library section and drop it to the body or component. The physical material of body/component will be changed; refer to Figure-70.
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•After applying material, click on the Close button of PHYSICAL MATERIAL dialog box to apply changes.

Appearance

The Appearance tool is used to change the appearance of body. This tool is generally used to change the color of the body. The procedure to use this tool is discussed next.

•Click on the Appearance tool of MODIFY drop-down from Toolbar; refer to Figure-71. The APPEARANCE dialog box will be displayed; refer to Figure-72.
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•Select required radio button of Apply To section from APPEARANCE dialog box to select bodies/components or faces.

•Drag an appearance and drop it to the body or face; refer to Figure-73.
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•After applying the appearance, click on the Close button from APPEARANCE dialog box to finish the process.

Creating Volumetric Lattice

The Volumetric Lattice tool is used to create internal lattice structure within the boundary of selected body. This tool is useful for converting solid body into a 3D printable lattice which can reduce total material consumption. The procedure to use this tool is given next.

•Click on the Volumetric Lattice tool from the MODIFY panel in the SOLID tab of the Ribbon. The VOLUMETRIC LATTICE dialog box will be displayed; refer to Figure-74.
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•Select the body which you want to convert to volumetric lattice. Preview of lattice will be displayed; refer to Figure-75.
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•Select desired shape of lattice element from the Cell Shape drop-down; refer to Figure-76.
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•Select the Uniform option from the Proportions drop-down to set the size of cell length, width, and height equal. Specify the size value in the Size edit box. You can also set the size of cell using the scale handle displayed on model on selecting the Scale toggle button from dialog box; refer to Figure-77.
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•Select the Nonuniform option from the Proportions drop-down to specify different sizes of cell shapes in each direction. 

•Click on the Move/Rotate button from the Lattice Transform section of the dialog box and set desired parameters to reorient the lattice cells.

•Click on the Solidity tab to define the percentage of model which will be solid after applying lattice; refer to Figure-78.
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•Click on the Offset tab from the dialog box to set different solidity percentage for selected face; refer to Figure-79. Click on the Add Objects button from the dialog box and select face of model to which you want to apply different solidity; refer to Figure-80.
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•Set the parameters as discussed earlier and click on the OK button to create lattice.

Manage Materials

The Manage Materials tool is used to define the material properties shown in PHYSICAL MATERIAL and APPEARANCE dialog boxes discussed earlier. The procedure to use this tool is discussed next.

•Click on the Manage Materials tool of MODIFY drop-down from Toolbar; refer to Figure-81. The Material Browser dialog box will be displayed; refer to Figure-82.
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•Click on any material or appearance from list section to check or modify the property of selected material or appearance. 

•To edit properties of any material, select it from the list and then click on the Add to Favorites & Edit button at the bottom-right in the dialog box.

•Change the properties as required using the options displayed in the right area of Material Browser dialog box and click on the OK button to apply changes.

•Close the dialog box once changes have been applied. Next time, when you will be applying material, make sure to select them from favorites list. You will learn more about modifying material properties in Chapter 20.

Change Parameters

The Change Parameters tool is used to change the parameters and apply equations to the model. The procedure to use this tool is discussed next.

•Click on the Change Parameters tool of MODIFY drop-down from Toolbar; refer to Figure-83. The PARAMETERS dialog box will be displayed; refer to Figure-84.
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•If you want to create some parameters which are to be used later in equation then click on the + Add User Parameter button from the PARAMETERS dialog box. The Add User Parameter dialog box will be displayed; refer to Figure-85. 
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•Click in the Name edit box and specify the name of parameter.

•Click on the Unit drop-down and select desired unit of the parameter.

•Click on the Expression edit box and enter desired expression like d1/4. The Value will be displayed.

•Click in the Comment edit box and enter required comment.

•After specifying the parameters, click on the OK button from Add User Parameter dialog box. The user defined parameter will be added in Parameters dialog box; refer to Figure-86.
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•Click on the Model Parameters node from PARAMETERS dialog box, all the model features will be displayed.

•Click on desired model feature node to check its parameters, the parameters applied in that feature will be displayed; refer to Figure-87. 
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•If you want to apply equation in parameters then click on the dimension parameter and enter desired equation like d1*2; refer to Figure-88. Note that here d1 is dimension number applied automatically to the sketch dimension.
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•After specifying the parameters, click on the OK button from Parameters dialog box

•The equation specified in the Parameters dialog box will be applied to the model; refer to Figure-89.
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Click on the Compute All tool from the MODIFY drop-down to re-calculate all the parameters.

Practical 1

In this practical, you will create a model of hook as shown in Figure-90. The dimensions of the hook are given in Figure-91.
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Creating sketch for model

•Start a new sketch using Top Plane.

•Click on the Circle tool and create the circle of diameter 120 taking coordinate system as center.

•Draw a straight line starting from top quadrant point and having length of approximately 40.

•Draw a three point arc in the bottom area of the circle; refer to Figure-92. (It should look like the one given in figure. Accuracy is no required.)

•Click on the Trim Entities tool and trim the portion between the straight line and the arc; refer to Figure-93.
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•Click on the Fillet tool from MODIFY panel in Ribbon and apply a fillet of 20 radius at the intersection of line and circle; refer to Figure-94.

•Click on the Sketch Dimension tool from Ribbon and apply the dimensions as shown in Figure-95. Note that you can toggle the diameter dimension to radius dimension using shortcut menu.

•Click on the Finish Sketch button to exit the sketching environment.
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Creating Plane and Second Sketch

Earlier, the sketch was created for path of sweep feature and now we will create sketch for section.

•Toggle to Isometric view of model using ViewCube and click on the Offset Plane tool from CONSTRUCT drop-down in the Ribbon. The OFFSET PLANE dialog box will be displayed.

•Create a plane offset of XY plane and distance up to top point of sketch; refer to Figure-96.

•After setting parameters as shown in Figure-96, click on the OK button from the dialog box.
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•Select the new plane and click on the Create Sketch tool from Ribbon. The sketching environment will be activated.

•Create a circle of diameter 25 at the origin; refer to Figure-97 and click on the Finish Sketch tool from the Ribbon to exit sketching environment.
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Creating Sweep Feature

•Switch to Isometric view using ViewCube and click on the Sweep tool from CREATE drop-down in the Ribbon. The SWEEP dialog box will be displayed.

•Select profile, path, and other parameters as shown in Figure-98. Click on the OK button from the dialog box to create the feature.
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Applying Fillet

•Click on the Fillet tool from the MODIFY panel in the Ribbon. The FILLET dialog box will be displayed.

•Select the bottom edge of model and specify the fillet parameters as shown in Figure-99. Click on the OK button to create the feature. The final model will be displayed; refer to Figure-100.
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Note that we have used fillet and round interchangeably because software provides same tool for both features but the difference between two can be seen in Figure-101.
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Practical 2

Create the model of wing nut using drawing shown in Figure-102. Use the diameter value D as 8, 10, 12, and 14.
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Creating Taper Extrude Feature

•Start a new file in Autodesk Fusion and start a new sketch using Front plane (XY plane). 

•Create the sketch as shown in Figure-103 using Line tool. Click on the Finish Sketch tool from Ribbon after creating sketch.
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•Click on the Revolve tool from CREATE panel in the Ribbon and specify the parameters as shown in Figure-104. Click on the OK button from the REVOLVE dialog box to create the feature.
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Creating Wings

•Click on the Create Sketch tool from CREATE panel in the Ribbon and select the Front (XY) plane. The sketching environment will be activated.

•Create the sketch as shown in Figure-105. Click on the Finish Sketch tool from the Ribbon to exit sketching environment.
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•Extrude this new sketch to both sides symmetrically by total thickness of 2; refer to Figure-106. 
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•After creating wing of one side, create its mirror copy on other side of YZ plane; refer to Figure-107.
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•Click on the Thread tool from CREATE drop-down in the Ribbon and select internal face of nut to generate threads. Specify the parameters as shown in Figure-108 and click on the OK button create the model.
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Defining Dimension Relations

Every parameter given in drawing is related to inner diameter of the nut. So, we will not apply relations to other parameters with inner diameter as per the drawing.

•Click on the Change Parameters tool from the MODIFY drop-down in the Ribbon. The PARAMETERS dialog box will be displayed.

•Expand all the nodes in Model Parameters section. The dialog box should display as shown in Figure-109.
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•Note that in Sketch1, d3 is used to specify inner diameter of wing nut which drives all the other equations. If you are wondering how we know that, then this is hit and trial method until Autodesk updates the software to display dimension variables as well in sketch along with values. To find the diameter, we tried changing d5 and that caused increase in length of nut so there is only one 10 mm value dimension left which is diameter of nut. So, change the name of d3 variable to D and set the relations as shown in Figure-110.
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•Now, change the value of D in table to get desired size of nut. All the other dimensions will be modified as per relation and model will change accordingly in graphics area. Check what happens when you modify the diameter value in sketch and then exit the Sketching environment!!

Practice 1

Create the model of connecting rod as shown in Figure-111. The dimensions are given in Figure-112.
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Practice 2

Create a ring nut with value of D as 5,6,8, and 10 using equation and design table. Dimensions are given in Figure-113.

[image: ]

Self-Assessment

Q1. Which of the following tools can be used to dynamically use offset face or fillet function depending on the selection?

a. Fillet		b. Offset Face

c. Press Pull	d. Combine

Q2. Which of the following tool is used to apply round at the edges?

a. Fillet		b. Chamfer

c. Draft		d. Shell

Q3. Which of the following tool is used by casting mold designer to allow easy extraction of part from the die?

a. Fillet		b. Draft

c. Shell		d. Chamfer

Q4. Which of the following tool is used to create a body using intersection of two bodies?

a. Combine		b. Shell

c. Split Body	d. Split Face

Q5. The Move/Copy tool in Autodesk Fusion Design workspace can also be used to rotate the objects. (T/F)

Q6. What is the difference between applications of Physical Material tool and Appearance tool in Modify drop-down of Design workspace?

Q7. In Autodesk Fusion, you can create a fillet with changing radius at specified points. (T/F)

Q8. Which of the following tools is used to remove material from a solid body and convert it into a thin body of specified thickness?

 

a. Combine		b. Shell

c. Split Body	d. Split Face







Chapter  7

Assembly Design
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The major topics covered in this chapter are:

•Introduction

•New Component Tool

•Joint Tool

•As-Built Joint Tool

•Joint Origin Tool

•Rigid Group Tool

•Drive Joints Tool

•Motion Link Tool

•Enable Contact Sets Tool

•Motion Study Tool




Introduction

Most of the things you find around you in real-world are assembly of various components; the computer you are working on is an assembly, the automotive you may be driving or sitting in for travelling is an assembly, there are lots of examples. Till this point, we have learned to create solid parts. But most of the time, we need to assemble the parts to get some use of them. In this chapter, we will work on the assembly design of Autodesk Fusion in which we will be assembling two or more components using some assembly constraints.

New Component 

The New Component tool is used to create an empty component or components from the selected bodies. Note that we need to convert all parts to components before performing their assembly. The procedure to use this tool is discussed next.

•Click on the New Component tool of ASSEMBLE drop-down from Toolbar; refer to Figure-1. The NEW COMPONENT dialog box will be displayed; refer to Figure-2.
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•Select Standard option from Type drop-down in the dialog box, if you want to create a standard component in the assembly structure.

•Select Sheet Metal option from Type drop-down, if you want to create a sheet metal component in the assembly structure.

Standard Component

In this topic, we will discuss the procedure of creating standard component.

•Select Standard option from Type drop-down of NEW COMPONENT dialog box if not selected by default.

•Select External radio button from dialog box to create an external component and referenced into the assembly in the current design. The options related to External radio button will be displayed in the NEW COMPONENT dialog box; refer to Figure-3.
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•Click in the Name edit box of NEW COMPONENT dialog box and enter the name of component.

•Specify desired location where you want to save the new design that will contain the new component by clicking on the button from Location section of the dialog box.

•Click on Select button of Parent option and select the parent body under which new component will be created.

•Select the Activate check box from NEW COMPONENT dialog box to activate the new component. Note that all the modeling operations performed after activating the component will become child feature of that component.

•After specifying the parameters for standard component, click on the OK button from NEW COMPONENT dialog box. A standard component will be created; refer to Figure-4.
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•If you want to create an internal component directly in the current design then select Internal radio button from the dialog box. The options related to Internal radio button will be displayed in the NEW COMPONENT dialog box; refer to Figure-5 .
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•Select From Bodies check box from NEW COMPONENT dialog box to convert existing bodies into individual components. The updated NEW COMPONENT dialog box will be displayed; refer to Figure-6.
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•The Select button of Bodies section is active by default. Click on the parts/bodies from model to create a new component; refer to Figure-7. You can select multiple bodies by holding the CTRL key.
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•After selecting the body, click on the OK button from NEW COMPONENT dialog box. The new component will be created and action will be displayed in BROWSER.

Sheet Metal Component

In this topic, we will discuss the procedure of creating sheet metal component.

•Select the Sheet Metal option from Type drop-down of NEW COMPONENT dialog box. The NEW COMPONENT dialog box with sheet metal options will be displayed; refer to Figure-8.
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•Select desired sheet metal rule already in use in this design or from the Sheet Metal Rule drop-down in the dialog box.

•The other parameters in the NEW COMPONENT dialog box have been discussed earlier.

•After specifying parameters for sheet metal component, click on the OK button from NEW COMPONENT dialog box. A sheet metal component will be created; refer to Figure-9.

[image: ]

Joint 

The Joint tool is used to define joints between components to allow movement of components relative to each other. To apply Joint tool, you need to create the component of bodies. The procedure to use this tool is discussed next.

•Click on the Joint tool of ASSEMBLE drop-down from Toolbar; refer to Figure-10. The JOINT dialog box will be displayed; refer to Figure-11.
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•Select desired option from Origin Mode section of Component 1 area in the Position tab of the dialog box. Select Simple option from Origin Mode section to select a Snap point to place the joint origin. Select Between Two Faces option from Origin Mode section to select Plane 1 and Plane 2 to center the joint origin between them then select a Snap point. Select Two Edge Intersection option from Origin Mode section to select Edge 1 and a non-parallel Edge 2 to locate the joint origin at the extended intersection. 

•Select button of Snap section from Component 1 area is active by default. Click on the first component at desired location to assemble; refer to Figure-12. You will be asked to select a location on second component.
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•Select desired option from Origin Mode section of Component 2 area in the Position tab of the dialog box. The options of Origin Mode section have been discussed earlier.

•Click on the second component on mating location to select; refer to Figure-13.
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•On selecting the second component, the selected two component will be joined to each other at the locations selected on them and the updated JOINT dialog box will be displayed; refer to Figure-14.
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•Click in the Angle edit box from Alignment area in Position tab of the dialog box and specify the angle of rotation of component.

•If you want to specify offset distance between components then click in the Offset X , Offset Y, and Offset Z edit boxes as required and enter the value. You can also set the offset distance by moving the drag handles.

•Click on the Flip button from Alignment area of the dialog box, if you want to flip the direction of second component.

Motion

There are seven motion types in Motion tab of JOINT dialog box which we can apply to the component as required; refer to Figure-15. These motion types are described next.

[image: ]

Rigid Motion [image: ]

•Select the Rigid option from Type drop-down in the Motion tab of the JOINT dialog box, if you want the joint of two component to be rigid to each other and there should be no motion between the two joined component.

Revolute Motion [image: ]

•Select the Revolute option from Type drop-down in the Motion tab of the JOINT dialog box, if you want to revolve the component about other at the joint location. On selecting the Revolute option, a revolve drag handle will be displayed. You can revolve the component by moving the drag handle; refer to Figure-16.
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•Select Minimum and Maximum check box from Joint Motion Limits rollout to specify the minimum and maximum motion limit for the joint in the respective edit boxes. Select the Rest check box to specify the default position of the joint at rest in the respective edit box.

Slider Motion [image: ]

•Click on the Slider option from Type drop-down in the Motion tab of the JOINT dialog box, if you want to assemble the component in such a way that selected component can slide over the other; refer to Figure-17.
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Cylindrical Motion [image: ]

•Click on the Cylindrical option from Type drop-down in the Motion tab of the JOINT dialog box, if you want to assemble the component in such a way that it is free to move along the selected axis and free to rotate about the same selected axis; refer to Figure-18.
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Pin-Slot Motion [image: ]

•Click on the Pin-Slot option from Type drop-down in the Motion tab of JOINT dialog box, if you want to revolve and slide the component together like in nut & bolt locking-unlocking.

Planar Motion [image: ]

•Click on the Planar option from Type drop-down in the Motion tab of JOINT dialog box, if you want to assemble the component in such a way that the component can move over the selected plane only in defined boundary.

Ball Motion [image: ]

•Click on the Ball option from Type drop-down in the Motion tab of JOINT dialog box, if you want to assemble the component in such a way that the component is free to move 360 degree in 3D space pivoted to a point; refer to Figure-19.
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•Click on the Animate button from Motion tab of JOINT dialog box to watch the applied motion by animating Component 1. Click the button again to stop the animation.

After specifying the parameters for joint, click on the OK button from JOINT dialog box to complete the process.

Duplicate With Joints

The Duplicate With Joints tool duplicates components in an assembly and the joints attached to them in Fusion. The procedure to use this tool is discussed next.

•Click on the Duplicate With Joints of ASSEMBLE drop-down from Toolbar; refer to Figure-20. The DUPLICATE WITH JOINTS dialog box will be displayed; refer to Figure-21. 
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•Select desired component from the canvas, browser, or timeline to duplicate. The updated DUPLICATE WITH JOINTS dialog box will be displayed; refer to Figure-22.
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•Select desired option from Origin Mode section of the dialog box which have been discussed earlier.

•Select desired snap point in the component to place the joint origin.

•After specifying desired parameters, click on OK button from the dialog box. The joint will be duplicated; refer to Figure-23.
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As-Built Joint

The As-built Joint tool allows the joints to be applied to components in their current position as they are built, making it easy to join them in their original orientation. The procedure to use this tool is discussed next.

•Click on the As-built Joint tool of ASSEMBLE drop-down from Toolbar; refer to Figure-24. The AS-BUILT JOINT dialog box will be displayed; refer to Figure-25. 
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•Select the components from the canvas. 

•Select required motion from Type drop-down in Motion area of the dialog box. The updated AS-BUILT JOINT dialog box will be displayed; refer to Figure-26.
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•Select desired option from Origin Mode section of the dialog box which have been discussed earlier.

•Select desired references on the components based on the option selected in Type drop-down; refer to Figure-27.
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•Select desired option from Rotate drop-down to specify the axis for rotation of the component. 

•Click on the Preview Motion button from Joint Motion Limits area of the dialog box to watch the applied motion by animating the component. Click the button again to stop the animation.

•After specifying the parameters, click on the OK button from AS-BUILT JOINT dialog box to complete the process.

•If you want to rotate the component after creating joint then double-click on the flag displayed; refer to Figure-28.
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•The drag handle will be displayed. Rotate the component as required; refer to Figure-29.
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Joint Origin

The Joint Origin tool is used to define joint origin on a component. The procedure to use this tool is discussed next.

•Click on the Joint Origin tool of ASSEMBLE drop-down from Toolbar; refer to Figure-30. The JOINT ORIGIN dialog box will be displayed; refer to Figure-31.
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•Select Simple option from Origin Mode section of JOINT ORIGIN dialog box, if you want to place the joint origin on a face.

•Select Between Two Faces option from Origin Mode section of JOINT ORIGIN dialog box if you want to place the joint origin midway between the faces.

•In our case, we are selecting the Between Two Faces option from Origin Mode section. The updated JOINT ORIGIN dialog box will be displayed as shown in Figure-32.
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•The Select button of Plane 1 section is active by default. Click on the first face from model to select; refer to Figure-33. 
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•On selecting the first face, the Select button of Plane 2 section will be activated. Similarly, select the second face of the model; refer to Figure-34. The updated  JOINT ORIGIN dialog box will be displayed.
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•The Select button of Snap option is active by default. Click at desired location to define the snap point; refer to Figure-35.
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•On selecting the snap point, the JOINT ORIGIN dialog box will be updated; refer to Figure-36.
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•If you want to specify the angle of snap then click in the Angle edit box of JOINT ORIGIN dialog box and specify the angle of rotation of snap.

•If you want to specify the offset distance of snap then click on the Offset X edit box and enter the value. You can also set the offset distance by moving the drag handle.

•Similarly, set the offset distance in other edit boxes.

•Select the Flip button from JOINT ORIGIN dialog box if you want to flip the direction of snap. 

•Select the Reorient check box from JOINT ORIGIN dialog box, if you want to position the axes of origin of geometry.

•After specifying the parameters, click on the OK button from JOINT ORIGIN dialog box to complete the process.

•Now, you will be able to join the two component with the help of Joint tool using newly created joint origin; refer to Figure-37 and Figure-38.

[image: ]

[image: ]

Rigid Group

The Rigid Group tool is used to combine selected components into one group so that the created group act as one object. The procedure to use this tool is discussed next.

•Click on the Rigid Group tool of ASSEMBLE drop-down from Toolbar; refer to Figure-39. The RIGID GROUP dialog box will be displayed; refer to Figure-40.
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•The Select button of Components section is active by default. You need to select the components from the model to create a rigid group.

•Select the Include Child Components check box if you want to include the child components into the rigid group. 

•Click on OK button from RIGID GROUP dialog box to complete the process.

TANGENT RELATIONSHIP

The Tangent Relationship tool is used to create tangent relationship between face on a body in one component and a set of connected faces on body in another component within an assembly in Fusion. The procedure to use this tool is discussed next.

•Click on the Tangent Relationship tool of ASSEMBLE drop-down from Toolbar; refer to Figure-41. The TANGENT RELATIONSHIP dialog box will be displayed; refer to Figure-42.
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•The Component 1 selection button is active by default. Select a face on the body of first component; refer to Figure-43.
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•After selecting face on a body in the first component, select the face on a body in the second component as shown in Figure-44.
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•After selecting face on a body in the second component, click on the OK button from the dialog box. The tangent relationship will be applied between the components; refer to Figure-45.
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Drive Joints 

The Drive Joints tool is used to specify the rotation angle or distance value based on joint’s degrees of freedom. The procedure to use this tool is discussed next.

•Click on the Drive Joints tool of ASSEMBLE drop-down from Toolbar; refer to Figure-46. The DRIVE JOINTS dialog box will be displayed; refer to Figure-47.[image: ] [image: ]

•The Joint Input selection is active by default. Click on the joint from model. The updated DRIVE JOINTS dialog box will be displayed; refer to Figure-48.
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•Click in the Rotation edit box and specify the angle of rotation. You can also specify rotation limits by moving the drag handle; refer to Figure-49.
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•After specifying the parameters, click on the OK button from DRIVE JOINTS dialog box. 

Note that after changing position of joint after driving, the POSITION panel is displayed in the SOLID tab of Toolbar; refer to Figure-50. Select the Capture Position tool from the panel if you want to make current position of joint as new start position. Select the Revert Position option from the panel if you want to revert the joint to original position.
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Motion Link

The Motion Link tool is used to specify the relationship between motion of two selected joints like relation between two gear rotation or relation between bolt rotation and translation while fastening. The procedure to use this tool is discussed next.

•Click on the Motion Link tool of ASSEMBLE drop-down from Toolbar; refer to Figure-51. The MOTION LINK dialog box will be displayed; refer to Figure-52.
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•Joints selection is active by default. Click on desired joints. In our case, we are selecting the slider and revolve joints to create a motion of vice.

•On selecting the two joints, the animation of vice will start and the dialog box will be updated; refer to Figure-53.
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•Click in the Distance edit box of MOTION LINK dialog box and specify the value of distance per revolution.

•Click in the Angle edit box of MOTION LINK dialog box and specify the value of angle of revolution. The combination of distance and angle value define the range of motion like in our case, for one full rotation of 360 degree by handle, the jaw will move 10 mm of distance.

•Select the Reverse check box of MOTION LINK dialog box, if you want to reverse the direction of revolution.

•Click on the Animate button to watch the animation of joints.

•After specifying the parameters, click on OK button of MOTION LINK dialog box to complete the process; refer to Figure-54.
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Enable Contact Sets

The Enable Contact Sets tool is used to enable the physical contact conditions. The procedure to use this tool is discussed next. 

•Click on the Enable Contact Sets tool of ASSEMBLE drop-down from Toolbar; refer to Figure-55. The tool will be displayed in BROWSER; refer to Figure-56.
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•Click on All Bodies Contact button to activate the contact analysis between sets; refer to Figure-57.
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•Click on No Contact button to disable the contact between sets.

•In the above figure, the first case is with contact sets not active and the second case is with contact sets active. So, when contact set is active then physical properties of objects are taken into account like one solid object cannot pass through another solid object.

Enable All Contact

The Enable All Contact tool is used to enable all contacts which were applied earlier in the part or model.

•To enable contact, click on the Enable All Contact tool of ASSEMBLE drop-down from Toolbar. All contacts will be enabled and the ASSEMBLE drop-down will be updated with two new tools which are discussed next. 

Disable Contact

The Disable Contact tool is used to disable all contacts which were made earlier in the part or model. 

•To disable contact, click on the Disable Contact tool of ASSEMBLE drop-down from Toolbar. All contacts will be disabled.

New Contact Set

The New Contact Set tool is used to create new contact set between two selected components. This tool is available when Enable All Contact tool is selected. These contact sets prevent parts from passing through one another. The procedure to use this tool is discussed next.

•Click on the New Contact Set tool of ASSEMBLE drop-down from Toolbar; refer to Figure-58. The NEW CONTACT SET dialog box will be displayed; refer to Figure-59.
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•The Select button of Bodies or Components section is active by default. Select the two component or bodies to create sets and click on OK button from NEW CONTACT SET dialog box to complete the process.

Motion Study

The Motion Study tool is used to perform kinematic motion analysis based on joints. The procedure to use this tool is discussed next.

•Click on the Motion Study tool of ASSEMBLE drop-down from Toolbar; refer to Figure-60. The Motion Study dialog box will be displayed; refer to Figure-61.
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•You need to select the joint from part or model. Click to select the joint; refer to Figure-62.

[image: ]

•After selecting joint, create the points of motion curve as required by clicking in the graph line of motion; refer to Figure-63.
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•Click in the Angle edit box and specify required angle for animation point. Note that the options will be displayed based on selected joint.

•After creating the animation points, set the speed of animation from Speed bar.

•Select Play Once radio button from Mode section to play the animation once.

•Select Play Forward/Backward radio button from Mode section to play the animation forward and then backward.

•Select Play Loop radio button from Mode section to play the animation in cycle.

•After specifying the parameters for animation, click on Play button to check the animation of selected joint.

•Click on OK button from Motion Study dialog box to exit the motion study of components.

Arranging Components in Enclosures

The Arrange tool is used to arrange assembly components in a specified 2D or 3D enclosure utilizing the space optimally. The procedure to use this tool is given next.

•Click on the Arrange tool from the MODIFY drop-down in the SOLID tab of Toolbar. The ARRANGE dialog box will be displayed; refer to Figure-64 and you will be asked to select components for arranging.
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•Select all the components from BROWSER or graphics area to be arranged. 

Arranging in 2 Dimensions

•Select the 2D True Shape or 2D Rectangular option from the Solver Type drop-down to arrange components in 2D plane. Select the 2D True Shape option if your components are of irregular shape and can be densely packed. Select the 2D Rectangular option from the drop-down if your components are rectangular in shape.

•Select the Create Copies check box to create copies of the components to use for the arrangement.

•Select the Face Up button from Objects Selected by Face section if you want the selected faces of object to point upward when arranging them. Similarly, select the Face Down button if you want the faces of selected objects to be pointing downward when arranging them.

•Click on the Envelopes tab to define the boundaries for arranging components. The options will be displayed as shown in Figure-65 and you will be asked to select a plane/face/sketch for defining boundary of envelope.
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•If you have selected a sketch then components will be automatically arranged within sketch boundary and options will be displayed as shown in Figure-66.
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•Select Allow Partial Arrange check box if you want to arrange as many components as possible when there is not sufficient space in envelope. Clear this check box if you want to generate an error when there is no sufficient space for all the components in envelope.

•Specify desired value in Placement Clearance edit box to raise the components from sketch plane at respective height.

•Click on the Flip Envelope(s) button to reverse the arrangement between above and below plane.

•If you have activated the Nesting & Fabrication Extension then Multiple Envelopes and Grain Direction options will be available to you and the Envelopes tab should display as shown in Figure-67.

•Set desired value in the Grain Direction edit box to define angle for orienting components.

•After activating Multiple Envelopes extension, you can now select multiple faces as envelopes for arranging components.
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Arranging in 3 Dimensions

•After selecting components for arrangement, select the 3D Arrange option from the Solver Type drop-down in Objects tab of dialog box to arrange components in 3 dimensions.

•Click on the Envelopes tab from the dialog box. The options will be displayed as shown in Figure-68.
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•Select desired plane from graphics area and set desired parameters in the Length, Width, and Height edit boxes to define limits of 3D envelope. The components will be arranged automatically in 3 dimension; refer to Figure-69.
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•Enter desired value in the X Offset and Y Offset edit boxes to specify the distance between the envelope origin and the main origin along the x-axis and y-axis, respectively.

•In the Spacing section of dialog box, set desired parameters in edit boxes to define spacing of components with respect to frame, ceiling, and consecutive objects.

•After setting parameters, click on the OK button to generate the arrangement.

Automated Modeling

The Automated Modeling tool in AUTOMATE drop-down of Toolbar is used to automatically generate designs for an assembly part based on specified connecting faces and avoiding bodies. The tool generates freeform shapes that can be used as base reference for further designing the components. The procedure to use this tool is given next.

•Click on the Automated Modeling tool from the AUTOMATE drop-down in the Toolbar. The AUTOMATED MODELING dialog box will be displayed; refer to Figure-70 and you will be asked to select faces to be connected.
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•Select the faces to be connected by automated modeling and click on the Select button for Bodies to Avoid section. You will be asked to select the bodies to be avoided.

•Select desired bodies/components to be avoided; refer to Figure-71.
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•Select the Opacity check box to make the avoidance bodies transparent.

•Select the New Body option from the Operation drop-down if you want to create a new body by automated modeling. Select the New Component option from the drop-down if you want to create a new component using automated modeling.

•Click on the Generate Shapes button from the dialog box to generate the shapes. After calculation, preview of alternatives will be displayed; refer to Figure-72.
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•Select desired alternative and click on the OK button to create the model.

Practical 1

Assemble the parts of handle as shown in Figure-73. The exploded view of assembly is displayed as shown in Figure-74.
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All the part files can be downloaded from resource kit of Fusion software, which is available at WWW.CADCAMCAEWORKS.COM.

The steps to assemble these parts are given next.

Adding file into Fusion

•After downloading the resource kit from CADCAMCAEWORKS.COM, open the Chapter 7 folder.

•Double-click on Handle v0.f3d file. The file will open in Autodesk Fusion software; refer to Figure-75.
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Assembling components

•Click on New Component tool of ASSEMBLE drop-down from Toolbar; refer to Figure-76. The NEW COMPONENT dialog box will be displayed; refer to Figure-77.
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•Select the From Bodies check box from NEW COMPONENT dialog box and select all the bodies to make them component; refer to Figure-78.
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•After selecting the bodies, click on OK button from NEW COMPONENT dialog box. The components will be created and added in Timeline.

•Click on Joint tool of ASSEMBLE drop-down from Toolbar. You can also activate the Joint tool by pressing J key from keyboard. The JOINT dialog box will be displayed; refer to Figure-79.
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•The Select button of Snap section from Component 1 area in Position tab is selected by default. Click on the component to join; refer to Figure-80.
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•After selection of first component, select the second component; refer to Figure-81.
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•Select Rigid option from Type drop-down in Motion tab of the dialog box to create a rigid joint between two component.

•After specifying the parameters, click on OK button from JOINT dialog box to create a rigid joint.

•Similarly, create another rigid joint between other component.

•After joining these components, the assembly will be displayed as shown in Figure-82. 
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Practical 2

Assemble the parts of F1 brake balance shifting mechanism as shown in Figure-83. The exploded view of assembly is displayed as shown in Figure-84.
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The steps to assemble these parts are given next.

Adding file into Fusion

•After downloading the resource kit from CADCAMCAEWORKS.COM, open the Chapter 7 folder.

•Double-click on F1 brake balance shifting mechanism.f3d file. The file will open in Autodesk Fusion software; refer to Figure-85.
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Creating New Components

•Select New Component tool from ASSEMBLE drop-down. The NEW COMPONENT dialog box will be displayed.

•Select From Bodies check box in the dialog box. You are asked to select the bodies.

•The Select button of Bodies section is active by default. Select the bodies which you want to convert into components; refer to Figure-86.
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•Click on OK button from the dialog box to complete the process.

Assembling the Components

•Select Joint tool from ASSEMBLE drop-down. The JOINT dialog box will be displayed.

•Select Between Two Faces option from Origin Mode section of Component 1 area in Position tab of the dialog box. You are asked to select the first face.

•The Select button of Plane 1 section is active by default. Select first face of the component as shown in Figure-87. You are asked to select the second face.
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•The Select button of Plane 2 section will become active. Select second face of component as shown in Figure-87. You are asked to select a snap point.

•The Select button of Snap section will become active. Select the snap point on the component as shown in Figure-88.
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•Similarly, select Between Two Faces option from Origin Mode section of Component 2 area. You are asked to select first and second face of the component.

•Select first face of the component for Plane 1 selection and select second face of the component for Plane 2 selection as shown in the Figure-89. You are asked to select the snap point on the component.
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•The Select button of Snap section will become active. Select the snap point on the component as shown in Figure-90. The components will be joined together; refer to Figure-91.

[image: ]

[image: ]

•Select Revolute option from Type section in Motion tab of the JOINT dialog box. 

•After specifying parameters, click on the OK button from the dialog box to complete the process.

•Now, select Joint tool from ASSEMBLE drop-down. The JOINT dialog box will be displayed. You are asked to select the snap point on the components.

•Select snap point on both Component 1 and Component 2 as shown in Figure-92.
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•On selecting the snap point on second component, both the components will be joined; refer to Figure-93.
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•Select Rigid option from Type section in Motion tab of the dialog box.

•After specifying parameters, click on the OK button from the dialog box to complete the process.

•Now, select Joint tool again from ASSEMBLE drop-down. The Joint dialog box will be displayed. You are asked to select the snap points on the components.

•Select snap point on both Component 1 and Component 2 as shown in Figure-94.
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•On selecting the snap point on second component, both the components will be joined; refer to Figure-95.
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•Select Revolute option from Type section in Motion tab of the dialog box.

•After specifying the parameters, click on OK button from the dialog box to complete the process.

•Now, select the Joint tool from ASSEMBLE drop-down. The JOINT dialog box will be displayed. You are asked to select the snap point on the components.

•Select snap point on both Component 1 and Component 2 as shown in Figure-96.
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•On selecting the snap point on second component, both the components will be joined; refer to Figure-97.
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•Select Rigid option from Type section in Motion tab of the dialog box.

•After specifying the parameters, click on OK button from the dialog box to complete the process.

•Click on Joint tool again from ASSEMBLE drop-down. The JOINT dialog box will be displayed. You are asked to select the snap point on the components.

•Select snap point on both Component 1 and Component 2 as shown in Figure-98.
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•On selecting snap point on second component, both the components will be joined; refer to Figure-99.
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•Select Slider option from Type section in Motion tab of the dialog box.

•After specifying the parameters, click on OK button from the dialog box to complete the process.

Copying the Components

•Select the components to be copied while holding the CTRL key from BROWSER as shown in Figure-100. Right-click on any of the selected components, a shortcut menu will be displayed. Select Copy option from the shortcut menu.

[image: ]

•Right-click in the empty area of the screen, a Marking Menu will be displayed. Select Paste option from the Marking Menu. The MOVE/COPY dialog box will be displayed along with the drag handle; refer to Figure-101.
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•Drag the copied components with the help of drag handle. The copied components will be displayed; refer to Figure-102.
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•Click on OK button from MOVE/COPY dialog box to complete the process.

Assembling the Copied Components

•Select Joint tool from ASSEMBLE drop-down. The JOINT dialog box will be displayed and you will be asked to select snap point on components.

•Select snap point on both the Component 1 and Component 2 as shown in Figure-103.
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•On selecting snap point of second component, both the components will be joined.

•Select Revolute option from Type section in Motion tab of the dialog box.

•After specifying the parameters, click on OK button from the dialog box to complete the process. The final assembly of components will be displayed; refer to Figure-104. 
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Self Assessment

Q1. The .............. tool is used to create a standard component or sheet metal component from the selected bodies. 

Q2. Which of the following tool is used to define motion type of a component in an assembly?

a. New Component		b. Joint

c. Rigid Group			d. Drive Joints

Q3. Which of the following motion type is not available to apply joints in assembly of Autodesk Fusion?

a. Slider				b. Cylindrical

c. Pin-slot				d. Symmetry

Q4. Which of the following tools is used to combine multiple components to act as a single component?

a. New Component		b. Joint

c. Rigid Group			d. Drive Joints

Q5. Which of the following tools is used to define relation between motion of two components of assembly?

a. Motion Link			b. Joint

c. Rigid Group			d. Drive Joints

Practice 1

Assemble the parts of motor assembly as shown in Figure-105 and Figure-106. The exploded view of assembly is shown in Figure-107. Note that you can open this practice file from the resource kit downloaded for this book.
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Practice 2

Assemble the parts of crank assembly as shown in Figure-108. The exploded view in which you will get the model is shown in Figure-109.
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Chapter  8

Importing Files and Inspection
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The major topics covered in this chapter are:
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Introduction

In the previous chapter, we have learned about the procedure of creating and assembling component. Till now, we have worked on the components that are/have been created in Autodesk Fusion. Now, you will learn to insert external model objects like canvas, decal, dxf, and manufacturer parts. In this chapter, you will learn the procedures of inspecting the part and importing files in Autodesk Fusion software.

Inserting File

In this section, you will learn the procedure to insert various types of files in Autodesk Fusion.

Insert Derive

The Insert Derive tool is used to insert components, sketches, parameters, or bodies from another design file into the current model file. Note that before using this tool, you need to save the current model file. The procedure to use this tool is discussed next.

•Click on the Insert Derive tool of INSERT drop-down from Toolbar; refer to Figure-1. The Select Source dialog box will be displayed; refer to Figure-2.
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•Select desired source component and click on the Select button from Select Source dialog box. The selected component will be inserted in the canvas along with the DERIVE dialog box; refer to Figure-3.
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•The Select button of Model Objects section is active by default. Click on the inserted component to select the model. The updated DERIVE dialog box will be displayed; refer to Figure-4. You can select the sketch and other objects from BROWSER.
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•Select the Place Objects At Origin check box to place the component origin aligned to model origin.

•Expand the Parameters node and select desired check boxes to include parameters in desired part.

•After specifying all the parameters, click on OK button from the DERIVE dialog box to complete the process.

Decal

The Decal tool is used to place an image on the selected face/plane. The procedure to use this tool is discussed next.

•Click on the Decal tool of INSERT drop-down from Toolbar; refer to Figure-5. The Insert dialog box will be displayed; refer to Figure-6.
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•Select required image from Insert dialog box and click on Insert button from the dialog box. The image will be inserted or click on Insert from my computer button from Insert dialog box. The Open dialog box will be displayed; refer to Figure-7.
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•Select desired image which you want to import and click on Open button from Open dialog box. The DECAL dialog box will be displayed with the image inserted; refer to Figure-8.
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•The Select button of Face section is active by default. Click on the face of model to which decal is to be applied. The updated DECAL dialog box will be displayed; refer to Figure-9.

[image: ]

•Set the image on the selected face with the help of drag handle displayed on image. You can also set the image by specifying the values in respective edit boxes in the dialog box.

•Click on the Horizontal Flip button to flip the image horizontally.

•Click on the Vertical Flip button to flip the image vertically.

•Select the Chain Faces check box to include tangent faces in selection.

•After specifying the parameters, the preview of model along with image will be displayed; refer to Figure-10.
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If the preview is as desired then click on the OK button from the DECAL dialog box to complete the process. 

Canvas

The Canvas tool is used to insert an image on a planer face so that you can create model based on image. The procedure to use this tool is discussed next.

•Click on the Canvas tool of INSERT drop-down from Toolbar; refer to Figure-11. The Insert dialog box will be displayed.
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•Select desired image from the dialog box and import as discussed earlier. The CANVAS dialog box will be displayed with the image inserted; refer to Figure-12.
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•The Select button of Face section is active by default. Click on the face of model/plane where you want to place the canvas image. The updated CANVAS dialog box will be displayed; refer to Figure-13.
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•Click on Canvas opacity edit box and specify the opacity of image. You can also set the opacity by moving the Canvas opacity slider. 

•Select the Display Through check box if you want to make the image visible through the component.

•Select the Selectable check box if you want the image to be selectable.

•Select the Renderable check box if you want to include the image in renderings of model.

•Click in the X Distance edit box and specify a value of distance to move in X direction.

•Click in the Y Distance edit box and specify a value of distance to move in Y direction

•Click in the Z Angle edit box and specify a value to rotation around z axis.

•Click in the Scale X edit box and specify a scale value in X direction.

•Click in the Scale Y edit box and specify a scale value in Y direction.

•Click in the Scale Plane XY edit box and specify the value of scale in the XY plane.

•Click on the Horizontal Flip button to mirror the image horizontally.

•Click on the Vertical Flip button to mirror the image vertically.

•After specifying the parameters, click on the OK button from CANVAS dialog box to complete the process.

Insert SVG

The Insert SVG tool is used to insert an SVG image file into sketch. The procedure to use this tool is discussed next.

•Click on the Insert SVG tool of INSERT drop-down from Toolbar; refer to Figure-14. The Insert dialog box will be displayed.
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•Select desired file from the dialog box and insert the file as discussed earlier. The INSERT SVG dialog box will be displayed with the file selected; refer to Figure-15. 
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•The Select button of Sketch plane section is active by default. You need to select the plane for adding SVG file. Click on the plane to select; refer to Figure-16.
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•On selecting the face or plane, the sketching environment will be enabled with updated INSERT SVG dialog box; refer to Figure-17.
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•Click in the X Distance edit box and specify a value of distance to move in X direction.

•Click in the Y Distance edit box and specify a value of distance to move in Y direction.

•Click in the Z Angle edit box and specify a value to rotation around z axis.

•Click in the Scale Plane XY edit box and specify the value of scale in the XY plane.

•Click on the Horizontal Flip button to mirror the image horizontally.

•Click on the Vertical Flip button to mirror the image vertically.

•You can also use the drag handle to move or flip the model.

•After specifying the parameters, click on the OK button from INSERT SVG dialog box to complete the process.

Insert DXF

The Insert DXF tool is used to insert a DXF file into the active design. The procedure to use this tool is discussed next.

•Click on the Insert DXF tool of INSERT drop-down from Toolbar; refer to Figure-18. The INSERT DXF dialog box will be displayed; refer to Figure-19.
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•The Select button of Plane/Sketch section is active by default. Click on the plane to select.

•Click on Select DXF File button from INSERT DXF dialog box. The Open dialog box will be displayed.

•You need to select the file of .dxf format and click on Open button. The preview of DXF file will be displayed along with updated INSERT DXF dialog box; refer to Figure-20.
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•Click on the Units drop-down and select required unit.

•Select Single Sketch option from Insert Mode drop-down to insert the layers of selected .DXF file into one sketch.

•Select One Sketch per Layer option from Insert Mode drop-down to insert each sketch of DXF file on different layer. 

•Click in the X Distance edit box and specify a value of distance to move in X direction.

•Click in the Y Distance edit box and specify a value of distance to move in Y direction.

•Select the DXF Layers check box to list the layers available in the selected DXF file. Select the layers to import.

•After specifying the parameters, click on the OK button from INSERT DXF dialog box to complete the process.

Insert McMaster-Carr Component

The Insert McMaster-Carr Component tool is used to insert 2D or 3D model of various library components provided by McMaster-Carr. The procedure to use this tool is given next.

•Click on the Insert McMaster-Carr Component tool from the INSERT drop-down in the Toolbar; refer to Figure-21. The INSERT MCMASTER-CARR COMPONENT window will be displayed; refer to Figure-22.
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•Select desired component and its model number from the window. The page in window will be displayed as shown in Figure-23.
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•Click on the Product Detail link button for selected component. The drawing and model of selected component will be displayed at the bottom in the window; refer to Figure-24.
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•Select desired format from drop-down above the drawing and click on the Save button to save the model in local drive.

•Close the window by selecting Close button.

Insert Mesh

The Insert Mesh tool is used to insert a mesh file in current model. The procedure to use this tool is discussed next.

•Click on the Insert Mesh tool of INSERT drop-down from Toolbar; refer to Figure-25. The Open dialog box will be displayed; refer to Figure-26.
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•Select the file and click on Open button of Open dialog box. The file will be added in application window along with INSERT MESH dialog box; refer to Figure-27.
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•Click on the Unit Type drop-down from INSERT MESH dialog box and select required unit to scale the model.

•Click on the Flip Up Direction button to flip the direction of model.

•Click on the Center button from Position section to drag the model to center or coordinate system.

•Click on Move To Ground button from Position section to move the model to ground plane.

•If you want to enter the numerical value to move the model then click on the Numerical Inputs section and enter desired value. You can also move and rotate the model by using drag handles.

•Click on Reset button from Numerical Inputs section to reset the model position to the original state.

•After specifying the parameters, click on the OK button from INSERT MESH dialog box to complete the process.

Insert a manufacturer part

The Insert a manufacturer part tool is used for inserting a part of manufacturer or supplier in model through parts4cad. The procedure to use this tool is discussed next.

•Click on the Insert a manufacturer part tool of INSERT drop-down from Toolbar; refer to Figure-28. The Part Community web page will be displayed in default web browser; refer to Figure-29.
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•Select the part from manufacturer or supplier and open the file in Autodesk Fusion.

Insert TraceParts Supplier Components

The Insert TraceParts Supplier Components tool gives you access to millions of supplier components, 3D models, CAD files, and 2D drawings. Simply navigate to what you are looking for, sign-in with your TraceParts account, download, and insert a supplier component directly into Fusion canvas. The procedure to use this tool is discussed next.

•Click on the Insert TraceParts Supplier Components tool of INSERT drop-down from Toolbar; refer to Figure-30. The AUTODESK Fusion 360 DESIGN LIBRARY window will be displayed; refer to Figure-31.
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•Select the part from supplier and open the file in Autodesk Fusion.

Inspect

Till now, we have discussed various tools to insert the objects in Autodesk Fusion. Now, we will discuss about measurement and analysis tools available in Autodesk Fusion.

Measure

The Measure tool is used to measure selected geometry. The procedure to use this tool is discussed next.

•Click on the Measure tool of INSPECT drop-down from Toolbar; refer to Figure-32. The MEASURE dialog box will be displayed; refer to Figure-33.
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•Select the Select Face/Edge/Vertex button from Selection Filter section if you want to select face/edge/vertex for measurement.

•Select the Select Body button from Selection Filter section if you want to select body for measurement.

•Select the Select Component button from Selection Filter section if you want to select component for measurement.

•Click on the Precision drop-down and select desired precision option for displaying the required number of decimal places in results.

•Select desired secondary unit for the measurement from Secondary Units drop-down if you want to display secondary unit as well.

•Click on the Clear Selection button to restart the selection process once you have performed measurement.

•In our case, we are selecting Select Face/Edge/Vertex button from Selection Filter section. Click on the face to measure; refer Figure-34.

[image: ]

•On selecting the face, the updated MEASURE dialog box will be displayed with the measurement of selected face; refer to Figure-35.
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•If you want to measure the distance between two faces then select the other face.

•Hover the cursor on the respective measurement to copy the value to clipboard; refer to Figure-36.
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•Select the Show Snap Points check box to display snap points when you hover over your model with the Measure tool activated.

•Click on Close button of MEASURE dialog box to exit the Measure tool.

Interference

The Interference tool is used to display interference of selected components or bodies. The procedure to use this tool is discussed next.

•Click on the Interference tool of INSPECT drop-down from Toolbar; refer to Figure-37. The INTERFERENCE dialog box will be displayed; refer to Figure-38.
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•The Select button of Select section is active by default. Click on the model to check interference. You can also use window selection.

•Select the Include Coincident Faces check box if you want to include the faces in selection which are touching with each other.

•In our case, we are using window selection to select the component; refer to Figure-39.
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•After selecting the components, click on Compute button to calculate the interference. The Interference Results dialog box will be displayed; refer to Figure-40.
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•Click on the OK button from Interference Results dialog box to exit the Interference tool.

Curvature Comb Analysis

The Curvature Comb Analysis tool is used to display a curvature comb on the spline or circular edges to determine the change in curvature. The procedure to use this tool is discussed next.

•Click on the Curvature Comb Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-41. The CURVATURE COMB ANALYSIS dialog box will be displayed; refer to Figure-42.
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•Edges selection of CURVATURE COMB ANALYSIS dialog box is active by default. Click on the geometry to select the edge. The preview of comb on edge will be displayed; refer to Figure-43.
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•Click in the Density edit box and specify the value. You can also set the comb density by moving the Density slider.

•Click in the Scale edit box and specify the value. You can also set the comb scale by moving the Scale slider.

•After analyzing, click on OK button from CURVATURE COMB ANALYSIS dialog box to exit the tool.

Zebra Analysis

The Zebra Analysis tool is used to analyze continuity between the surfaces of component by displaying  stripes on model. The procedure to use this tool is discussed next.

•Click on the Zebra Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-44. The ZEBRA ANALYSIS dialog box will be displayed; refer to Figure-45.
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•The Select button of Bodies section is active by default. Click to select the body for analysis.

•On selecting the body, preview of zebra stripes will be displayed; refer to Figure-46.
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•Select Vertical option from Direction section for display of vertical lines on model.

•Select Horizontal option from Direction section for display of horizontal lines on model.

•Set the number of stripes for model from Repeats slider.

•Click on the Opacity edit box and enter the value for opacity. You can also set the value of opacity by moving the Opacity slider.

•Select the Lock Stripes check box of ZEBRA ANALYSIS dialog box to freeze the stripes on body.

•Select the High Quality check box of ZEBRA ANALYSIS dialog box to increase the display quality of stripes.

•After specifying the parameters, click on OK button from ZEBRA ANALYSIS dialog box. The stripes will be displayed on model; refer to Figure-47. 
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Draft Analysis

The Draft Analysis tool is used to display a color gradient on the selected body to evaluate draft angle of various faces of the part. The procedure to use this tool is discussed next.

•Click on the Draft Analysis tool of INSPECT drop-down from Toolbar; refer to  Figure-48. The DRAFT ANALYSIS dialog box will be displayed; refer to Figure-49.
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•The Select button of Body section is active by default. Click on the body to perform analysis.

•Click on Select button of Direction section and select the direction for analysis. On selection, the preview will be displayed; refer to Figure-50.
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•Click in Draft Angle edit boxes and specify the range of draft angle for which you want to perform analysis. You can also set the draft angle limits by moving the Draft angle slider.

•Select the ToleranceZone check box if you want to display a tolerance gradient on the results.

•Click on the Tolerance edit box and specify the start and stop angles tolerance. You can also set the tolerance angle by moving the slider.

•Click on the Opacity edit box and enter the value for opacity for draft colors. You can also set the value of opacity by moving the Opacity slider.

•Select the High Quality check box of DRAFT ANALYSIS dialog box to increase the display quality of gradient.

•After specifying the parameters for analysis, click on OK button from DRAFT ANALYSIS dialog box to complete the analysis.

Curvature Map Analysis

The Curvature Map Analysis tool is used to displays a color gradient on the faces of selected bodies to evaluate the amount of curvature. The procedure to use this tool is discussed next.

•Click on the Curvature Map Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-51. The CURVATURE MAP ANALYSIS dialog box will be displayed; refer to Figure-52.

[image: ] [image: ]

•The Select button of Bodies section is active by default. Click on the body to select for analysis.

•Select Gaussian option from Type section if you want to display the gradient as the product of curvature in the U direction and curvature in the V direction.

•Select Principal Minimum option from Type section if you want to display the gradient highlighting areas of lowest curvature.

•Select Principal Maximum option from Type section if you want to display the gradient highlighting areas with the highest curvature.

•Select Smooth option from Display section if you want to display a blend of two colors.

•Select Bands option from Display section if you want to display no transition between colors.

•Click in the Scale edit box of CURVATURE MAP ANALYSIS dialog box and enter the value. You can also set the value of scale by moving the Scale slider.

•Click on the Opacity edit box and enter the value for opacity. You can also set the value of opacity by moving the Opacity slider.

•Select the High Quality check box of CURVATURE MAP ANALYSIS dialog box to increase the display quality of gradient.

•After specifying the parameters for analysis, click on OK button from CURVATURE MAP ANALYSIS dialog box to exit this analysis; refer to Figure-53.	

[image: ]

Isocurve Analysis

The Isocurve Analysis tool is used to analyze the quality of the curvature of a surface by applying UV mapping and curvature combs in Fusion. The procedure to use this tool is discussed next.

•Click on the Isocurve Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-54. The ISOCURVE ANALYSIS dialog box will be displayed; refer to Figure-55.
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•The Bodies/Faces selection button is active by default. Select the body or face which you want to analyze; refer to Figure-56.
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•Select desired isocurve type from Type section of the dialog box. Select the U and V option to display isocurves in U and V directions. Select the U option to display isocurves in the U direction. Select the V option to display isocurves in the V direction.

•Specify number of isocurves to display on selected bodies or faces in the Isocurves edit box. You can also set the number of isocurves by moving the Isocurves slider.

•Select Curvature Combs check box to display curvature combs on isocurves.

•Specify number of teeth to display on curvature combs in the Density edit box. You can also set the number of teeth by moving the Density slider.

•Specify scale of curvature combs in the Scale edit box. You can also set the value of scale by moving the Scale slider.

•After specifying desired parameters for analysis, click on the OK button from the dialog box to exit the analysis; refer to Figure-57.
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Accessibility Analysis

The Accessibility Analysis tool is used to determine whether the area of the model is accessible or inaccessible through selected view of the plane. This analysis is used to perform undercut analysis. The procedure to use this tool is discussed next.

•Click on the Accessibility Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-58. The ACCESSIBILITY ANALYSIS dialog box will be displayed; refer to Figure-59.
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•The Select button of Body section is active by default. Click on the face of the body to select; refer to Figure-60. You will be asked to select a direction.
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•Click on the Select button of Direction section and select the edge, plane, or axis of the model to indicate the direction of analysis. The preview of the accessible areas will be displayed along with updated ACCESSIBILITY ANALYSIS dialog box; refer to Figure-61.
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•On selecting the direction, the areas that are accessible from selected direction are shaded in green and the areas that are inaccessible are shaded in red.

•Select desired option from Change Direction section to change the direction of analysis.

•You can also set the opacity by sliding the slider button or edit the opacity in edit box of Opacity section.

•The visibility of this analysis can be controlled by expanding the Analysis folder in the BROWSER and clicking on the eye button to view or hide the analysis; refer to Figure-62.
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•After specifying the parameters for analysis, click on OK button from ACCESSIBILITY ANALYSIS dialog box to exit this analysis.

Minimum Radius Analysis

The Minimum Radius Analysis tool is used to highlight the areas of the model which are at or below the minimum radius. It also detects the minimum fit for fillets and holes. The procedure to use this tool is discussed next.

•Click on the Minimum Radius Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-63. The MINIMUM RADIUS ANALYSIS dialog box will be displayed; refer to Figure-64.
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•The Select button of Body section is active by default. Click on the body to be selected; refer to Figure-65.
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•After selecting the body, set the Maximum Tool Radius in the edit box for analysis of the model. For tool of Minimum Radius 8, the sections that can be machined are highlighted in green whereas sections with cannot be machined by 8 mm radius tool will be highlighted in red; refer to Figure-66.  
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•Note that software automatically calculates the optimum minimum radius of tool which can machine most of the sections of model in Optimal Minimum Radius field of the dialog box which is 7.8003 mm in our case; refer to Figure-66. 

•Set the opacity of the analysis as you did in the Accessibility Analysis tool.

•Select the Sharp Edges check box to display sharp edges of the model.

•After specifying all the parameters, click on the OK button of MINIMUM RADIUS ANALYSIS dialog box to exit this analysis.

•The visibility of this analysis can be control by expanding the Analysis folder in the BROWSER and clicking on the eye button to view or hide the analysis; refer to Figure-67.
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Section Analysis

The Section Analysis tool is used to cut the model at selected plane reference and check the temporary view. The procedure to use this tool is discussed next.

•Click on the Section Analysis tool of INSPECT drop-down from Toolbar; refer to Figure-68. The SECTION ANALYSIS dialog box will be displayed; refer to Figure-69.
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•The Select button of Cut Plane section is active by default. Click on the face to select.

•On selection of face, the dialog box will be updated along with the preview of model; refer to Figure-70.
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•Click in the Distance edit box and specify the location of the section plane along y direction. You can also set the value by moving the drag handle.

•Click in the Angle 1 edit box and specify the angle of plane about x direction. You can also set the value by moving the drag handle.

•Click in the Angle 2 edit box and specify the angle of plane about y direction. You can also set the value by moving the drag handle.

•Click on the Flip button to reverse the section side of plane.

•Select From Component option from Section Color drop-down if you want to use the same color as applied to the model. 

•Select Custom option from Section Color drop-down if you want to use the custom color for the section.

•Select the Show Hatching check box if you want to show hatching on the section.

•After specifying the parameters for analysis, click on OK button from SECTION ANALYSIS dialog box to complete the analysis.

Center of Mass

The Center of Mass tool is a center point of body used for representing the mean position of matter in a body. The procedure to use this tool is discussed next.

•Click on the Center of Mass tool of INSPECT drop-down from Toolbar; refer to Figure-71. The CENTER OF MASS dialog box will be displayed; refer to Figure-72.
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•You need to select the body and click on OK button from CENTER OF MASS dialog box. The center of mass of the body will be displayed; refer to Figure-73.
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Plastic Injection Molding Design Advice

The Design Advice tool is used to analyze the part and check its manufacturability using plastic injection modeling process. The procedure to use this tool is given next.

•Open part for which you want to check plastic injection molding recommendations and click on the Design Advice tool from the INSPECT drop-down of PLASTIC tab in the Toolbar. The DESIGN ADVICE dialog box will be displayed; refer to Figure-74.
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•Select the solid body to be manufactured by injection molding. You will be asked to assign plastic rules if not applied earlier. Assign the rules as discussed earlier.

•Click on the Select button for Pull Direction and select reference to be used for defining direction of core/cavity pull.

•Click on the Flip Pull Direction button to reverse direction of pulling mold plate.

•Select check boxes from the Summary section of dialog box and define properties of model to be analyzed for molding; refer to Figure-75.
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•After setting desired parameters, click on the Analyze button. The results of analysis will be displayed; refer to Figure-76. Modify the part as per the analysis results and if there are green tick marks for all the parameters then your part is good to go for manufacturing.
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Displaying Component Colors

The Display Component Colors tool is used to toggle coloring of various objects in Autodesk Fusion. You can also press SHIFT+N to do the same thing.

Similarly, the Display Mesh Face Groups tool is used to display mesh face groups with different colors. 

Self Assessment

Q1. Which of the following tools is used for inserting image on the face of a model?

a) Insert Mesh

b) Insert Derive

c) Decal

d) Insert SVG

Q2. What is the use of Reset Transformation button in INSERT MESH dialog box?

Q3. What is the use of Insert Mc-Master Carr Component tool and what is Mc-Master Carr?

Q4. Write the procedure of inserting manufacturer or supplier part in the model.

Q5. Write the procedure to measure the distance between two faces.

Q6. Write the procedure to find interference between two components.

Q7. The Curvature Comb Analysis tool is used to display a curvature comb on the spline or circular edges to determine the ............................... .

Q8. The Zebra Analysis tool is used to analyze continuity between the surfaces of component by ........................on model.

Q9. Write the procedure to display zebra stripes on body.

10. The Draft Analysis tool is used to display a color gradient on the selected body to

........................... of various faces of the part.

11. The .................. tool is used to displays a color gradient on the faces of selected bodies to evaluate the amount of curvature.

12. What is the use of Gaussian option in Curvature Map Analysis?

13. The Section Analysis tool is used to define the view of component from ................... side.

14. Which of the following analyses uses ToleranceZone option to display a tolerance gradient on the results?

a) Section Analysis

b) Zebra Analysis

c) Curvature Comb Analysis

d) Draft Analysis

Q15. The ............ tool is used to analyze the quality of the curvature of a surface by applying UV mapping and curvature combs in Fusion.







Chapter  10

Rendering and Animation
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The major topics covered in this chapter are:
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Introduction

When a designer is working on a 3D Model, the model he/she creates is generally a mathematical representation of points and surfaces in three-dimensions. Sometimes, a realistic 2D image of 3D model is required for presentation to the client. The conversion of 3D model with specified environmental scenario through mathematical approximation to a finalized 2D image is known as Rendering. During this process, the entire scene’s textural and lighting information are combined to determine the color value of each pixel in the finalized image. To perform rendering, select the RENDER option from the Change Workspace drop-down in the Ribbon. 

Introduction to Render Workspace

The tools in Render Workspace are used to create photo-realistic image from a scene of model. There are various tools used for rendering process which are discussed next.

Appearance Tool

The Appearance tool is used to apply different materials to selected bodies/components/faces. The procedure to use this tool has been discussed earlier in the book. So, we are not repeating the tool here.

Scene Settings

The Scene Settings tool is used to control the lighting, background color, ground effects, and camera rendering. The procedure to use this tool is discussed next.

•Click on the Scene Settings tool of SETUP panel from Toolbar; refer to Figure-1. The SCENE SETTINGS dialog box will be displayed; refer to Figure-2.

[image: ] [image: ]

Environment section

•Click on the Brightness edit box and specify the value of brightness for model. You can also move the Brightness slider to adjust the brightness for the model. 

•If you want to control the position and rotation of lights then click on the Position button of Environment section from Settings tab. The drag handle along with some tools will be displayed on the canvas screen; refer to Figure-3.
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•Click in the floating window and specify the position of lights. You can also set the position by moving the drag handle from model.

•Click in the Rotation edit box and specify the value of rotation of lights. You can also adjust the value by moving the Rotation slider.

•If you want to reset all the changed settings, then click on the Reset button from rotation tools.

•Select Environment option from Background drop-down if you want to use environment image. The environments are available in Environment Library tab of this dialog box.

•Select Solid Color option from Background drop-down if you want to set a particular color to the background. 

•To select a solid color, click on the Color button. A color box will be displayed; refer to Figure-4.
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•Select required color from color box and click on the Apply button to set the selected color as background color.

Ground section

•Select the Ground Plane check box of Ground section from Settings tab if you want to display the shadow and reflection of model on the ground canvas.

•Select the Flatten Ground check box of Ground section from Settings tab if you want to enable a “textured” ground plane where the environment image is mapped as a texture.

•Select the Reflections check box of Ground section from Settings tab if you want to display the reflection of model on the ground.

•Click in the Roughness edit box and specify the value of sharpness of reflection. You can also set the sharpness of reflection by moving the Roughness slider.

Camera section

•Select the Orthographic option of Camera drop-down from Camera section if you want to set the orthographic view of model.

•Select the Perspective option of Camera drop-down from Camera section if you want to set the perspective view of model.

•Select the Perspective with Ortho Faces option from Camera drop-down if you want to set the perspective view of model with ortho faces.

•Click in the Exposure edit box of Camera section from Settings tab and enter the value of camera exposure. You can also set the camera exposure by moving the Exposure slider.

•Select the Depth of Field check box if you want to apply depth of field effect. Depth of field is used to focus on specific area of the model. This effect is only enabled when Ray Tracing is enabled. On selecting the Depth of Field check box, the dialog box will be updated; refer to Figure-5.	
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•The Center of Focus selection button is active by default. You need to select a location on model for focusing.

•Click in the Blur edit box and enter the value of blur the model except the selected center of focus. You can also set the value of blur by moving the Blur slider.

•Click on the Aspect Ratio drop-down and select required aspect ratio of canvas screen. 

•Click on Save as Defaults button to save the setting as default setting.

•Click on the Restore Defaults button to restore the changed settings to default.

Environment Library tab

•Click on the Environment Library tab from the SCENE SETTINGS dialog box. The tab will be displayed; refer to Figure-6.
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•The Current Environment section shows the applied environment on the current model.

•If you want to change the environment of the model then drag a specific environment from Library section and drop it to the current model or in the Current Environment section. You can download the environments in library by using the Download button next to them in the list.

•If you want to apply custom environment for model then click on the Attach Custom Environment button of Environment Library tab from SCENE SETTINGS dialog box. The Attach Custom Environment dialog box will be displayed; refer to Figure-7. 
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•Select desired custom environment from the dialog box or click on the Select from my computer button. The Open dialog box will be displayed; refer to Figure-8.
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•Select required file and click on Open button. The environment will be applied to model.

•After selecting required environment from Environment Library tab, click on Close button to exit the Scene Settings tool.

Note- There is no Timeline in the Render workspace. The tools applied in the RENDER workspace will not be recorded.

Decal tool has been discussed earlier in the book.

Texture Map Controls

The Texture Map Controls tool is used to set the orientation of the texture applied to the face or model. The procedure to use this tool is discussed next.

•Click on the Texture Map Controls tool of SETUP panel from Toolbar; refer to Figure-9. The TEXTURE MAP CONTROLS dialog box will be displayed; refer to Figure-10.
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•The Select button of Selection option is selected by default. You need to select the texture of model. The updated TEXTURE MAP CONTROLS dialog box will be displayed; refer to Figure-11.
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Automatic

•Select the Automatic option from Projection Type drop-down if you want to adjust the texture on the model using model topology. 

Planar

•Select the Planar option from Projection Type drop-down if you want to map the image or texture on the model as projection.

•On selecting the Planar option, you need to select the axis for adjusting the texture. On selecting the texture, the dialog box will be updated; refer to Figure-12.
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•Adjust the image or texture by using the manipulator or by specifying the values in related edit boxes in TEXTURE MAP CONTROLS dialog box.

•After adjusting the texture, click on the OK button from TEXTURE MAP CONTROLS dialog box.

Box

•Click on the Box option from Projection Type drop-down if you want to map the image on model into box like objects.

•On selecting the Box option, the manipulator and updated dialog box will be displayed; refer to Figure-13. 
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•Click in the specific edit box and enter desired value. You can also set the value by moving the arrow of manipulator.

•If you want to reset the values of Mapping Transform or manipulator then click on the Reset Transform button.

Spherical 

•Select the Spherical option from Projection Type drop-down if you want to map texture into a spherical object. 

•On selecting the Spherical option, the manipulator along with updated dialog box will be displayed. 

•The options were discussed in last topic.

Cylindrical

•Select the Cylindrical option from Projection Type drop-down if you want to map texture into a cylindrical object.

•On selecting the Cylindrical option, the manipulator along with updated dialog box will be displayed. 

•The options were discussed in last topic. After specifying the parameters, click on the OK button from TEXTURE MAP CONTROLS dialog box to exit the tool.

In-canvas Render

The In-canvas Render button is used to start and stop the In-canvas rendering process. The procedure to use this tool is discussed next.

•Click on the In-canvas Render button from IN-CANVAS RENDER drop-down; refer to Figure-14. The render quality slider will be displayed to display at the bottom right area of canvas screen; refer to Figure-15.
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•The current scene of the model will be changed into the photo-realistic 2D image.

•Clicking again on the In-canvas Render Stop button will stops the rendering process.

In-Canvas Render Setting

The In-canvas Render Setting tool is used to change the setting of rendering process. The procedure to use this tool is discussed next.

•Click on the In-Canvas Render Settings tool from IN-CANVAS RENDER drop-down; refer to Figure-16. The IN-CANVAS RENDER SETTINGS dialog box will be displayed; refer to Figure-17.
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•Set the quality of rendering by adjusting the Limit Resolution to slider. The higher quality rendering takes more time to calculate rendering process and lower quality rendering takes less time to calculate the rendering process.

•Select the Lock View check box to lock the current view of model for rendering. If this check box is selected then you can not reorient the model during rendering process.

•After specifying the parameters, click on the OK button from IN-CANVAS RENDER SETTINGS dialog box.

Capture Image

The Capture Image tool is used to capture the current canvas as an image. The procedure to use this tool is discussed next.

•Click on the Capture Image tool of IN-CANVAS RENDER drop-down in Toolbar; refer to  Figure-18. The Image Options dialog box will be displayed; refer to Figure-19. 

[image: ]

[image: ]

•Click on the Image Resolution drop-down and select required resolution of image.

•Select the Transparent Background check box if you want to set the transparent background of model.

•Select the Enable Anti-aliasing check box if you want to activate the anti-aliasing property.

•After specifying the parameters, click on the OK button from Image Options dialog box. The Save As dialog box will be displayed; refer to Figure-20.
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•Click in the Name edit box of Save As dialog box and enter the specific name for image.

•Click on the Type drop-down and select required format of image file.

•Click on the Location drop-down button and select the location of saving image.

•Select the Save to my computer check box if you want to save the file to computer.

•Select the Save to a project in the cloud check box to save the image file on cloud.

•After specifying the parameters for image, click on the Save button from Save As dialog box. The image will be saved to the specified location.

Render

The Render tool is used to create a high quality rendered image of the current scene. The procedure to use this tool is discussed next.

•Click on the Render tool from Toolbar; refer to Figure-21. The RENDER SETTINGS dialog box will be displayed; refer to Figure-22. 
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WEB

•Click on the WEB tab of RENDER SETTINGS dialog box. Various options under WEB tab will be displayed; refer to Figure-23.
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•Three highlighted options are the size of image in which your rendered file will be saved. Click on required size.

•Click on the Cloud Renderer option from RENDER WITH section, if you want to render the file from Autodesk cloud. On selecting the Cloud Renderer button, the dialog box will be updated; refer to Figure-24.
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•With Local Renderer option selected, click on the Advanced settings toggle button from WEB tab to manually set the render quality value. The RENDER QUALITY slider will be displayed; refer to Figure-25.
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•Set the value of quality from slider as required. If you want to automatically set the quality of render then again click on the Advanced settings toggle button. The Standard(50) and Final(75) option will be displayed.

•Click on required option from RENDER QUALITY section and click on the Render button from WEB tab. The rendering process will start.

•The completed rendered file will be saved in RENDERING GALLERY; refer to Figure-26.
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Render Gallery

•To view the enlarged size of rendered image, click on that particular image. The image will be displayed in RENDERING GALLERY dialog box; refer to Figure-27.
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•If you want to create a video of the rotating model then click on the Turntable button from RENDERING GALLERY dialog box. The Render Settings - Turntable dialog box will be displayed; refer to Figure-28.
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•Specify desired parameters and click on the Render button. The file will be re-created and displayed in RENDERING GALLERY.

Post Processing

•If you want to adjust the exposure of model then click on the Post-processing button. The Post-processing dialog box will be displayed; refer to Figure-29.
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•The value of exposure can be adjusted by using the slider for Exposure Value.

•Select desired option from the Preset drop-down. The options in the dialog box will be automatically adjusted presentation settings for rendering.

•Similarly, you can set the other parameters in the dialog box. After setting the parameters, click on the Apply button.

Downloading Render Image File

•If you want to download the current file then click on the Download button from RENDERING GALLERY dialog box. The drop-down will be displayed as shown in Figure-30.
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•Select the Transparent Background toggle button if you want to make background of model transparent. On selecting this toggle button, you will be able to save the image file in PNG or TIFF format only.

•Select desired Download image as... button. The Save File dialog box will be displayed; refer to Figure-31.
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•Select the location for saving file and click on the Save button from the dialog box to save the file.

•If you want to delete the current file from RENDERING GALLERY then click on the Delete button from RENDERING GALLERY dialog box. The Delete Image dialog box will be displayed; refer to Figure-32.
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•If you are sure about deleting the particular file then click on the Delete button from Delete Image dialog box otherwise click on Cancel button.

•If you want to share the image to Fusion Gallery or A360 then click on the Share images button at the top right in RENDERING GALLERY dialog box and select the respective option.

•If you want to see the information of the current file then click on the Info button from RENDERING GALLERY dialog box.

•If you want to zoom-in/zoom-out the rendered image then click on the Zoom button from the dialog box.

•After rendering the file, click on the Close button from RENDERING GALLERY dialog box to exit the rendering process.

Render in KeyShot

The Render in KeyShot tool is used to transfer the current scene to KeyShot if the software is installed in your system and you have installed related KeyShot Autodesk® Fusion 360® Plugin from Fusion App Store; refer to Figure-33. Note that after installing the plug-in, you need to restart the Fusion software. The procedure to use this tool is discussed next.
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•Click on the Render in KeyShot tool from Render drop-down in the Toolbar; refer to Figure-34. The Please Register KeyShot 2023 dialog box will be displayed; refer to Figure-35.
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•Select Activate my license radio button and click on the Next button. The Activate License page of the dialog box will be displayed; refer to Figure-36.
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•Select desired license type from the page and click on the Next button. The Sign in page of KeyShot Cloud account will be displayed to activate the license.

•Select Start a Trial radio button to start the trial version of KeyShot. Once you have activated license, click on the Render in Keyshot tool again. The model in Fusion will be transferred to Keyshot for rendering; refer to Figure-37.
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Export to KeyShot .bip

The Export to KeyShot .bip tool is used to export the current scene to a KeyShot .bip file. The procedure to use this tool is discussed next.

•Click on the Export to KeyShot .bip tool from Render drop-down in the Toolbar; refer to Figure-38. The Save As dialog box will be displayed; refer to Figure-39.
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•Specify desired file name in the File name edit box and specify desired location in the dialog box.

•Click on Save button from the dialog box to save the file.

Animation

The Animation workspace is used to animate the joints of assembly. This workspace is also used to create exploded view of assembly. You can create the exploded view automatically as well as manually in this workspace. To activate the workspace, click on the ANIMATION option from the Workspace drop-down. The tools to perform animation will be displayed. 

New Storyboard

A storyboard is automatically generated for each model when you switch to ANIMATION workspace. In the process of creating animation, additional storyboard can be added at any time as well. Each new storyboard has a default name “Storyboardx” where x is a number. You can edit this name by double-clicking on it at the bottom in application window. Storyboard acts as base for animation. To create different animations of same assembly, you can create different storyboards. The procedure to create new storyboard is discussed next.

•Click on the New Storyboard tool from STORYBOARD drop-down of Toolbar in ANIMATION workspace; refer to Figure-40. The NEW STORYBOARD dialog box will be displayed; refer to Figure-41.
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•Select the Clean option from Storyboard Type drop-down if you want to delete all previous actions of animation and want to create a new storyboard.

•Select the Start from end of previous option from Storyboard Type drop-down if you want to use position of components at the end of previous animation as the starting position for the new animation.

•After setting desired options, click on the OK button from the dialog box. The created storyboard will be added at the bottom of ANIMATION TIMELINE; refer to Figure-42.
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Transform Components 

The Transform Components tool is used to move and rotate the component. Note that the movement and rotation performed in this workspace will be recorded in animation. The procedure to use this tool is discussed next.

•Click on the Transform Components tool of TRANSFORM drop-down; refer to Figure-43. The TRANSFORM COMPONENTS dialog box will be displayed; refer to Figure-44.
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•The Select button of Components section is active by default. Click on the component that you want to move or rotate. On selection of component, a manipulator will be displayed on the selected component along with updated TRANSFORM COMPONENTS dialog box; refer to Figure-45.
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•The actions like moving or rotating the components are registered as animation in storyboard. To register the movement, drag the playhead in ANIMATION TIMELINE area to time value upto which the selected transformation operation will be completed. For example, if you want to move the component shown in figure by 60 mm in 2 seconds then first move the playhead of timeline to 2 seconds and then move the component by 60 mm; refer to Figure-46.
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•You can specify desired values for movement in the TRANSFORM COMPONENTS dialog box or you can set the parameters by moving the manipulator. 

•After specifying the parameters, click on the OK button from TRANSFORM COMPONENTS dialog box to add the action in animation timeline. 

•To play the animation, you need to click on the Play button from ANIMATION TIMELINE.

Restore Home

The Restore Home tool is used to restore the model position as it is at the end of animation. 

•Click on the Restore Home tool from TRANSFORM drop-down; refer to Figure-47. The position of model will be restored.
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Auto Explode: One Level

The Auto Explode: One Level tool is used to automatically separate all selected components down to one level in hierarchy. The procedure to use this tool is discussed next.

•Select the parts of assembly to be exploded (separated from each other) while holding the CTRL key. You can also select all components using window selection; refer to Figure-48.
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•Click on the Auto Explode: One Level tool from TRANSFORM drop-down; refer to Figure-49. The components will be separated on the canvas screen; refer to Figure-50. 
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•By moving the highlighted slider (Explosion Scale), you can set the distance between component. 

•After adjusting the space between components, click on the OK button from slider.

Auto Explode: All Levels

The Auto Explode: All Levels tool is used to automatically separate all selected components down to all levels in component hierarchy (including sub-assemblies). The procedure to use this tool is discussed next.

•Select the parts of components to separate by holding the CTRL key. You can also select the components using window selection. 

•Click on the Auto Explode: All Levels tool from TRANSFORM drop-down; refer to Figure-51. The components of selected model will be separated.

[image: ]

•Click on the screen to view the separated component properly; refer to Figure-52.
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•Move the slider to adjust the distance between separated components of model. 

•After adjusting the components, click on the [image: ] OK button. The exploded view of assembly will be displayed; refer to Figure-53.
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Manual Explode

The Manual Explode tool is used to manually separate the selected component. The procedure to use this tool is discussed next.

•Click on the Manual Explode tool of TRANSFORM drop-down from Toolbar; refer to Figure-54.
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•You are asked to select the components to be moved during exploding. Click on the component to separate; refer to Figure-55.
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•On selecting a component, number of arrows will be displayed on the selected component. You need to click on the arrow of direction in which you want to move the selected component.

•Move the Explosion Scale slider to separate the selected component from remaining model; refer to Figure-56.
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Show/Hide

The Show/Hide tool is used to show or hide the selected component. The procedure to use this tool is discussed next.

•Click on desired component from model to show or hide.

•Now, click on the Show/Hide tool from TRANSFORM drop-down; refer to Figure-57. The selected component will be shown or hidden based on its condition.
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•To display the hidden component, click on the crossed eye button from Browser; refer to Figure-58.
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Create Callout

The Create Callout tool is used to add annotation to the animation. The procedure to use this tool is discussed next.

•Click on the Create Callout tool from ANNOTATION panel; refer to Figure-59. The callout symbol will be attached to the cursor.
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•Click on the component to add the callout. A text box will be displayed; refer to Figure-60. 
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•Type desired text in the text box and click on OK button. The annotation callout will be added to the selected component.

View

The View tool is used to start and stop the recording of the actions or commands occurring on the model or component. When View tool is activated then it captures the actions like move for animation and when the View tool is deactivated it does not record the process; refer to Figure-61.
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Publish Video

The Publish Video tool is used to publish the video. The procedure to use this tool is discussed next.

•Click on the Publish Video tool from the PUBLISH panel in the Toolbar; refer to Figure-62. The Video Options dialog box will be displayed; refer to Figure-63.
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•Select Current Storyboard option from Video Scope section if you want to create a video of current storyboard animation only.

•Select All Storyboards option from Video Scope section if you want to create a video of all storyboard animations combined.

•Click on the Current Document Window Size drop-down from Video Resolution section or select required video resolution.

•After specifying the parameters, click on the OK button from Video Options dialog box. The Save As dialog box will be displayed; refer to Figure-64. 
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•Click in the Name edit box and specify the name of file.

•Select the Save to a project in the cloud check box if you want to save the file online or in your Autodesk account.

•Select the Save to my computer check box if you want to save the file in your computer.

•After specifying the parameters, click on the Save button from Save As dialog box. The Publish Video progress dialog box will be displayed which tells about the progress of publishing video; refer to Figure-65.
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The video will be published online and saved to the computer at preferred location.

Self Assessment

Q1. What is Rendering?

Q2. The ................ is used to create the photo-realistic image from a scene of model.

Q3. The ................... tool is used to control the lighting, background color, ground effects, and camera rendering.

Q4. From where can you get the environments for background as well as for model?

Q5. How can you display the shadow and reflections of model on ground canvas?

Q6. A textured ground plane where the environment image is mapped as a texture can be enabled by selecting Ground Plane check box. (T/F)

Q7. The reflection of model on the ground can be displayed by selecting the Reflections check box. (T/F)

Q8. What is Depth of Field and how it can be enabled?

Q9. If you want to change the environment of the model then drag a specific environment from ................. section and drop it to the current model or in the Current Environment section.

Q10. The Appearance tool is used to set the orientation of the texture applied to the face or model. (T/F)

Q11. What is the use of Reset Transform button in Box dialog box?

Q12. What happens when In-canvas Render button is selected?

Q13. What is the use of Animation Workspace?

Q14. Which tool is used to add annotation to the animation?







Chapter  11

Drawing
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The major topics covered in this chapter are:
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Introduction

Drawing is the engineering representation of a model on the paper. For manufacturing a model in the real world, we need some means by which we can tell the manufacturer what to manufacture. For this purpose, we create drawings from the models. These drawings have information like dimensions, material, tolerances, objective, precautions, and so on. 

Starting Drawing Workspace

In Autodesk Fusion, we create drawings in the DRAWING workspace. The procedure to open a file in DRAWING workspace is discussed next.

•Open desired model from Data Panel or saved directory.

•Click on From Design option from DRAWING cascading menu in Change Workspace drop-down. The CREATE DRAWING dialog box will be displayed along with the model; refer to Figure-1.
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•Select Automatic radio button to set automatic mode of creating drawing from design. Selecting this radio button will automatically generate standard views and design dimensions. Note that you can still modify the drawing later.

•Select Manual radio button to manually insert views and dimension in the drawing based on design.

•Select the Full Assembly option from Contents drop-down of Reference area in the dialog box if you want to create drawing using whole assembly. Select the Visible Only option from Contents drop-down to automatically select only visible components of assembly. Select the Select option from Contents drop-down to manually select components in the canvas or browser.

•Click on the Standard drop-down from CREATE DRAWING dialog box and select the standard for the drawing. ASME option can use the third angle projection as well as first angle projection but ISO option uses first angle projection for placing views. There are also many other differences between two standards which you can find better in relevant books. Note that these projections are default settings but you can override them using Preferences dialog box.

•Click on the Units drop-down from CREATE DRAWING dialog box and select the unit for drawing.

•Click on the Sheet Size drop-down from CREATE DRAWING dialog box and select the size of sheet for drawing. Note that there is difference between A (8.5x11) and A (11x8.5) sheet size. The size A (8.5x11) will generate Portrait sheet whereas size A(11x8.5) will generate Landscape sheet.

•If Automatic radio button is selected, select desired sheet creation settings from Structure drop-down.

•After specifying the parameters, click on the OK button from CREATE DRAWING dialog box. The DRAWING workspace will be activated along with DRAWING VIEW dialog box in a new drawing file; refer to Figure-2.
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•The model will be attached to the cursor. Click on the drawing sheet to place the base view.

Parameters in DRAWING VIEW dialog box

•Click on the Orientation drop-down and select the base view of model. Here, Front view is default option. When you change the view from Front to Top, the view of model will automatically changed.

•Select the style of model from the Style section.

•Click in the Scale drop-down and select required scaling factor for model.

•Select required option from Tangent Edges section to apply the edges with the selected view.

•Select the Interference Edges check box if you want to keep interfering edges within the selected view. Interfering edges are overlapping edges from two features of the model.

•Select the Thread Edges check box if you want to display the threads of model in current view.

•After specifying the parameters in DRAWING VIEW dialog box, click on OK button. The selected view of model will be placed; refer to Figure-3.
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Specifying Drawing Preferences

•Click on the Preferences option from the Autodesk Account drop-down. The Preferences dialog box will be displayed.

•Select the Drawing option from the General node at the left in the dialog box. The options will be displayed as shown in Figure-4. 

[image: ]

•Select desired option from the Standard drop-down to define which standard to use for drafting. You can select ASME or ISO option from the drop-down to set it default for drafting or you can select the Inherit From Design to define the standard by 3D Model.

•Select desired unit of length from the Units drop-down. You can select inch or mm as unit.

•Select desired default size of sheet from the Sheet Size drop-down.

•Select the Override or Restore Format Defaults Below check box if you want to use parameters different from selected standard. The options below this check box will be activated; refer to Figure-5.
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•Select Include Mesh Bodies check box to include mesh in drawings.

•Select Include Surface Bodies check box to include surface in drawings.

•Select desired option from the Projection Angle drop-down to define the view projection method for drawing.

•Select desired value for height of annotations in Text Height Group drop-down.

•Select desired font from Font drop-down to define font of all the annotations in drawing area.

•Select desired precision level for linear and angular dimensions in the Linear Dimension Precision and Angular Dimension Precision drop-downs, respectively.

•Select the Display Dimension Units check box to display unit of annotation in drawing.

•Select the Display Trailing Zeros check box to display zeros after decimal places if the dimension is not up to specified precision level.

•Select the Display Leading Zeros check box if you want to display zeros before the dimension values in the annotations.

•Select desired value for line width for drawings in Line Width Group drop-down.  

•Select the Display Line Widths check box if you want to display lines in drawing by their specified widths rather than using same width for all lines.

•Click on the OK button from the Preferences dialog box.

Creating Base View

The Base View tool is used to create base view derived directly from a 3D model. You can create various views of your model using this view. Note that you should have only one base view and other views should be projection of that view. The procedure to use this tool is discussed next.

•Click on the Base View tool from CREATE panel; refer to Figure-6. The DRAWING VIEW dialog box will be displayed.
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•Click at desired location to place the view and specify desired parameters in the dialog box. The options of DRAWING VIEW dialog box have been discussed earlier.

•Click on the OK button from the dialog box to generate the view.

Creating Projected View

The Projected View tool is used to create drawing views generated from an existing base or drawing view. The procedure to use this tool is discussed next.

•Click on the Projected View tool from CREATE panel in the Toolbar; refer to Figure-7. The tool will be activated.
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•Click on the pre-existing base view from drawing sheet to select the view as parent view; refer to Figure-8. The projected view will be attached to the cursor; refer to Figure-9.
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•Place the projected views of model at desired locations and press ENTER. The projected view(s) are created on drawing sheet; refer to Figure-10.
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Creating Auxiliary View

The Auxiliary View tool is used to create a projected view using view point normal to selected edge. The procedure to use this tool is given next.

•Click on the Auxiliary View tool from the CREATE drop-down in the Toolbar. You will be asked to select the edge for generating auxiliary view.

•Select desired edge from the model. The auxiliary view will get attached to cursor; refer to Figure-11.
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•Click at desired location in the drawing area to place the view and set the parameters in AUXILIARY VIEW dialog box as discussed earlier.

•Click on the OK button from dialog box to create the view.

Creating Section View

The Section View tool is used to create full, half, offset, or aligned section views. The procedure to use this tool is discussed next.

•Click on the Section View tool from CREATE panel; refer to Figure-12. The tool will be activated.
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•Click on the projected or base view from drawing sheet to be used for section view. The DRAWING VIEW dialog box will be displayed.

•You need to divide the selected parent view into two parts to create half section; refer to Figure-13.  
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•Click on the parent view to specify the start point and end point. You can create different shape of section line to create desired type of section. Note that you can use snap point in right-click shortcut menu to select points for section line; refer to Figure-14. After specifying the start point, intermediate points, and end point, click on ENTER key. The section view will be created and attached to the cursor; refer to Figure-15.
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•Place the section view at desired location/side of base model and click on OK button from DRAWING VIEW dialog box. The section view will be created on drawing sheet; refer to Figure-16. Note that arrows of section view will be modified automatically based on placement location of section view.
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•Note that the hatching is created automatically in the section view. To edit hatching, double-click on it. The HATCH dialog box will be displayed. Specify desired values and click on the Close button.

•If you want to edit the section annotation then double-click on it. The TEXT dialog box will be displayed; refer to Figure-17.  
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•Click on the Font drop-down and select required font from the list.

•Click in the Height edit box and specify the height of text and select the writing style of text from TEXT dialog box.

•Click on the Select Color button of Color section to specify desired color of the text.

•Click on desired text alignment from Justification section.

•If you want to insert any special symbol then click on it from Symbols section of the dialog box.

•After specifying the parameters for the text, click in the text box from drawing sheet and enter required text.

•Click on the Close button from TEXT dialog box to complete the process. The text will be modified according to parameters specified.

Creating Detail View

The Detail View tool is used to create detail view from any projected or base view. The procedure to use this tool is discussed next.

•Click on the Detail View tool of CREATE panel; refer to Figure-18. The tool will be activated and you will be asked to select a view whose selected section is to be included in detail view.
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•Select desired view from drawing sheet; refer to Figure-19. The DRAWING VIEW dialog box will be displayed. 
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•Click at desired location to specify the center point for boundaries of detail view; refer to Figure-20. 
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•Create the boundary on parent view as required; refer to Figure-21.
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•On creating the circular boundary, the detail view of model will be attached to the cursor; refer to Figure-22. Place it as desired.
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•After placing the view, set the parameters of detail view in DRAWING VIEW dialog box and click on OK button. The detailed view will be created; refer to Figure-23.
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CREATING BREAK VIEW

The Break View tool is used to shorten an existing drawing view by removing a portion of the design and indicating the missing section in the drawing. Broken view is generally created to place long views. The procedure to use this tool is discussed next.

•Click on the Break View tool from CREATE panel; refer to Figure-24. The BREAK VIEW dialog box will be displayed and you will be asked to select the drawing view to be broken; refer to Figure-25.

[image: ] [image: ]

•The Select button of Drawing View section is active by default. Select desired view from drawing sheet which you want to break; refer to Figure-26. You will be asked to select break position.
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•Select the start point of break position using the Start Point selection button; refer to Figure-27. You will be asked to select end point of break position.
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•Move the cursor away and click at desired location to specify end position of break position in the End Point selection button; refer to Figure-28.
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•Specify desired value in Gap edit box of the dialog box to specify distance for the gap between the two sections.

•After specifying parameters for break view, click on the OK button from the dialog box. The broken view will be created; refer to Figure-29.
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Breakout Section View

The Breakout Section View tool is used to remove a defined area of object to expose inner features in an existing drawing view. The procedure to use this tool is discussed next.

•Click on the Breakout Section View tool from CREATE panel in the Toolbar; refer to Figure-30. The BREAKOUT SECTION VIEW dialog box will be displayed; refer to Figure-31.
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•The Select button of View section is active by default. Select desired view from drawing sheet in which you want to display breakout; refer to Figure-32. The Cut Profile selection will become active and you will be asked to specify the start point.
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•Click in the view at desired location to specify start point of the section. You will be asked to specify the next point.

•Move the cursor away and click at desired locations to specify next consecutive point(s).

•After specifying desired points, press Enter. The breakout section view will be created and other sections of the dialog box will be activated; refer to Figure-33.
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•The Distance section displays the half of the design’s depth by default. You can specify desired depth value in the edit box at which section will be created.

•Click on the Measure Half Length button to go back to the default depth distance.

•Clear check boxes for components from Objects To Cut section of the dialog box to exclude them from creating breakout section view.

•After specifying desired parameters, click on the OK button from the dialog box.

CREATING SKETCH

The Create Sketch tool is used to the sketch mode and create a new sketch on the current sheet. The procedure to use this tool is discussed next. 

•Click on the Create Sketch tool from CREATE panel in the Toolbar; refer to Figure-34. The SKETCH contextual tab will be displayed along with SKETCH dialog box; refer to Figure-35.
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•Select desired option from Linetype drop-down of Properties area in the dialog box to change the linetype of new or selected sketch geometry.

•Select desired option from Line Width drop-down of Properties area in the dialog box to change the line width of new or selected sketch geometry.

•Select Show Sheet Contents check box from Options area to show the contents of the sheet as you edit the sketch.

•Select Show Layout Grid check box from Options area to show the layout grid in the canvas as you edit the sketch.

•Select Snap to Grid check box from Options area to snap to the layout grid in the canvas as you edit the sketch.

•After specifying parameters in the SKETCH dialog box, create desired sketch from SKETCH tab in the Toolbar.

•After creating the sketch, click on Finish Sketch button from Toolbar or from the dialog box to exit the tab.

Moving Views

The Move tool is used to move selected view from one place to another. The procedure to use this tool is discussed next.

•Click on the Move tool from MODIFY drop-down; refer to Figure-36. The MOVE dialog box will be displayed; refer to Figure-37.
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•The Select button of Selection section in MOVE dialog box is active by default. Click on the view to select the view to be moved. The updated MOVE dialog box will be displayed; refer to Figure-38.
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•Click on Transform button from MOVE dialog box and select a base point from the selected view. The selected view will get attached to the cursor to move the view from one place to another; refer to Figure-39.
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•Click on the sheet to place the view. The view will be moved from previous position to new position.

•Click on the OK button from MOVE dialog box to complete the process.

Rotating Views

The Rotate tool is used to rotate selected view as desired. The procedure to use this tool is discussed next.

•Click on the Rotate tool from MODIFY panel; refer to Figure-40. The ROTATE dialog box will be displayed; refer to Figure-41.
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•The Select button of Selection section in ROTATE dialog box is active by default. Click on the view to be rotated.

•Click on Transform button from ROTATE dialog box and select the base point from selected view. The view will be attached to the cursor; refer to Figure-42.
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•You can adjust the angle of rotation of view by moving the cursor around parent view and place as required. If you want to specify the value of rotation then click in the Angle edit box of ROTATE dialog box and specify the value.

•You can also set the reference for rotation by clicking on Select button of Reference section and selecting the reference point from parent view.

•After specifying the parameters, click on OK button from ROTATE dialog box to complete the process.

Creating Centerline

The Centerline tool is used to create centerline. The procedure to use this tool is discussed next.

•Click on the Centerline tool from GEOMETRY panel; refer to Figure-43. The tool will be activated.
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•You need to select parallel edges from a view to create a center line. Click on the desired edge to select; refer to Figure-44. You will be asked to select the second edge.
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•On selecting second edge, the center line will be created.

Creating Center Mark

The Center Mark tool is used to create center mark for rounds and circles. The procedure to use this tool is discussed next.

•Click on the Center Mark tool from GEOMETRY panel; refer to Figure-45. The tool will be activated. You need to select a round edge from any view.

•On selecting the edge, the center mark will be created for selected round edge; refer to Figure-46.
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Creating Center Mark Pattern

The Center Mark Pattern tool is used to generate pattern of center marks in the drawing view. The procedure to use this tool is given next.

•Click on the Center Mark Pattern tool from the GEOMETRY panel of Toolbar; refer to Figure-47. The CENTER MARK PATTERN dialog box will be displayed; refer to Figure-48. You will be asked to select a hole or round edge whose center mark is to be created.
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•Click on desired holes one by one. If the holes are in circular pattern then the dialog box will be displayed as shown in Figure-49. Select the Center Mark check box to generate center mark for pitch circle. Click on the OK button to generate center marks.

[image: ]

•In cases where you want to specify the PCD reference manually, click on the Reference Edge selection button after selecting holes and then select the reference edge; refer to Figure-50.
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•In case of selecting holes in linear direction, you can select maximum 3 holes for center mark.

Edge Extension

The Edge Extension tool is used to create an extension of associative edge for two intersecting (unequal) edges within an existing drawing view. The procedure to use this tool is discussed next.

•Click on the Edge Extension tool from GEOMETRY panel; refer to Figure-51. The tool will be activated.
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•You need to select the two non-parallel (going to intersect) edges to create the extension. Click on the edge to select; refer to Figure-52.
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•On selecting the second edge, the extended edge will be displayed; refer to Figure-53.
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Dimensioning

The Dimension tool is used to apply dimension to model. The procedure to use this tool is discussed next.

•Click on the Dimension tool from DIMENSIONS panel; refer to Figure-54. The tool will be activated.
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•When you hover the cursor over on any geometry, the measurement of that dimension will be displayed; refer to Figure-55.
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•If you want to mention that dimension then click on the line. The dimension will be attached to the cursor. 

•Place the dimension at desired distance by clicking. 

Automatic Dimensioning

The Auto Dimension tool is used to create and customize the dimensions automatically. The procedure to use this tool is discussed next.

•Click on the Auto Dimension tool from DIMENSIONS panel; refer to Figure-56. The AUTO DIMENSION dialog box will be displayed; refer to Figure-57.
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•Select desired dimension layout from the dialog box to be applied. The dimension will be applied to the drawing; refer to Figure-58.
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•Select desired option from Datum Location drop-down to specify the location of dimensions.

•Drag the Density manipulator to specify the density of dimensions.

•After specifying desired parameters, click on OK button from the dialog box. 

Tidy Up

The Tidy Up tool is used to automatically move dimensions that are overlapping. It also rearranges, re-sorts, and re-sizes objects in the sheet to keep the layout tidy.

Ordinate Dimensioning

The Ordinate Dimension tool is used to apply ordinate dimensioning. The procedure to use this tool is discussed next.

•Click on the Ordinate Dimension tool from DIMENSIONS panel; refer to Figure-59. The tool will be activated and you will be asked to specify origin for ordinate dimensioning.
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•Click at desired location to place origin of ordinate dimensioning. The ordinate dimension will be attached to the cursor; refer to Figure-60.

•Click at desired location to place dimension text. Similarly, you can dimension horizontally/vertically.
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Creating Linear Dimension

The Linear Dimension tool is used to create linear dimensions in horizontal/vertical directions. The procedure to use this tool is given next. 

•Click on the Linear Dimension tool from the DIMENSIONS panel in the Toolbar; refer to Figure-61. You will be asked to select points.
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•Select the two points one by one to create horizontal/vertical distance dimension. The dimension will get attached to cursor.

•Move the cursor in desired direction to create vertical or horizontal dimension if the two points are not in aligned vertically/horizontally; refer to Figure-62.
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•Click at desired location to place the dimension.

Creating Aligned Dimension

The Aligned Dimension tool is used to create aligned dimension between two selected points. The procedure is given next.

•Click on the Aligned Dimension tool from DIMENSIONS panel in the Toolbar; refer to Figure-63. You will be asked to select points.
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•Click at desired two points. The distance dimension between two selected points will get attached to cursor; refer to Figure-64.
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•Click at desired location to place the dimension.

Creating Angular Dimension

The Angular Dimension tool is used to create angle dimension between two selected lines/edges. If you select an arc then its angular span is created as dimension. The procedure to use this tool is given next.

•Click on the Angular Dimension tool from the DIMENSIONS panel in the Toolbar; refer to Figure-65. You will be asked to select entities.
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•Select two lines between which you want to create angular dimension or select an arc whose angular dimension is to be created. The dimension will get attached to cursor; refer to Figure-66.
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•Click at desired location to place the dimension.

Creating Radius Dimension

The Radius Dimension tool is used to apply radius dimension to selected arc, circle, and circular edges. The procedure to use this tool is given next.

•Click on the Radius Dimension tool in DIMENSIONS panel of Toolbar; refer to Figure-67. You will be asked to select circular edge or circle in the drawing.
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•Click at desired entity. The radius dimension will get attached to cursor; refer to Figure-68.
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•Click at desired location to place the dimension.

Creating Diameter Dimension

The Diameter Dimension tool is used to create diameter dimension for selected round edges, circles, and fillets in the drawing; refer to Figure-69. The procedure to use this tool is similar to Radius Dimension tool.
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Jogged Radial Dimension

The Jogged Radial Dimension tool is used to create radius dimension of a circle, arc, or polyline arc segment with the origin of the dimension and a jog at convenient locations. The procedure to use this tool is discussed next.

•Click on the Jogged Radial Dimension tool from the DIMENSIONS panel of Toolbar; refer to Figure-70. You will be asked to select an arc or circle.
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•Select desired arc or circle in the drawing. You will asked to specify center location.

•Select center location for the dimension. The jogged radial dimension will get attached to the cursor; refer to Figure-71.
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•Click at desired location to specify the jog location. The jogged radial dimension will be created.

Arc Length Dimension

The Arc Length Dimension tool is used to measure the distance along an arc or a polyline arc segment. The procedure to use this tool is discussed next.

•Click on the Arc Length Dimension tool from the DIMENSIONS panel of Toolbar; refer to Figure-72. You will be asked to select an arc or polyline arc segment.
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•Select desired arc in the drawing. The distance dimension will get attached to the cursor; refer to Figure-73.
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•Click at desired location to place the dimension or right click to select to select Full Arc Dimension or Partial option from the context menu to specify full or partial length of the arc, respectively.

Baseline Dimensioning

The baseline dimensioning is performed when you want to create linear dimensions with respect to one common base reference. The procedure to create baseline dimensions is given next.

•Click on the Linear Dimension tool from the DIMENSIONS panel of Toolbar; refer to Figure-74, and create a linear dimension which will be used as base line; refer to Figure-75.
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•Click on the Baseline Dimension tool from the DIMENSIONS panel of the Toolbar; refer to Figure-76, and select one of the leg of base dimension.
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•A new dimension will be generated with one end point fixed to selected leg and other end point of dimension attached to cursor; refer to Figure-77.
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•Select desired point of sketch to create the dimension. You will be asked to specify end point for another dimension. Select desired points to create required dimensions. Once you have created required dimensions, press ENTER from keyboard to complete the process. The dimensions will be generated; refer to Figure-78.
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Chain Dimensioning

In chain dimensioning, all the linear dimensions are placed side by side. The procedure to use this tool is given next.

•Create a linear dimension to used as reference for chain dimensioning as discussed in previous section for baseline dimensioning.

•Click on the Chain Dimension tool from the DIMENSIONS panel of the Toolbar; refer to Figure-79, and select the base dimension. You will be asked to specify end point of new dimension; refer to Figure-80.
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•Click at desired location to specify end point. You will be asked to specify end point of another dimension.

•Click at desired locations to create required dimensions and then press ENTER to exit. The dimensions will be created; refer to Figure-81.
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Arrange Dimensions

The Arrange Dimension tool is used to stack or align linear or angular dimensions in the DRAWING workspace. The procedure to use this tool is discussed next.

•Click on the Arrange Dimensions tool from DIMENSIONS panel of the Toolbar; refer to Figure-82. The ARRANGE DIMENSIONS dialog box will be displayed; refer to Figure-83.
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•Select Stack or Align option from Type section of the dialog box to create the dimension.

•The Base dimension selection option is active by default. Select the base dimension that all other dimensions will be stacked above/below; refer to Figure-84.
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•After selecting the base dimension, select the other dimensions that you want to stack; refer to Figure-85.
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•Specify desired spacing between stacked dimensions in the Spacing edit box of the dialog box.

•After specifying desired parameters, click on the OK button from the dialog box. The dimensions will be arranged; refer to Figure-86.
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Flip Arrows

The Flip Arrows tool is used to flip the direction of the selected dimension arrow. The procedure to use this tool is discussed next.

•Click on the Flip Arrow tool from the DIMENSIONS panel of the Toolbar; refer to Figure-87. You will be asked to select the dimension.
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•Select desired dimension to flip the arrow direction. The arrow direction will be flipped; refer to Figure-88.
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Dimension Break

The Dimension Break tool is used to resolve intersecting dimensions in the drawing. This tool adds/removes break in selected dimension. The procedure to use this tool is given next.

•Click on the Dimension Break tool from the DIMENSIONS panel of the Toolbar; refer to Figure-89. The DIMENSION BREAK dialog box will be displayed; refer to Figure-90,  and you will be asked to select the dimension to add or remove break.
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•Select desired dimension and then select the Add Break or Remove Break option from the Operation drop-down to perform respective action. In our case, we are selecting Add Break option from the drop-down to add break in intersecting dimension.

•Click on the OK button from the dialog box. The selected operation will be performed on the dimension; refer to Figure-91.
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Editing Dimensions

Once you have generated dimensions, there are some cases where you need to provide special symbols with dimensions or you want to modify the value of dimension. The procedure to edit dimension is given next.  

•Double-click on the dimension in drawing that you want to edit. The DIMENSION dialog box will be displayed; refer to Figure-92.
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•Select desired button of Representation section from Text node to make the dimension as reference dimension, not to scale, and theoretically exact; refer to Figure-93.
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•Click at desired place in dimension box and select desired symbol to be inserted. The symbol will be added to dimension; refer to Figure-94.
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•Select desired option from the Source drop-down to define the hierarchy level in model from which you want to link the source of dimension in assembly.

•Select desired option from the Type drop-down in the Properties section to define type of dimension to be assigned. Select the General option from drop-down if the dimension falls in general category, select the Physical option from drop-down if it is a physical property like mass, or select the Parameter option if it is a parameter like diameter, length,angle etc. Select desired option in Property drop-down to define the type for selected property.

•Select desired unit from Primary Units drop-down in the Primary Units node. 

•Select desired precision level from Linear Precision drop-down.

•Select desired option from Zeros/Units section to add/remove zeros and units to/from the dimension. 

•Select the Alternate Units check box to also display dimensions in inches if they are in mm and vice-versa; refer to Figure-95.
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•Select the Tolerances check box and select desired type of tolerance from the Type drop-down to apply tolerance to dimension. Select the Symmetrical option from the Type drop-down if tolerance is equal in both negative and positive directions. Select the Deviation option from the Type drop-down if tolerance is different in positive and negative directions. Select the Limit option from the Type drop-down if you want to display upper and lower limit of dimension; refer to Figure-96.
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•After selecting desired option from drop-down, specify desired value of tolerance in edit boxes below it in Tolerances node.

•Similarly, select the Inspection check box and set desired parameters if you want to define inspection rate of current dimension. 

•After specifying parameters, click on the Close button or click anywhere in blank space of drawing to exit the tool.

Creating Text

The Text tool is used to insert text into the active drawing. The procedure to use this tool is discussed next.

•Click on the Text tool from TEXT panel; refer to Figure-97. The Text tool is activated and you will be asked to draw a text box.
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•Click to specify the first corner.

•After specifying the first corner, click on the screen to specify the second corner; refer to Figure-98. The TEXT dialog box will be displayed; refer to Figure-99.

 [image: ]

[image: ]

•Click on the Font drop-down and select required font for text.

•Click in the Height edit box and specify the height of text.

•Click on the Select Color button from Color section. The Color Picker dialog box will be displayed from which you can select desired color for the text.

•Set the other parameters and type desired text in the Text box.

•Click on Close button. The text will be added in drawing sheet.

CREATING note

The Note tool automatically creates different type of note based on the type of object you select on the current sheet. The procedure to use this tool is discussed next.

•Click on the Note tool from TEXT panel in the Toolbar; refer to Figure-100. The NOTE dialog box will be displayed; refer to Figure-101.
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•The Automatic option in Type drop-down of NOTE dialog box is selected by default.

•Select Leader Note option from Type drop-down to create a multiline text object with a leader that associates the note to a component or feature.

•Select Hole and Thread Note option from Type drop-down to create a hole or thread note associated with a hole or thread feature.

•Select Bend Note option from Type drop-down to create a bend note associated with a sheet metal flat pattern bend.

•Here, we selected Leader Note option in Type drop-down of dialog box or click on Leader Note tool from TEXT panel of Toolbar; refer to Figure-100. The tool will be activated.

•The Select button of Select section is active by default. Click on the drawing to select the start point. An arrow will be attached to the cursor. 

•Click on the screen to place text box. The text box will be displayed along with TEXT dialog box; refer to Figure-102.
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•Set desired parameter in TEXT dialog box and type the text in text box. 

•After specifying the parameters, click on Close button from TEXT dialog box.

Similarly, you can use the Hole and Thread Note tool and Bend Note tool.

Applying Surface Texture

The Surface Texture tool is used to apply surface finish symbol to objects in drawing. The procedure to use this tool is discussed next.

•Click on the Surface Texture tool from SYMBOLS panel of Toolbar; refer to Figure-103. The tool will be activated.
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•Click on the model in drawing view to select object. An arrow will be displayed on the selected part.

•Click to select the second point for leader or press ENTER key to place the symbol directly on selected face. The SURFACE TEXTURE dialog box will be displayed; refer to Figure-104.
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•Select desired surface finish symbol button from Symbol type section.

•Specify the maximum and minimum roughness of surface texture in the Roughness max and Roughness min edit boxes of the dialog box, respectively.

•Specify desired values in the Machining allowance and Process edit boxes.

•Select the lay direction option as desired from Direction of lay drop-down.

•Specify the other parameters in the dialog box as desired.

•Click on the Reset button to reset all the properties to default values.

•After specifying desired parameters, click on the OK button from SURFACE TEXTURE dialog box; refer to Figure-105.

[image: ]

Surface Texture Symbols or Surface Roughness Symbols
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Creating Feature Control Frame

The Feature Control Frame contains data for controlled specifications. It shows the characteristics symbol, datum reference, and tolerance value. It is a rectangular frame which is divided into two or more sections. The feature control frame is also known as GD&T box in laymen’s language. The method to insert Feature Control Frame in drawing is same as discussed for Surface Texture symbol. In GD&T, a feature control frame is required to describe the conditions and tolerances of a geometric control on a part’s feature. The feature control frame consists of four pieces of information:

1.GD&T symbol or control symbol

2.Tolerance zone type and dimensions

3.Tolerance zone modifiers: features of size, projections…

4.Datum references (if required by the GD&T symbol)

This information provides everything you need to know about geometry of part like what geometrical tolerance needs to be on the part and how to measure or determine if the part is in specification; refer to Figure-106. The common elements of feature control frame are discussed next.
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1.Leader Arrow – This arrow points to the feature then the geometric control is placed on. If the arrow points to a surface then the surface is controlled by the GD&T. If it points to a diametric dimension then the axis is controlled by GD&T. The arrow is optional but helps clarify the feature being controlled.

2.Geometric Symbol – This is where your geometric control is specified. 

3.Diameter Symbol (if required) – If the geometric control is a diametrical tolerance then the diameter symbol (Ø) will be in front of the tolerance value.

4.Tolerance Value – If the tolerance is a diameter you will see the Ø symbol next to the dimension signifying a diametric tolerance zone. The tolerance of the GD&T is in same unit of measure that the drawing is written in. 

5.Feature of Size or Tolerance Modifiers (if required) – This is where you call out max material condition or a projected tolerance in the feature control frame. 

6.Primary Datum (if required) – If a datum is required, this is the main datum used for the GD&T control. The letter corresponds to a feature somewhere on the part which will be marked with the same letter. This is the datum that must be constrained first when measuring the part. Note: The order of the datum is important for measurement of the part. The primary datum is usually held in three places to fix 3 degrees of freedom.

7.Secondary Datum (if required) – If a secondary datum is required, it will be to the right of the primary datum. This letter corresponds to a feature somewhere on the part which will be marked with the same letter. During measurement, this is the datum fixated after the primary datum.

8.Tertiary Datum (if required) – If a third datum is required, it will be to the right of the secondary datum. This letter corresponds to a feature somewhere on the part which will be marked with the same letter. During measurement, this is the datum fixated last.

Reading Feature Control Frame

The feature control frame forms a kind of sentence when you read it. Below is how you would read the frame in order to describe the feature.
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Meaning of various geometric symbols are given in Figure-107.
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Figure-108 and Figure-109 shows the use of geometric tolerances in real-world.
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Note that in applying most of the geometrical tolerances, you need to define a datum plane like in Perpendicularity, Parallelism, and so on. There are a few dimensioning symbols also used in geometric dimensioning and tolerances, which are given in Figure-110.
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The procedure to use this tool is discussed next.                                       

 

•Click on the Feature Control Frame tool from SYMBOLS panel of Toolbar; refer to Figure-111. The tool will be activated.
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•Click on the drawing to select the object. An arrow will be attached to the cursor; refer to Figure-112.

[image: ]

•Click on the screen to place the rectangular box and press ENTER key. The FEATURE CONTROL FRAME dialog box will be displayed; refer to Figure-113.
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•Expand the First Frame node and select required symbol from Characteristic drop-down. The selected symbol will be displayed in the feature frame rectangular box.

•Click in the First tolerance edit box and enter the value of tolerance. You can also add the required symbol; refer to Figure-114.
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•Click on the First datum edit box and enter the value of datum as required; refer to Figure-115.
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•Similarly enter the remaining parameters in respective edit boxes.

•Select the Second Frame check box of FEATURE CONTROL FRAME dialog box if you want to add second frame for the drawing. Feature Control Frames with two frames is also called Composite Feature Control Frame.

•Click in the Top Note edit box and enter the note. If you want to add any symbol then click on the drop-down button. A list of symbols will be displayed; refer to Figure-116.
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•Click on required symbol. The selected symbol will be added over the feature control frame box. Similarly, you can set the symbol for Bottom Note edit box.

•After specifying the parameters, click on the OK button from FEATURE CONTROL FRAME dialog box to complete the process. 

Creating Datum Identifier

The Datum Identifier tool identifies a datum feature for a feature control frame symbol. Generally, datum identifier are circular frames divided in two parts by a horizontal line. The lower half represents the datum feature and the upper half is for additional information, such as dimensions of the datum target area; refer to Figure-117. In Fusion, datum identifier is represented by datum identifying letter in a rectangular frame.
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The procedure to use this tool is discussed next.

•Click on the Datum Identifier tool from SYMBOLS panel of Toolbar; refer to Figure-118. The tool will be activated.
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•Click on the drawing to select object. An arrow will be attached to the cursor.

•Specify the point and press ENTER key. The datum ID symbol will be displayed along with DATUM IDENTIFIER dialog box; refer to Figure-119.
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•Modify the identifier as desired and click on the OK button from DATUM IDENTIFIER dialog box.

CREATING WELDING SYMBOL and other symbols

The Welding tool in SYMBOLS drop-down of Ribbon is used to insert welding symbols applied to selected edge/face. Using this tool, you can apply annotation to the edges where weld is to be performed. The procedure to place a weld symbol is similar to placing Feature Control Frame discussed earlier. Similarly, you can use the Taper and Slope tool from the SYMBOLS drop-down in the DRAWING tab of Ribbon to apply symbol defining taper/slope on selected edge. 

Generating Tables

The Table tool is used to generate empty table, parts list, and bend table of the assembly model linked with drawing. The procedure to use this tool is discussed next.

•Click on the Table tool from TABLES drop-down in the Toolbar; refer to Figure-120. The TABLE dialog box will be displayed along with attached empty table; refer to Figure-121.

[image: ] [image: ]

•The Automatic option in Type drop-down of TABLE dialog box is selected by default. The Automatic option automatically creates a parts list or bend table, based on the contents of the current sheet.

•Select Custom Table option from Type drop-down to create an empty table.

•Select Parts List option from Type drop-down to create a parts list based on an assembly, storyboard, component, or sheet metal component reference. Note that Parts list is also called Bill of Materials or BOM.

•Select Bend Table option from Type drop-down to create a bend table based on a sheet metal flat pattern reference.

•Select Hole Table option from Type drop-down to create a hole table based on the origin you place in a drawing view.

•Select Revision History option from Type drop-down to create a revision history for the active sheet.

•Here, we are selecting the Parts List option from Type drop-down of dialog box or click Parts List tool from TABLES drop-down in the Toolbar; refer to Figure-120.

•The Select button of Select section is active by default. Select desired view on the current sheet.

•Select First Level option from Structure drop-down to include first level components only.

•Select All Levels option from Structure drop-down to include all components in the assembly.

•Click at desired location in the drawing to place the parts list. Parts list will be generated with balloons; refer to Figure-122. 
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Similarly, you can use Custom Table (Empty Table) tool, Bend Table tool, Hole Table tool, and Revision History tool. Note that you can edit the fields of empty table by double-clicking in them.

Generating Balloon

The Balloon tool is used to generate balloons for components in drawing. The procedure to use this tool is discussed next.

•Click on the Balloon tool from TABLES drop-down; refer to Figure-123. The BALLOON dialog box will be displayed; refer to Figure-124 and you will be asked to select the component.
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•By default, the Standard option is selected in the dialog box, so straight lines are created with balloon. If you want to create spline attached to balloon in place of line then select the Patent option from the Type drop-down. 

•Click on desired edge of component. On selection of edge, an arrow will be attached to the cursor.

•Click at desired location to place the balloon; refer to Figure-125 and Figure-126.
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Bend Identifier and Table

The Table tool discussed earlier works in a different way for sheet metal component. If you are generating drawing for a sheetmetal part then Table tool will generate bend table for the part and like balloons in assembly, bend identifiers are used to identify bends as per the table. The process is given next.

•After starting drawing environment, using flat pattern of a sheet metal part, click on the Bend Identifier tool from the TABLES drop-down in the Toolbar; refer to Figure-127. You will be asked to select the bends in flat pattern.
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•Click on the sheet metal bends in drawing one by one. Bend identifiers will be assigned to the bends; refer to Figure-128.

[image: ]

•Press ESC to exit the tool.

•Click on the Table tool from TABLES drop-down in the Toolbar and place the bend table at desired location; refer to Figure-129.
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REVISION MARKER

The Revision Marker tool is used to create non-associative and associative revision markers with and without a leader in a DRAWING workspace. The procedure to use this tool is discussed next.

•Click on the Revision Marker tool from TABLES panel in the Toolbar; refer to Figure-130. The REVISION MARKER dialog box will be displayed; refer to Figure-131.
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•Select desired revision from Revision drop-down, if more revisions are available.

•Select an object or specify a point to place the revision marker; refer to Figure-132.
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•After selecting the object, an arrow will be attached to the cursor.

•Click at desired location to place the revision marker; refer to Figure-133.
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•Click on the Close button from the dialog box to exit the tool.

Revision cloud

The Revision Cloud tool is used to create cloud-shaped objects to call attention to specific changes or portions of each drawing in the DRAWING workspace. The procedure to use this tool is discussed next.

•Click on the Revision Cloud tool from the TABLES panel in the Toolbar; refer to Figure-134. You will be asked to specify the first point.
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•Click in the canvas at desired location to specify the first point of the revision cloud.

•Move the cursor away and click at desired location to specify the next point of the revision cloud; refer to Figure-135. Optionally, you can specify the more points of the revision cloud.
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•After specifying desired points, press Enter from the keyboard. The revision cloud will be created; refer to Figure-136.

[image: ]

Revision History

The Revision History tool is used to generate a table of list of revisions in the drawing. After performing revisions then generating revision markers, click on the Revision History tool from the TABLES drop-down in Toolbar. The revision history table will be created; refer to Figure-137.
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Renumbering

The Renumber tool is used to renumber the existing balloons. The procedure to use this tool is discussed next.

•Click on the Renumber tool from the TABLES drop-down in the Toolbar; refer to Figure-138. The RENUMBER dialog box will be displayed; refer to Figure-139. 
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•Select Automatic option from Type drop-down to renumber the balloons or bend identifiers, based on the selection. Select Balloon option from Type drop-down to renumber the balloons for components in a parts list. Select Bend Identifier option from Type drop-down to renumber the bend identifiers for sheet metal bends in a bend table.

•Click in the Number edit box and enter desired number.

•Click on Select button from Selection section and click on the balloons as per their sequences to renumber them. The balloon numbers will be changed; refer to Figure-140.
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•After specifying the parameters, click on OK button from RENUMBER dialog box to complete the process.

Aligning Balloons

The Align Balloons tool is used to align all the pre-existing balloons. The procedure to use this tool is discussed next.

•Click on the Align Balloons tool from TABLES drop-down in Toolbar; refer to Figure-141. The tool will be activated.
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•Click to select all the balloons to aligned; refer to Figure-142 and press ENTER. You will be asked to specify starting point of line to be used for alignment of balloons.
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•Click on the screen to specify the start point. End point of alignment line will be attached to cursor.

•Click on the screen at desired location to define alignment of balloons; refer to Figure-143.
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Export PDF

The Export PDF tool is used to output the drawing in PDF format. The procedure to use this tool is discussed next.

•Click on the Export PDF tool of EXPORT drop-down in Toolbar; refer to Figure-144. The EXPORT PDF dialog box will be displayed; refer to Figure-145.
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•Click on the Sheets drop-down from the EXPORT PDF dialog box and select required sheet for output. You can also use SHIFT key or CTRL key to select multiple sheets.

•Select the Open PDF check box if you want to open the output PDF file.

•Select the Lineweights check box if you want to make bold lines of drawing otherwise, clear it.

•After specifying the parameters, click on the OK button from EXPORT PDF dialog box. The Export PDF dialog box will be displayed to save the file; refer to Figure-146.

[image: ]

•Click in the Name edit box and specify desired name for pdf file.

•Specify desired location of file in the Default Project section and click on Save button to save the file.

•Or, select Save to my computer check box and click on the [image: ] button. The Select Location dialog box will be displayed; refer to Figure-147.
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•Browse to desired location where you want to save the file and specify desired file name in the File name edit box. 

•Click on the Save button. The PDF file will be created.

Exporting DWG

The Export DWG tool is used to create an output file of drawing in DWG format. The procedure to use this tool is discussed next.

•Click on the Export DWG tool from EXPORT drop-down in the Toolbar; refer to Figure-148. The EXPORT DWG dialog box will be displayed to save the file; refer to Figure-149.
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•Select Simplified DWG option from Format drop-down of dialog box to export the contents of the current sheet as a DWG file, including views, title block, border, and all annotations as 2D geometry in Model Space.

•Select AutoCAD DWG option from Format drop-down to export the contents of all sheets to a DWG file. Each sheet is exported as a separate Layout tab.

•Click on the Sheets drop-down from EXPORT DWG dialog box and select required sheet for output. You can also use SHIFT key or CTRL key to select multiple sheets.

•After specifying the parameters, click on the OK button from EXPORT DWG dialog box. The Output DWG dialog box will be displayed to save the file; refer to Figure-150.
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•Rest of the procedure is same as discussed for previous tool.

Exporting dxf file

The Export Sheet as DXF tool from EXPORT drop-down in the Toolbar exports the sheets in a drawing as a DXF file. The procedure to use this tool is similar to the Simplified DWG option in the Format drop-down of EXPORT DWG dialog box.

Exporting CSV File

The Export CSV tool is used to create the output of the current file in CSV format. CSV is a format used by database management software and point cloud software. The procedure to use this tool is discussed next.

•Click on the Export CSV tool from EXPORT drop-down in the Toolbar; refer to Figure-151.
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•Select the table, parts list, or bend table in the Model Space. The Output Table dialog box will be displayed; refer to Figure-152.
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•Rest of the procedure is same as discussed for previous tool.

Practical 1

Generating part drawing for the model as shown in Figure-153.
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Starting a New Drawing using Part

•Set the parameters as shown in Figure-154 for preference.
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•Open the model file for Practical 1 of Chapter 11 in the resource kit. The model will be displayed in the canvas.

•Click on the From Design option from New Drawing cascading menu of the File menu; refer to Figure-155. The CREATE DRAWING dialog box will be displayed.

[image: ]

•Make sure ASME is selected in the Standard drop-down of CREATE DRAWING dialog box and click on the OK button. The DRAWING VIEW dialog box will be displayed with preview of drawing view; refer to Figure-156.
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Placing Views

•Select the Top option from the Orientation drop-down, Visible and Hidden Edges button from Style section, and 1:1 in Scale drop-down from the dialog box.

•Click at desired location to place the view; refer to Figure-157.

•Click on the OK button from the dialog box to create the view.

•Click on the Projected View tool from the CREATE panel in the Toolbar. You will be asked to select the base view.

•Select the view earlier placed and move the cursor towards right. The view will get attached to the cursor; refer to Figure-158.
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•Click at desired location to place the view and press ESC to exit.

Applying Annotations

•Click on the Center Mark Pattern tool from the GEOMETRY panel in the Toolbar. The CENTER MARK PATTERN dialog box will be displayed.

•Click on one of the holes in the base view and select the Center Mark check box. The preview of center mark pattern will be displayed; refer to Figure-159.
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•Click on the OK button from the dialog box.

•Click on the Dimension tool from the DIMENSIONS panel in the Toolbar and apply dimensions as shown in Figure-160.

•Click on the Datum Identifier tool from the SYMBOLS panel in the Toolbar and place the datum identifiers as shown in Figure-161.
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Adding Tolerances to Dimension

•Double-click on the dimension with 10 value. The DIMENSION dialog box will be displayed; refer to Figure-162.
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•Select the Symmetrical option from the Type drop-down in Tolerances node of dialog box and specify the value as 1 in Tolerance edit box. Click on the Close button to exit the dialog box.

•Similarly, set the tolerances for other dimensions; refer to Figure-163.
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•Click on the Feature Control Frame tool from the SYMBOLS panel in the Toolbar and select the hole of diameter 6. The control frame will get attached to cursor.

•Click at desired location to place the control frame and press ENTER. The FEATURE CONTROL FRAME dialog box will be displayed; refer to Figure-164.
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•Specify the parameters as shown in Figure-165 and click on the Close button.
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Similarly, define position feature control frame for other hole and place another base view as 3D NE Isometric view; refer to Figure-166.
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Practical 2

Generate part drawing for the model as shown in Figure-167.
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•Open the model file for Practical 2 of Chapter 11 in the resource kit. The model will be displayed in the canvas.

•Click on the From Design option from New Drawing cascading menu of the File menu; refer to Figure-168. The CREATE DRAWING dialog box will be displayed.
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•Make sure ASME is selected in the Standard drop-down of CREATE DRAWING dialog box and click on the OK button. The DRAWING VIEW dialog box will be displayed with preview of drawing view; refer to Figure-169.
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Placing Views

•Select the Front option from the Orientation drop-down, Visible and Hidden Edges button from Style section, and 1:1 in Scale drop-down from the dialog box.

•Click at desired location to place the view; refer to Figure-170.
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•Click on the OK button from the dialog box to create the view; refer to Figure-171.
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Creating Table

•Click on the Table tool from TABLES drop-down in the Toolbar. The TABLE dialog box will be displayed along with attached empty table; refer to Figure-172.
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•Select Parts List option from Type drop-down in the dialog box and the current drawing view will be selected automatically.

•Click at desired location in the drawing sheet to place the parts list. Parts list will be generated with balloons; refer to Figure-173.
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Practice

Create drawings for the models discussed in practical and practice sections of Chapter 5 of this book.

Self Assessment

Q1. The .................. tool is used to create drawing views generated from an existing base or drawing view.

Q2. What is the difference between ASME and ISO option in CREATE DRAWING dialog box?

Q3. In which view of drawing, hatching is automatically created?

Q4. Text can be aligned by Justification section. (T/F)

Q5. The drawing view can be move from one place to another with the help of Move button. (T/F)

Q6. What is the use of Edge extension tool?

Q7. Two parallel edges should be selected to create the extension. (T/F)

Q8. When is the baseline dimensioning required?

Q9. What is Feature Control Frame?

Q10. What is the use of Datum Identifier tool?

Q11. The ................. tool is used to create an output file of drawing in DWG format.
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Figure-35. Extruding with offset
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Figure-16. Preview of extrusion
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Figure-78. TANGENT PLANE dialog box
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Figure-147. Selecting sketch point for snap fit
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Figure-77. Tangent Plane tool
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Figure-18. Selecting center fuce of the model





OEBPS/image/872.png
Figure-83. Brake balance shifting mechanism assembly
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Figure-3. Sketching mode
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Figure-50. REVOLVE dialog box
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Figure-5. Window selection
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Figure-32. Preview of first extrusion
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Figure-56. Auto Dimension tool
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Figure-93. Plane Tangent to Face at Point tool
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Figure-76. Coil Type drop down
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Figure-55. Enable Contact Sets tool
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Figure-20. SELECT BY SIZE dialog box
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